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Kata Sambutan 

Peran guru profesional dalam proses pembelajaran sangat penting sebagai kunci 

keberhasilan belajar siswa. Guru Profesional adalah guru yang kompeten 

membangun proses pembelajaran yang baik sehingga dapat menghasilkan 

pendidikan yang berkualitas. Hal tersebut menjadikan guru sebagai komponen 

yang menjadi fokus perhatian pemerintah pusat maupun pemerintah daerah 

dalam peningkatan mutu pendidikan terutama menyangkut kompetensi guru. 

 

Pengembangan profesionalitas guru melalui program Guru Pembelajar (GP) 

merupakan upaya peningkatan kompetensi untuk semua guru. Sejalan dengan 

hal tersebut, pemetaan kompetensi guru telah dilakukan melalui uji kompetensi 

guru (UKG) untuk kompetensi pedagogik dan profesional pada akhir tahun 2015. 

Hasil UKG menunjukkan peta kekuatan dan kelemahan kompetensi guru dalam 

penguasaan pengetahuan. Peta kompetensi guru tersebut dikelompokkan 

menjadi 10 (sepuluh) kelompok kompetensi. Tindak lanjut pelaksanaan UKG 

diwujudkan dalam bentuk pelatihan paska UKG melalui program Guru 

Pembelajar. Tujuannya untuk meningkatkan kompetensi guru sebagai agen 

perubahan dan sumber belajar utama bagi peserta didik. Program Guru 

Pembelajar dilaksanakan melalui pola tatap muka, daring (online), dan campuran 

(blended) tatap muka dengan online. 

 

Pusat Pengembangan dan Pemberdayaan Pendidik dan Tenaga Kependidikan 

(PPPPTK), Lembaga Pengembangan dan Pemberdayaan Pendidik dan Tenaga 

Kependidikan Kelautan Perikanan Teknologi Informasi dan Komunikasi (LP3TK 

KPTK), dan Lembaga Pengembangan dan Pemberdayaan Kepala Sekolah 

(LP2KS) merupakan Unit Pelaksana Teknis di lingkungan Direktorat Jenderal 

Guru dan Tenaga Kependidikan yang bertanggung jawab dalam 

mengembangkan perangkat dan melaksanakan peningkatan kompetensi guru 

sesuai bidangnya. Adapun perangkat pembelajaran yang dikembangkan tersebut 

adalah modul untuk program Guru Pembelajar (GP) tatap muka dan GP online 

untuk semua mata pelajaran dan kelompok kompetensi. Dengan modul ini 

diharapkan program GP memberikan sumbangan yang sangat besar dalam 

peningkatan kualitas kompetensi guru. 

 

Mari kita sukseskan program GP ini untuk mewujudkan Guru Mulia Karena 

Karya. 

Jakarta,    Februari 2016 

Direktur Jenderal 

Guru dan Tenaga Kependidikan, 

 

Sumarna Surapranata, Ph.D. 

NIP. 195908011985032001
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Kata Pengantar 

Puji dan syukur kami panjatkan kehadirat Allah SWT atas selesainya 

penyusunan Modul Guru Pembelajar Paket Keahlian AkuntansiSekolah 

Menengah Kejuruan (SMK) dalam rangka Pelatihan Guru Pasca Uji  Kompetensi 

Guru (UKG). Modul ini merupakan bahan pembelajaran wajib, yang digunakan 

dalam pelatihan Guru Pasca UKG bagi Guru SMK. Di samping sebagai bahan 

pelatihan, modul ini juga berfungsi sebagai referensi utama bagi Guru SMK 

dalam menjalankan tugas di sekolahnya masing-masing. 

Modul Guru Pembelajar Paket Keahlian AkuntansiSMK ini terdiri atas 2 materi 

pokok, yaitu : materi profesional dan materi pedagogik. Masing-masing materi 

dilengkapi dengan tujuan, indikator pencapaian kompetensi, uraian materi, 

aktivitas pembelajaran, latihan dan kasus, rangkuman, umpan balik dan tindak 

lanjut, kunci jawaban serta evaluasi pembelajaran.   

Pada kesempatan ini saya sampaikan ucapan terima kasih dan penghargaan 

atas partisipasi aktif kepada penulis, editor, reviewer dan pihak-pihak yang 

terlibat di dalam penyusunan  modul ini. Semoga keberadaan  modul ini dapat 

membantu para narasumber, instruktur dan guru pembelajar dalam 

melaksanakan Pelatihan Guru Pasca UKG bagi Guru SMK.   

 

Jakarta,   Februari 2016 

Kepala PPPPTK Bisnis dan 

Pariwisata 

 

 

Dra. Hj. Djuariati Azhari, M.Pd 

NIP.195908171987032001 
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Pendahuluan 

 

A. Latar Belakang 

 

1. Gambaran Umum 

Program Guru Pembelajar adalah pengembangan kompetensi Guru dan 

Tenaga Kependidikan yang dilaksanakan sesuai kebutuhan, bertahap, 

dan berkelanjutan untuk meningkatkan profesionalitasnya. Program Guru 

Pembelajar sebagai salah satu strategi pembinaan guru dan tenaga 

kependidikan diharapkan dapat menjamin guru dan tenaga kependidikan  

mampu secara terus menerus memelihara, meningkatkan, dan 

mengembangkan kompetensi sesuai dengan standar yang telah 

ditetapkan. 

Setelah dilaksanakan Uji Kompetensi Guru (UKG) akan diketahui 

kelemahan/kompetensi yang kurang dikuasai guru. Sehingga diperlukan 

sebuah diklat yang didukung sebuah panduan/buku/modul untuk 

memperbaiki kompetensi yang kurang dikuasai. 

Modul Guru Pembelajarpaket keahlian akuntansi kelompok kompetensi F 

ini telah disesuaikan dengan standar kompetensi guru dan dilengkapi 

dengan uraian materi secara lugas dan komprehensif didukung dengan 

aktivitas pembelajaran serta evaluasi dalam bentuk latihan, kasus dan 

tugas, disertai dengan kunci jawaban dan penskoran sehingga Guru 

Pembelajar secara mandiri dan berkelanjutan dapat menilai kemampuan 

hasil belajar guna meningkatkan kompetensinya sesuai dengan gradasi 

pengetahuannya sesuai dengan tuntutan kurikulum yang terbaru yaitu 

kurikulum 2013 yang menjadi kurikulum nasional. 

Modul diklat ini merupakan panduan pelatihan bagi bapak/ibu guru yang 

sudah menguasai kompetensi tingkat dasar atau mendapat nilai UKG 51-

60, namun belum menguasai kompetensi J mengenai Komputer 

Akuntansi Perusahaan Manufaktur. 
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540GM602 Akuntansi J Ped: Refleksi Pembelajaran 

540GM602 Akuntansi J Pro: Komputer Akuntansi Perusahaan Manufaktur 

540GM602 Akuntansi I Ped: Manfaat Penilaian Dalam  Pembelajaran 

540GM602 Akuntansi I Pro: Akuntansi Perusahaan Manufaktur 

540GM602 Akuntansi H Ped: Penilaian Pembelajaran 

540GM602 Akuntansi H Pro: Surat Pemberitahuan Pajak 

540GM602 Akuntansi G Ped: Komunikasi Efektif 

540GM602 Akuntansi G Pro: Akuntansi Keuangan 2 

540GM602 Akuntansi F Ped: Potensi Peserta Didik 

540GM602 Akuntansi F Pro: Komputer Akuntansi Perusahaan Jasa dan 
Dagang 

540GM602 Akuntansi E Ped: Tik Dalam Pembelajaran 

540GM602 Akuntansi E Pro: Ketentuan Umum Perpajakan 

540GM602 Akuntansi D Ped: Pembelajaran Yang Mendidik 

540GM602 Akuntansi D Pro: Akuntansi Keuangan 1 

540GM602 Akuntansi C Ped: Pengembangan Kurikulum 

540GM602 Akuntansi C Pro: Pelaporan Keuangan Perusahaan Dagang 

540GM602 Akuntansi B Ped: Dasar Pembelajaran Yang Mendidik 

540GM602 Akuntansi B Pro: Pencatatan Transaksi Perusahaan Dagang 

540GM602 Akuntansi A Ped: Karakteristik Peserta Didik 

540GM602 Akuntansi A Pro: Akuntansi Perusahaan Jasa 

 

Sumber : Pedoman Penyusunan Modul Diklat PKB 

2. Definisi Modul 

Modul diklat ini adalah substansi materi pelatihan yang dikemas dalam 

suatu unit program pembelajaran yang terencana guna membantu 

pencapaian peningkatan kompetensi yang didesain dalam bentuk printed 

materials (bahan tercetak).  

Modul Diklat Guru Pembelajar ini berbeda dengan handout, buku teks, 

atau bahan tertulis lainnya yang sering digunakan dalam kegiatan 

pelatihan guru, seperti diktat, makalah, atau ringkasan materi/bahan 

sajian pelatihan. Modul Diklat Guru Pembelajar pada intinya merupakan 

model bahan belajar (learning material) yang menuntut Guru Pembelajar 

untuk belajar lebih aktif dan mandiri. 
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B. Tujuan 

 

1. Tujuan Umum 

Dengan mempelajari modul Guru Pembelajar Akuntansi kompetensi J ini 

diharapkan Guru Pembelajar mampu memahami, menerapkan, 

menganalisis, dan mengevaluasi pengetahuan faktual, konseptual, 

prosedural, dan metakognitif dalam ilmu pengetahuan, teknologi, seni, 

budaya, dan humaniora dengan wawasan kemanusiaan, kebangsaan, 

kenegaraan, dan peradaban terkait penyebab fenomena dan kejadian 

dalam bidang kerja yang spesifik untuk memecahkan masalahbagaimana 

cara menggunakan aplikasi komputer akuntansi MYOB Account Right 

Enterprise Versi 19 untuk perusahaan dagang dan jasa. 

 

2. Tujuan Khusus 

Secara khusus tujuan penulisan modul ini adalah: 

1. Memberikan panduan bagi guruGuru Pembelajaragar dapat 

menggunakan Aplikasi Komputer Akuntansi Perusahaan Dagang dan 

Jasa. 

2. Menjadi acuan pengelolaan Guru Pembelajar bagi Pusat 

Pengembangan dan Pemberdayaan Pendidik dan Tenaga 

Kependidikan (PPPPTK) atau penyedia layanan diklat lainnya untuk 

kegiatan diklat Guru Pembelajar untuk Komputer Akuntansi 

Perusahaan Manufaktur di sekolah/madrasah. 
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C. Peta Kompetensi 

Berikut adalah peta kedudukan Modul Diklat Guru PembelajarKompetensi J 

Komputer Akuntansi Perusahaan Dagang dan Jasa dengan modul-modul 

lainnya :  

540GM602 Akuntansi J Komputer Akuntansi Perusahaan 

Manufaktur 

540GM602 Akuntansi I Akuntansi Perusahaan Manufaktur 

540GM602 Akuntansi H Surat Pemberitahuan Pajak 

540GM602 Akuntansi G Akuntansi Keuangan 2 

540GM602 Akuntansi F Komputer Akuntansi Perusahaan Jasa 

dan Dagang 

540GM602 Akuntansi E Ketentuan Umum Perpajakan 

540GM602 Akuntansi D Akuntansi Keuangan 1 

540GM602 Akuntansi C Pelaporan Keuangan Perusahaan 

Dagang 

540GM602 Akuntansi B Pencatatan Transaksi Perusahaan 

Dagang 

540GM602 Akuntansi A Akuntansi Perusahaan Jasa 

 

Gambar 1 1 Peta Kompetensi Modul 

dari bawah ke atas, gradedan kompetensi guru dari rendah hingga tinggi. 

Kedudukan modul ini berada pada kelompok kompetensi J jenjang tinggi, 

guru yang mempelajari modul ini diharapkan sudah menguasai 

kompetensi/modul jenjang dasar kompetensi A s.d. I. 

 

D. Ruang Lingkup 

 

Modul diklat ini membahas bagaimana menyelesaikan pekerjaan akuntansi 

dengan menggunakan software aplikasi akuntansi MYOB AccountRight 

Enterprise v19 meliputi kegiatan belajar: 1. Melakukan setup awal, 2. 

Mengentri saldo awal, 3. Mengentri transaksi keuangan, 4. Mengentri 

transaksi penyesuaian, 5. Membuat laporan keuangan, 6. Membuat file 
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backup. Ruang lingkup ini sudah memenuhi standar minimun kurikulum 2013 

yang menjadi Kurikulum Nasional. 

 

E. Cara Penggunaan Modul 

 

Untuk mendapatkan hasil belajar yang maksimal, Guru Pembelajar diminta 

untuk mengikuti saran-saran sebagai berikut: 

1. Bacalah Pendahuluan dari modul ini agar Guru Pembelajardapat 

mengetahui maksud dan tujuan serta cakupan pembahasan materi 

dalam modul ini. Untuk Tujuan Pembelajaran yang lebih spesifik bacalah 

Tujuan Pembelajaran dan Indikator Pencapaian Kompetensi yang 

terdapat pada tiap kegiatan pembelajaran. 

2. Disarankan agar Guru Pembelajarsebelumnya telah menguasai modul 

paket keahlian akuntansi untuk kelompok kompetensi A sampai dengan 

E untuk dapat mempelajari modul ini. 

3. Pahami dan pelajari uraian materi, bila Guru Pembelajar menemukan 

istilah baru dan belum mengerti maknanya, Guru Pembelajardapat 

membuka halaman Glosarium pada akhir modul ini. 

4. Kerjakan setiap aktivitas, latihan, kasus dan tugas yang terdapat pada 

modul ini dengan seksama, bila menemui kesulitan, Guru Pembelajar 

dapat berdiskusi dengan teman yang dapat memberi pemahaman  lebih 

jelas. 

5. Untuk menyamakan persepsi pemahaman Saudara, bacalah rangkuman 

pada tiap modulnya. 

6. Berikan umpan balik dan tindak lanjut pembelajaran pada tiap modul. 

7. Untuk mengetahui hasil pembelajaran,Guru Pembelajar dapat membuka 

kunci jawaban dan mengecek kebenaran jawaban Saudara.Kunci 

Jawaban bisa menjadi bahan pembanding untuk menyempurnakan 

perkerjaan yang diselesaikan, dan juga bisa menjadi solusi apabila 

mengalami kebuntuan. 
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Kegiatan Pembelajaran 1 

Melakukan Setup  Awal 

 

 

A. Tujuan 

 

Setelah melaksanakan kegiatan pembelajaranpertamaini,Guru 

Pembelajar dapat melakukan setup awal pada sistem komputer akuntansi 

perusahaan manufaktur sehingga siap digunakan untuk mengentri 

transaksi akuntansi. 

 

B. Indikator Pencapaian Kompetensi 

 

Diharapkan Guru Pembelajar dapat menyelesaikan kegiatan-kegiatan 

sebagai berikut: 

1. Membuat file data akuntansi yang baru. 

2. Menyusun daftar akun. 

3. Menyusun hubungan akun. 

4. Mengentri neraca awal pada akun buku besar 

5. Mengentri saldo-saldo pada kartu piutang/hutang  

6. Mengentri saldo-saldo pada kartu persediaan. 

7. Membuat job list departemen produksi. 

8. Memeriksa kebenaran data akuntansi. 
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C. Uraian Materi 

 

1. Pembuatan file data akuntansi 

MYOB merupakan salah satu program aplikasi komputer akuntansi yang 

berbasis Windows. Ada beberapa versi MYOB yang tersedia di 

masyarakat, tetapi versi yang digunakan dalam pembelajaran ini adalah 

AccountRight Plus for Windows versi 19.6.1 yang dirilis oleh MYOB 

Australia. Pastikan bahwa program ini telah diinstal terlebih dahulu di 

komputer anda. Langkah awal sebelum mengoperasikan MYOB, adalah 

pengecekan bahwa simbol mata uang dan seting tanggal sudah sesuai 

dengan sistem Indonesia. 

File data bisnis adalah file yang digunakan oleh MYOB untuk menyimpan 

seluruh data yang dientri ke komputer. Yang perlu dingat kembali adalah 

nama file tersebut harus unik (artinya tidak ada nama file yang sama 

sebelumnya), baik untuk file yang sudah eksis atau yang akan dibuat.  

Data yang dibutuhkan pembuatan File Data baru adalah: 

a. Identitas perusahaan, meliputi : nama perusahaan, nomor registrasi, 

alamat perusahaan, nomor telepon, nomor fax dan alamat e-mail. 

Kolom yang wajib diisi adalah nama perusahaan, kolom yang lain 

boleh dikosongkan. 

 

Gambar 1 2 Identitas perusahaan 

b. Periode akuntansi, yang meliputi: tahun periode berjalan, bulan akhir 

periode, bulan konversi , dan jumlah bulan dalam periode. 
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Gambar 1 3 Periode Akuntansi 

c. Teknik pembuatan daftar akun. Pada tahap ini akan digunakan cara 

yang kedua, yaitu mengimport daftar akun yang sudah dipersiapkan 

oleh perusahaan sebelumnya. Nama File dan Folder tempat 

penyimpanan file tersebut.Berikut contoh pemberian nama file dan 

folder. 

 

Gambar 1 4 Penyimpanan file 

2. Menyusun daftar akun. 

Program MYOB menyediakan tiga pilihan untuk pembuatan daftar akun: 

a. Memilih salah satu yang disediakan oleh MYOB 

b. Mengimport daftar akun  

c. Membuat atau mengetik daftar akun sendiri 

Dalam pembelajaran kali ini akan dipraktekkan opsi (b) yaitu mengimport 

daftar akun. Untuk itu anda harus mempunyai file daftar akun dalam 

bentuk text file (tab delimeted) yang sudah tersimpan di komputer anda. 
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Hal-hal yang perlu diperhatikan dalam mengimport daftar akun adalah 

memilih menu File > Import Data > Account > Account Information 

dan field-field daftar akun harus mengikuti format dalam MYOB. 

 

Gambar 1 5 Elemen daftar akun 

3. Menyusun hubungan akun. 

Program MYOB secara default sudah membuat hubungan akun (linked 

accounts) untuk beberapa akun, Sebagai contoh akun Cheque Account 

akan berhubungan dengan Trade Debtors. Linked Account ini dapat 

diubah atau diset kembali jika diperlukan. Berikut ini seting Linked 

Account untuk transaksi Banking, Sales, Purchases dan Payroll. 

a. Linked accounts untuk Banking 

 

Gambar 1 6 Linked Accounts – Banking 
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b. Linked accounts untuk Sales 

 

Gambar 1 7 Linked accounts - Sales 

c. Linked accounts untuk Purchases 

 

Gambar 1 8 Linked accounts - Purchases 

d. Linked accounts untuk Payroll 

 

 

 

 

 

Gambar 1 9 Linked accounts - Payrolls 
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4. Mengentri neraca awal pada akun buku besar 

Entri neraca awal pada akun buku besar dilakukan pada saat konversi ke 

sistem baru. Jika bulan konversi sama dengan bulan awal periode 

akuntansi maka hanya bisa dientri saldo-saldo dari akun-akun neraca. 

Apabila bulan konversi tidak sama dengan bulan awal periode akuntansi 

maka bisa dientri saldo-saldo dari akun neraca dan akun laba-rugi. 

Hal-hal yang perlu diperhatikan dalam entri saldo awal akun buku besar: 

a. Melalui menu Setup > Balances > Account Opening Balances. 

b. Jika nilai akun Historical Balancing = 0, ini berarti bahwa total akun-

akun assets seimbang dengan total akun-akun Liability dan Equity. 

Jika  nilai akun Historical Balancing ≠ 0, ini berarti bahwa telah 

terjadi ketidak-seimbangan antara total assets dengan total Liability 

dan Equity. 

c. Akun-akun kontra dientri dengan tanda ”–” (minus). Yang termasuk 

akun kontra: Allowance for Doubtful Debts, Fixed Assets 

Accumulation Depresiation, Owner’s Drawing, Other Contra Account. 

 

Gambar 1 10 Daftar Saldo - Neraca Awal 
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5. Mengentri saldo-saldo pada kartu piutang/hutang  

Kartu piutang berisi informasi tentang customer, meliputi identitas, history 

dan data lain. Kartu piutang ini berfungsi sebagai buku pembantu tempat 

mencatat mutasi (penambahan, pengurangan dan saldo) piutang dagang  

sebagai akibat dari transaksi penjualan atau pelunasan piutang.Berikut 

contoh kartu piutang atau customer card dan cara pengisian saldo 

awalnya. 

 

Gambar 1 11 Profile – Kartu Piutang 

 

Gambar 1 12 Entri Saldo – Kartu Piutang 

 

Sedangkan kartu hutang berisi informasi tentang supplier, meliputi 

identitas,  history, dan juga data lainnya. Kartu utang ini berfungsi sebagai 

buku pembantu tempat mencatat mutasi (penambahan dan pengurangan) 

utang sebagai akibat dari transaksi pembelian atau pembayaran utang. 
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Berikut contoh kartu hutang atau supplier card dan cara pengisian saldo 

awalnya. 

 

Gambar 1 13 Profile – Kartu Hutang 

 

 

Gambar 1 14 Entri Saldo – Kartu Hutang 

 

6. Mengentri saldo-saldo pada kartu persediaan. 

Kartu item persediaan berfungsi sebagai buku pembantu pada akun 

persediaan, yaitu tempat pencatatan saldo awal dan keluar masuknya 

setiap item persediaan. Kartu persedian ini amat penting bagi perusahaan 

manufaktur yang mempunyai berbagai jenis item persediaan, seperti 

bahan baku/bahan penolong dan barang jadi. Dalam pembuatan kartu 

item persediaan untuk kelompok bahan baku atau bahan penolong akan 

ditentukan item tersebut akan dibeli, di dibuat persediaan tetapi tidak 
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untuk dijual. Sedangkan untuk kelompok barang jadi ditentukan item 

tersebut tidak akan dibeli, dibuat inventorinya dan akan dijual.  

Gambar berikut ini akan memperlihatkan seting untuk item persediaan 

bahan baku/penolong: 

 

Gambar 1 15 Profile – Kartu Persediaan Bahan Baku 

Gambar berikut ini akan memperlihatkan seting untuk item persediaan 

untuk kelompok barang Jadi: 

 

Gambar 1 16 Profile – Kartu Persediaan Barang Jadi 

Hal-hal yang perlu diperhatikan dalam menyiapkan kartu item persediaan 

bahwa satu kartu untuk mencatat satu item persediaan dan linked-

accounts harus diset secara benar agar dapat diproses secara tepat. 

MYOB menyediakan menu Command Centre Inventory > Adjust 

Inventory yang digunakan untuk mengentri saldo setiap item persediaan. 
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Gambar 1 17 Entri Saldo – Kartu Persediaan 

7. Membuat job list departemen produksi. 

Proses produksi pada perusahaan manufaktur pada umumnya berjalan 

melewati beberapa departemen (lebih dari satu). MYOB menyediakan 

menu Lists > Jobs untuk pembuatan departemen. Pertama Saudara buat 

Header untuk Jobs dan kemudian lengkapi Details untuk tiap Jobs. 

 

Gambar 1 18 Header - Departemen 

 

Gambar 1 19 Details – Departemen 
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8. Memeriksa kebenaran data akuntansi. 

Program MYOB menyediakan menu Command Centre 

Accounts>Company Data Auditor  yang dapat memeriksa secara 

otomatis kebenaran data yang telah dientri ke dalam komputer.Saudara 

pilih Transaction Review  dan klik Run Review untuk pengecekan data 

yang telah dientri. 

 

Gambar 1 20 Company Data Auditor 

Hasilnya akan diinformasikan seperti dalam gambar berikut: 

 

Gambar 1 21 Run Transaction Review 
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D. Aktivitas Pembelajaran 

 

Dalam aktivitas pembelajaran ini Saudara diminta memahami lebih dahulu 

kasus CV. Jayadwipa  di Lampiran 1, kemudian dengan membaca bahan 

rujukan atau literatur yang relevan, Saudara di minta menyelesaikan 

aktivitas-aktivitas berikut: 

Aktivitas 1.1. Membuat file data akuntansi. 

1.1.1 membuat file data akuntansi. 

1.1.2 memberi nama file dan folder 

Aktivitas 1.2. Mengimpor daftar akun. 

1.2.1. mengimpordaftar akun. 

1.2.2. menata daftar akun 

Aktivitas 1.3. Menyusun hubungan akun (linked accounts). 

1.3.1. menyusun hubungan akun untuk banking 

1.3.2. menyusun hubungan akun untuk sales 

1.3.3. menyusun hubungan akun untuk purchases 

1.3.4. menyusun hubungan akun untuk payroll 

Aktivitas 1.4. Mengentri Data Neraca Awal pada Akun Buku Besar 

1.4.1. mengentri data neraca awal pada akun buku besar. 

Aktivitas 1.5. Mengentri saldo-saldo pada kartu piutang/hutang 

1.5.1. membuat kartu piutang/hutang. 

1.5.2. mengentri saldo-saldo kartu piutang/hutang 

Aktivitas 1.6. Mengentri saldo-saldo pada kartu persediaan. 

1.6.1. membuat kartu persediaan. 

1.6.2. mengentri saldo-saldo kartu persediaan 

Aktivitas 1.7.Membuat Job List Departemen produksi. 

1.7.1. membuat job list departmen produksi. 

Aktivitas 1.8. Memeriksa kebenaran data akuntansi 

1.8.1. memeriksa kebenaran data akuntansi 
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E. Latihan/Kasus/Tugas 

Soal Pilihan Ganda. 

1. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong)  

adalah …. 

a. Serial Number 

b. Company Name 

c. Address 

d. Phone and fax number 

2. Yang dimaksud dengan Conversion Month adalah …. 

a. Bulan saat terjadinya penutupan buku 

b. Bulan saat perpindahan ke komputer akuntansi 

c. Bulan awal periode akuntansi yang berjalan 

d. Bulan pergantian periode akuntansi 

3. Tipe file daftar akun berikut ini yang bisa bisa dimport adalah …. 

a. Daftar_Akun_CVJdwipa.xls 

b. Daftar_Akun_CVJdwipa.doc 

c. Daftar_Akun_CVJdwipa.txt 

d. Daftar_Akun_CVJdwipa.jpg 

4. Pada seting Linked account untuk Sales, dipertanyakan dua hal, (1) 

Asset account for tracking receivable: ….. dan Bank Account for 

Customer Receipts: ….. Jawaban yang akan Saudara isikan sesuai 

dengan urutannya adalah …. 

a. Kas di Bank dan Piutang Dagang. 

b. Kas di Bank dan Penjualan. 

c. Piutang Dagang dan Kas di Bank 

d. Penjualan dan Kas di Bank 

5. Yang termasuk dalam kelompok akun kontra di bawah ini adalah …. 

a. Kerugian Piutang Tidak Tertagih. 

b. Depresiasi Mesin Pabrik 

c. Cadangan kerugian Piutang  

d. Selisih Kas 
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6. Dalam tab Selling Details padaKartu Piutang terdapat kolom Income 
Account, pilih akun mana yang paling cocok untuk diisikan di kolom 
tersebut: 
a. Piutang Dagang 

b. Persediaan Barang 

c. Penjualan  

d. Kas di Bank 

7. Saudara akan mengentri term of payment 2/10, n/30 dalam tab Buying 

Details pada Kartu Hutang. Maka pilihan format term of payment yang 

paling cocok untuk kasus di atas adalah … 

a. # of Days after EOM. 

b. On a Day of the month. 

c. Day of the month ofter EOM.  

d. In a Given # of Days. 

8. Dalam profile Kartu Persediaan (Inventory Card) terdapat tiga kriteria 

penting untuk setiap item persediaan yaitu (1). I Buy This Item; (2). Isell 

This Item dan (3). I Inventory This Item. Kriteria manakah yang akan 

Saudara ini untuk item persediaan Bahan Baku … 

a. Kriteria (1). 

b. Kriteria (1), (2). 

c. Kriteria (1), (3). 

d. Kriteria (1), (2), (3). 

9. Fitur MYOB yang manakah yang dapat digunakan untuk mengentri Kode 

dan Nama Departemen … 

a. File > Activities 

b. File > Jobs. 

c. Lists > Activities. 

d. Lists > Jobs. 

10. Pengecekan kebenaran entri data awal pada MYOB dapat dilakukan 

dengan memilih menu Command Centre Accounts > Company Data 

Auditor  dan satu pilihan menu lagi yaitu …. 

a. Company File Overview 

b. Account Reconciliation 

c. Transaction Review 

d. Tax Exception Review 
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F. Rangkuman 

 

Komputer Akuntansi adalah suatu proses pemanfaatanteknologi komputer 

untuk mengerjakan segala pekerjaanyang berkaitan dengan akuntansi dan 

didukung oleh perkembangan software yang mempermudah dan 

mempercepat proses tersebut. Salah satu software komputer akuntansi yang 

populer dan banyak digunakan oleh perusahaan adalah MYOB AccountRight 

Plus v19. 

Terdapat serangkaian prosedur yang diperlukan untuk men-setup data awal 

ke dalam sistem komputer akuntansi. Langkah pertama setelah menginstall 

program dan menyesuaikan sistem regional adalah pembuatan file data 

akuntansi baru.File in sangat diperlukan untuk menyimpan seluruh data yang 

dientri ke dalam komputer. Selanjutnya  menyusun daftar akun dan 

menyesuaikan kembali hubungan antar akun (linked accounts) yang terkait 

dengan transaksi banking, sales, purchases dan payrolls. 

Kegiatan berikutnya yang perlu dilaksanakan adalah mengentri saldo-saldo 

akun yang didasarkan pada data neraca awal. Kemudian mengentri saldo-

saldo kartu piutang, kartu hutang dan kartu persediaan. Karena yang sedang 

dipelajari akuntansi perusahaan manufaktur, maka dalam pembuatan kartu 

persediaan perlu diperhatikan pembuatan kartu dan pengisian saldo-saldo 

untuk bahan baku, bahan penolong dan barang jadi. Dalam proses produksi, 

barang dalam proses akan berjalan dari departemen satu ke departemen 

berikutnya. Maka perlu diperhatikan pembuatan kode dan nama departemen 

menggunakan fitur-fitur yang ada dalam program MYOB. Terakhir MYOB 

juga menyediakan fitur Company Data Auditor untuk mengecek kebenaran 

data yang telah diinput ke dalam sistem komputer akuntansi. 
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G. Umpan Balik dan Tindak Lanjut 

 

No Pertanyaan Jawaban 

1 Pemahaman apa yang Saudara peroleh 

setelah mempelajari pada kegiatan belajar 1,  

tentang Melakukan Setup Awal? 

 

2 Hal penting  apa yang bisa Saudara catat 

setelah mempelajari materi pembelajaran 1,  

tentang Melakukan Setup Awal? 

 

3 Rencana tindak lanjut apakah yang akan 

Saudara lakukan di sekolah? 

 

 

 

4 Pesan penting apa yang Saudara 

rekomendasikan untuk pengembangan 

kegiatan pembelajaran 1. 
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Kegiatan Pembelajaran 2 

Mengentri Transaksi-Transaksi Akuntansi 

 

 

A. Tujuan 

 

Setelah melaksanakankegiatan pembelajarankeduaini, Guru Pembelajar 

dapat mengentridata transaksi akuntansi yang terkait dengan semua 

kegiatan operasional perusahaan manufaktur ke dalam sistem komputer 

akuntansi. 

 

 

B. Indikator Pencapaian Kompetensi 

 

Diharapkan Guru Pembelajar dapat menyelesaikan kegiatan-kegiatan 

sebagai berikut: 

1. Mengentri transaksi-transaksi yang terkait dengan pembelian bahan. 

2. Mengentri transaksi-transaksi yang terkait dengan pemakaian bahan. 

3. Mengentri transaksi-transaksi kas keluar untuk keperluan produksi. 

4. Mengentri transaksi pembebanan biaya overhead pabrik (BOP) 

5. Mengentri transaksi terkait dengan penjualan barang jadi. 

6. Mengentri transaksi-transaksi kas keluar untuk biaya non produksi. 
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C. Uraian Materi 

 

1. Mengentri Transaksi Terkait Pembelian Bahan. 

Sebelum terjadi pembelian bahan, pada umumnya diawali kondisi 

persediaan mendekati stok minimal di gudang. Oleh karena itu Bagian 

Gudang mengajukan surat Permintaan Pembelian Bahan, sebagai 

contoh: 

CV. Jayadwipa – Tangerang Selatan 

Tanggal Permintaan Pembelian Bahan No. PP-01 

5-12-2015 Dari bagian Gudang:  Harap segera dibeli bahan-bahan sbb.: 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

200 K-01 Kayu Ramin - - - 

130 K-02 Kayu Rasamala - - - 

250 J-01 Jok Busa - - - 

20 Ca-1 Cat Melamix - - - 

30 Ca-2 Cat Semprot - - - 

100 Am-1 Amplas - - - 

5 De-1 Dempul - - - 

Tabel 2. 1 Permintaan Pembelian Bahan 

Atas dasar bukti tersebut, maka bagian akuntansi mengentri data melalui 

menu Purchases >Enter Purchases >Quotesebagai berikut: 

 

Gambar 2. 1 Quotes – Pembelian Bahan 
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Atas dasar quote tersebut selanjutnya dibuat Surat Order Pembelian. 

Program MYOB menyediakan fitur untuk mengubah quote menjadi order 

dengan cara: Change to Order, dan hasilnya nampak sebagai berikut: 

 

Gambar 2. 2 Order - Pembelian Bahan 

Transaksi selanjutnya bagian Gudang menerima bahan-bahan yang 

diorder dari Supplier. Atas dasar bukti penerimaan tersebut dicatat oleh 

bagian akuntansi: 

 

Gambar 2. 3 Penerimaan Bahan 

Berbarengan dengan penerimaan bahan, diterima pula surat tagihan dari 

supplier. Atas dasar surat dari supplier ini maka dapat dibuat bill sebagai 

berikut: 
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Gambar 2. 4 Hutang Dagang – Pembelian Bahan 

Transaksi selanjutnya adalah pembayaran hutang (pay bills) kepada 

supplier atas dasar surat-surat tagihan yang diterima perusahaan. Contoh 

pay bills yang dibuat oleh bagian akuntansi: 

 

Gambar 2. 5 Pembayaran Hutang 

 

2. Mengentri Transaksi Terkait Pemakaian Bahan. 

Transaksi pemakaian bahan diawali dengan adanya surat permintaan 

bahan dari departemen produksi kepada bagian gudang. Berikut contoh 

bukti dari surat permintaan bahan. 
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CV. Jayadwipa – Tangsel 

Tanggal Bukti Permintaan Bahan  No. PB-301 

16-12-2015 Permintaan dari bagian Departemen Assembling (Dep1) ke bagian gudang dan bag. Akuntansi atas surat 

perintah produksi no. 017. 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

100 K-01 Kayu Ramin 1.000.000/M3 100.000.000  

60 K-02 Kayu Rasamala 600.000/M3 36.000.000  

 Jumlah 136.000.000  

Tabel 2. 2 Bukti Permintaan bahan 

Atas dasar bukti tersebut bagian akuntansi menggunakan menu 

Command Centre Inventory > Adjust Inventory untuk mencatat 

pengurangan persediaan bahan baku/penolong. Yang perlu untuk 

pencatatan pemakaian bahan ini adalah mengentri quatity dengan angka 

minus (-).  Kolom Account diisi dengan nomor akun yang terkait yaitu 

Barang Dalam Proses Bahan Baku Departemen tertentu. 

 

Gambar 2. 6 Pengurangan Persediaan Bahan Baku 

 

Pencatatan ini akan menghasilkan jurnal penyesuaian pemakaian bahan 

oleh depatemen sebagai berikut: 
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Gambar 2. 7 Jurnal untuk Pengurangan Persediaan BahanBaku 

3. Mengentri Transaksi Pengeluaran Kas untuk Produksi. 

Selama proses produksi berlangsung kemungkinan terjadi pengeluaran 

kas untuk pembelian bahan-bahan ataupun untuk keperluan pembayaran 

gaji untuk tenaga kerja langsung. Sebagai contoh transaksi pengeluaran 

kas antara lain: 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1205 

22-12-2015 Dibayarkan kepada UD Baretta Service, Jakarta 

 Uraian Jumlah (Rp) Ket 

Jasa tenaga helper dan cleaning service di pabrik 3.200.000  

Total 3.200.000  

Tabel 2. 3 Pengeluaran Kas untuk Produksi 

Atas dasar bukti transaksi tersebut diadakan pencatatan sebagai berikut: 

 

Gambar 2. 8 Pembayaran Jasa untuk Produksi 
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Contoh lain transaksi pengeluaran kas adalah untuk pembayaran 

gaji/upah tenaga kerja langsung dan tenaga kerja bagian administrasi dan 

penjualan: 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar BKK-1206 

25-12-2015 Dibayarkan kepada Karyawan 

 Uraian Gaji kotor PPh ps.21 Gaji dibayar 

Gaji dan Upah Produksi Des. 2015: 

Tenaga kerja langsung Dep assembling 4 orang 

Tenaga kerja langsung Dep assembling 4 orang 

 

4.584.714 

4.584.665 

 

 
15.122 
10.122 

 

4.569.592 

4.574.543 

Jumlah  9.169.379 25.244 9.144.135 

Gaji Bagian Kantor Des. 2015: 

Gaji bagian Administrasi dan Penjualan 6 orang 

 

13.272.530 

 

 

431.550 

 

 

12.840.980 

Jumlah 22.441.909 456.794 21.985.115 

Tabel 2. 4 Pembayaran Gaji untuk Karyawan 

Entri data untuk transaksi pengeluaran kas untuk pembayaran gaji 

tersebut dapat dilihat di gambar berikut: 

 

Gambar 2. 9 Entri Pembayaran Gaji Karyawan 

 

 

 



 

 
29 

Komputer Akuntansi Perusahaan Manufaktur 
 

4. Mengentri Transaksi Pembebanan Biaya Overhead Pabrik (BOP) 

Didasarkan pada perhitungan tarif BOP untuk masing-masing departemen 

(ada yang dihitung berdasarkan nilai per jam mesin dan nilai per jam 

tenaga kerja langsung) maka dapat diperoleh Beban BOP sesungguhnya 

untuk masing-masing departemen. Sebagai contoh transaksi berikut ini: 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1201 

31-12-2015 BOP yang dibebankan dalam bulan Desember 2015 

 Uraian Jumlah (Rp) Ket 

BOP dibebankan kepada Departemen Assembling (Dep1) 

200 jam x Rp. 76.000,-  

15.200.000  

BOP dibebankan kepada Departemen Finishing (Dep2) 

168 jam TKL x Rp. 120.000,- 

20.160.000  

Total 35.360.000  

Tabel 2. 5 Pembebanan Biaya Overhead untuk Departemen 

 

Entri transaksi pembebanan BOP tersebut di atas ke dalam jurnal umum 

dapat dilihat pada gambar berikut: 

 

Gambar 2. 10 Entri Pembebanan BOP 

 

 

5. Mengentri Transaksi Terkait Penjualan Barang Jadi 

Transaksi penjualan barang jadi secara kredit dicatat seperti biasa, 

menggunakan menu Sales >Enter Sales: 
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CV. Jayadwipa – Tangsel 

Tanggal Faktur Penjualan  No. FP-1201 

31-12-2015 Kepada : Toko Ria Mebel, Jakarta Jatuh tempo 30 Pebr 2015 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

600 GY-01 Kursi goyang 500.000 300.000.000 PPN 

      

   PPN 10% 30.000.000  

 Jumlah 330.000.000  

Tabel 2. 6 Transaksi Penjualan barang Jadi 

 

Gambar 2. 11 Entri Transaksi Penjualan 

Transaksi penjualan barang secara kredit menimbulkan piutang dagang 

dan transaksi berikutnya akan selalu terjadi yaitu adanya pelunasan 

piutang. Sebagai contoh pelunasan piutang dagang: 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Masuk BKM-1201 

31-12-

2015 

Menerima pelunasan piutang dari Toko Ria Mebel, Jakarta 

 Bukti Tgl. Uraian Jumlah (Rp) Ket 

FP-1101 30/11 Saldo piutang Nop. 2015 55.000.000  

FP-1201 31/12 piutang Des. 2015 45.000.000  

     

  Jumlah dibayar 100.000.000  

Tabel 2. 7 Transaksi Penerimaan Pelunasan Piutang 
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Contoh data entri untuk transaksi pelunasan piutang dagang di atas 

adalah sebagai berikut: 

 

Gambar 2. 12 Entri Penerimaan Pelunasan Piutang 

6. Mengentri Transaksi Pengeluaran Kas untuk Non Produksi. 

Transaksi pengeluaran kas yang tidak ada kaitan dengan proses produksi 

(non produksi) dicatat ke dalam akun-akun terkait dalam kelompok biaya 

administrasi dan penjualan. Contoh transaksi pengeluaran kas untuk non 

produksi: 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar BKK-1208 

29-12-2015 Pembelian perlengkapan penjualan (Non Produksi) 

 Uraian Jumlah (Rp) Ket 

Pembelian perlengkapan penjualan: 

- Kertas bungkus cokelat 

- Tali rafia 

 

100.000 

15.000 

 

Total 115.000  

Tabel 2. 8 Transaksi Pengeluaran Non Produksi 
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Transaksi pengeluaran kas tersebut dicatat melalui menu Banking > 

Spend Money sebagai berikut: 

 

Gambar 2. 13 Entri Pengeluaran Non Produksi 

 

D. Aktivitas Pembelajaran 

 

Dalam aktivitas pembelajaran ini Saudara diminta memahami lebih dahulu 

kasus CV. Jayadwipa  di Lampiran 1, kemudian dengan membaca bahan 

rujukan atau literatur yang relevan, Saudara di minta menyelesaikan 

aktivitas-aktivitas berikut: 

Aktivitas 2.1. Mengentri transaksi yang terkait dengan pembelian bahan. 

2.1.1. mengentri permintaan pembelian bahan (quote). 

2.1.2. mengubah “quote” menjadi “order” pembelian (change quote to 

order). 

2.1.3. memproses penerimaan barang (receive items). 

2.1.4. memproses “Order” menjadi “Bill” (change order to bill). 

2.1.5. Mengentri pembayaran hutang dagang (pay bills). 

Aktivitas 2.2. Mengentri transaksi pemakaian bahan untuk produksi. 

2.2.1. mengentri permintaan bahan baku oleh departemen 

2.2.2. mengentri permintaan bahan penolong oleh departemen 
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Aktivitas 2.3.Mengentri transaksi kas keluar untuk keperluan produksi. 

2.3.1. mengentri pembayaran gaji dan upah 

2.3.2. pembelian perlengkapan pabrik 

2.3.3. pembelian bahan penolong 

2.3.4. pembayaran biaya/beban 

Aktivitas 2.4.Mengentri transaksi pembebanan biaya overhead pabrik (BOP) 

2.4.1. mengentri transaksi pembebanan BOP departemen (jam mesin) 

2.4.2. mengentri transaksi pembebanan BOP departemen (jam tenaga 

kerja) 

Aktivitas 2.5.Mengentri transaksi terkait dengan penjualan barang jadi. 

2.5.1. Mengentri penjualan barang jadi. 

2.5.2. Mengentri penerimaan pelunasan piutang. 

Aktivitas 2.6.Mengentri transaksi kas keluar untuk biaya non produksi. 

2.6.1. Mengentri pembayaran biaya-biaya keperluan kantor 

2.6.2. Mengentri pembelian perlengkapan penjualan. 

 

E. Latihan/Kasus/Tugas 

Soal Pilihan Ganda/Isian Singkat/Betul Salah. 

1.  Untuk mengentri data permintaan pembelian bahan dari bagian Gudang, 

Saudara dapat memilih Fitur MYOB yaitumenu Command Centre … 

A. Purchases > Enter Purchases > Quotes 

B. Purchases > Enter Purchases > Orders 

C. Purchases > Enter Purchases > Bills 

D. Purchases > Enter Purchases > Pay Bills 

2. Untuk mengentri data order pembelian didasarkan pada Quotes, Saudara 

dapat memilih Fitur MYOB yaitu menggunakan menu Command Centre … 

A. Purchases >Enter Purchases > Orders 

B. Purchases >Purchases Register > Orders 

C. Purchases > Purchases Register >Quotes > Change to Orders 

D. Purchases >Purchases Register >Change to Orders 
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3. Fitur Menu Command Centre Purchases > Purchases Register > Orders > 

Receive Items digunakan untuk pencatatan … 

A. Penerimaan bahan-bahan yang diorder 

B. Penerimaan bahan-bahan yang diquote 

C. Penerimaan bahan-bahan yang dibeli 

D. Penerimaan bahan-bahan yang dibayar 

4. Untuk mengubah Orders menjadi Bills yang harus anda lakukan adalah 

pada windows … 

A. Purchases Regiters, pilih Change to Bill. 

B. Purchases Regiters, pilih Bill. 

C. Purchases Regiters, pilih Order dan Change to Bill. 

D. Purchases Regiters, pilih Pay Bill. 

5. Untuk mengentri pembayaran hutang yang didasarkan pada Bill yang 

diterima, Saudara dapat menggunakan menu Command Centre ….. dan 

kemudian pilih … 

A. Banking dan Spend Money 

B. Banking dan  Pay Bills. 

C. Purchases dan Bills. 

D. Purchases dan Pay Bills 

6. Transaksi permintaan pemakaian bahan baku dari Depertemen-1 ke Bagian 

Gudang akan Saudara catat sebagai berikut … 

A. BDP Biaya Bahan Dep-1 di Debit dan Persedian di Kredit. 

B. BDP Biaya Bahan Dep-1 di Kredit dan Persedian Bahan Baku di 

Debit. 

C. BDP Biaya Bahan Dep-1 di Debit dan Persedian Bahan Baku di 

Kredit. 

D. BDP Dep-1 di Debit dan Persedian Bahan Baku di Kredit. 

7.  Pembelian tunai bahan penolong untuk keperluan Depertemen A akan 

dientri …. 

A. Debit: Persedian bahan penolong, Kredit: Kas di Tangan 

B. Debit: BOP Sesungguhnya, Kredit: Kas di Tangan 
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C. Debit: BDP BOP Departemen A, Kredit: Kas di Tangan 

D. Debit: BOP Departemen A, Kredit: Kas di Tangan 

8. Selama bulan Desember 2015 terdapat biaya overhead pabrik yang 

dibebankan kepada Departemen-1 sebesar Rp. 15.200.000,-. Transaksi ini 

akan dientri kedalam jurnal umum sebagai berikut … 

A. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: Harga Pokok 

Penjualan Rp. 15.200.000,- 

B. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: BOP 

Sesungguhnya Rp. 15.200.000,- 

C. Debit: BOP Sesungguhnya Rp. 15.200.000,- dan Kredit: BDP BOP 

Dep-1 Rp. 15.200.000,- 

D. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: Harga Pokok 

Produksi Rp. 15.200.000,- 

9. Transaksi penjualan barang jadi secara kredit sebesar Rp. 100.000.000,-   

disertai dengan PPN 10%, Hagra pokok penjualan  sebesar Rp. 

60.000.000,- Transaksi ini akan di entri oleh bagian akuntansi sebagai 

berikut …. 

A. Debit: Piutang dagang Rp. 110.000.000,- dan Kredit: Penjualan Rp. 

100.000.000,- dan PPN Keluaran Rp. 10.000,000,- 

B. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 100.000.000,- Kredit: Penjualan Rp. 100.000.000,- PPN Keluaran 

Rp. 10.000,000,- dan Persediaan Barang Jadi Rp. 100.000.000,- 

C. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 60.000.000,- Kredit: Penjualan Rp. 110.000.000,- dan Persediaan 

Barang Jadi Rp. 60.000.000,- 

D. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 60.000.000,- Kredit: Penjualan Rp. 100.000.000,- PPN Keluaran 

Rp. 10.000,000,- dan Persediaan Barang Jadi Rp. 60.000.000,- 

10. Dibeli secara tunai perlengkapan penjualan sebesar Rp. 200.000,- 

Transaksi ini akan dientri sebagai berikut … 

A. Debet: BOP Sesungguhnya Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 
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B. Debet: Harga Pokok Penjualan Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 

C. Debet: Beban Perlengkapan Penjualan Rp. 200.000,- dan Kredit: Kas 

Rp. 200.000,- 

D. Debet: BDP BOP Departemen Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 

 

F. Rangkuman 

 

Terdapat serangkaian transaksi yang berurutan terkait dengan pembelian 

bahan baku dan bahan penolong. Diawali dengan transaksi permintaan 

bahan dari bagian gudang, kemudian diteruskan dengan pembuatan order 

pembelian dan disusul dengan penerimaan barang yang diorder. Selanjutnya 

diterima surat tagihan dari supplier dan diadakan pembayaran hutang 

dagang. 

Proses produksi berjalan diawali dengan permintaan bahan dari depertemen 

yang ada dalam perusahaan. Transaksi pengeluaran kas sangat mengkin 

terjadi untuk menunjang proses produksi. Kemudian diperhitungkan 

pembebanan biaya overhead kepada departemen-departemen sesuai 

dengan kemampuan masing-masing.  

Dalam periode yang berjalan, sudah barang tentu terjadi penjualan barang 

jadi kepada pelanggan. Untuk mendukung kegiatan ini, perusahaan akan 

banyak mengeluarkan biaya-biaya administrasi dan penjualan (non produksi) 

untuk mencapai laba yang maksimal. 

Program MYOB menyediakan menu atau fitur untuk mencatat semua 

transaksi  yang telah tersebut di atas. Sangat diperlukan ketelitian dan 

kehati-hatian untuk mengentri transaksi-transaksi tersebut. 
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G. Umpan Balik dan Tindak Lanjut 

 

No Pertanyaan Jawaban 

1 Pemahaman apa yang Saudara peroleh 

setelah mempelajari pada kegiatan 

pembelajaran2,  tentang Mengentri 

Transaksi-transaksi Akuntansi? 

 

2 Hal penting  apa yang bisa Saudara catat 

setelah mempelajari materi pembelajaran 2,  

tentang Mengentri Transaksi-transaksi 

Akuntansi? 

 

3 Rencana tindak lanjut apakah yang akan 

Anda lakukan di sekolah? 

 

 

 

4 Pesan penting apa yang Anda 

rekomendasikan untuk pengembangan 

kegiatan pembelajaran 2 ? 
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Kegiatan Pembelajaran 3 

Menyiapkan Laporan Keuangan 

 

 

A. Tujuan 

 

 

Setelah melaksanakankegiatan pembelajaranketiga ini Guru Pembelajar 

dapat menyiapkan laporan keuangan yang diperlukan oleh perusahaan 

manufaktur dengan menggunakan pilihan-pilihanmenu yang sesuai. 

 

B. Indikator Pencapaian Kompetensi 

 

 

Diharapkan Guru Pembelajar dapat menyelesaikan kegiatan-kegiatan 

sebagai berikut: 

1. Mengentri transaksi-transaksi penyesuaian. 

2. Menyiapkan laporan keuangan (utama). 

3. Menyiapkan laporan-laporan pendukung. 

4. Membuat file backup. 

5. Me-restore kembali file backup. 
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C. Uraian Materi 

 

1. Mengentri transaksi-transaksi penyesuaian. 

Transaksi penyesuaian perusahaan manufaktur akan difokuskan pada 7 

macam transaksi, meliputi penyusutan bangunan dan mesin pabrik; 

beban asuransi bangunan dan mesin pabrik; persediaan awal periode 

BDP untuk diselesaikan di departemen; transfer BDP dari departmen ke 

departemen lain; persediaan akhir periode BDP di departemen dengan 

tingkat penyelesaian tertentu; transfer barang Jadi ke Gudang;dan 

Pembebanan selisih BDP ke HPP. 

Dalam MYOB, jurnal-jurnal penyesuaian tersebut dapat di entri melalui 

menu Command Centre Account> Record Journal Entry. Berikut ini 

satu per satu akan ditampilkan jurnal penyesuaiannya. 

a. Penyusutan bangunan dan mesin pabrik. 

Biaya yang terjadi akibat adanya penyusutan gedung pabrik dan 

mesin pabrik dibukukan sebagai Biaya Overhead (BOP) 

Sesungguhnya di debit, sedang yang dikredit Akumulasi Depresiasi 

Bangunan dan akumulasi Depresiasi Mesin. Berikut ini contoh entri 

jurnal penyesuaian untuk penyusutan aset tetap yang digunakan 

untuk produksi. 

 

Tabel 3. 1 Transaksi Penyusutan Aset Tetap Pabrik 

 

b. Beban asuransi bangunan dan mesin pabrik. 

Biaya asuransi aset tetap yang digunakan untuk proses produksi 

dibukukan sebagai Biaya Overhead (BOP) Sesungguhnya di debit, 

sedang yang dikredit adalah Asuransi Dibayar Dimuka. Contoh untuk 
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jurnal penyesuaian biaya asuransi aset tetap yang digunakan di 

pabrik. 

 

Tabel 3. 2 Transaksi Beban Asuransi untuk Produksi 

 

c. Persediaan awal periode BDP untuk diselesaikan di departemen. 

Persediaan awal periode BDP Departemen yang semula di debet 

harus dikredit dalam jurnal penyesuaian. Sedang akun yang di debet 

adalah biaya-biaya yang membentuk persediaaan tersebut 

diantaranya BDP Biaya bahan, BDP Biaya Tenaga Kerja Langsung 

dan BDP Biaya Overhead untuk Departemen yang sama. Sebagai 

contoh jurnal penyesuaian berikut: 

 

Tabel 3. 3 Transaksi Penyesuaian Unit Awal di Departemen 

d. Transfer BDP dari departmen ke departemen lain. 

Dalam jurnal penyesuaian, di debet BDP Biaya Bahan Departemen 

penerima dan dikredit BDP Biaya bahan, BDP Biaya Tenaga Kerja 

dan BDP Biaya Overhead, ketiganya dari Departemen pengirim. 

Berikut contohnya: 
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Tabel 3. 4 Entri Pengiriman antar Departemen 

 

e. Persediaan akhir periode BDP di departemen dengan tingkat 

penyelesaian tertentu. 

Persediaan awal periode BDP Departemen yang semula dikredit 

harus didebet dalam jurnal penyesuaian. Sedang akun yang di kredit 

adalah biaya-biaya yang membentuk persediaaan tersebut 

diantaranya BDP Biaya bahan, BDP Biaya Tenaga Kerja Langsung 

dan BDP Biaya Overhead untuk Departemen yang sama. Sebagai 

contoh jurnal penyesuaian berikut: 

 

 

Tabel 3. 5 Entri Penyesuaian Unit Akhir di departemen 

 

f. Transfer Barang Jadi ke Gudang 

Terdapat dua kali proses penjurnalan, pertama mengurangi barang 

dalam proses untuk dimasukkan ke dalam barang jadi. Berikut contoh 

Jurnal penyesuaian yang pertama: 
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Tabel 3. 6 Entri Penyesuaian untuk Transfer ke Gudang Barang jadi 

 

Jurnal penyesuaian yang kedua, menambah jumlah unit barang jadi 

ke dalam kartu persediaan jadi. Contoh jurnal penyesuaian kedua: 

 

Tabel 3. 7 Entri Penambahan Barang Jadi 

 

g. Pembebanan selisih BDP ke HPP 

Pada akhir bulan, jika terdapat selisih angka pada akun-akun barang 

dalam proses, maka selisih tersebut dipindahkan ke akun Harga 

Pokok Penjualan. Jika selisih angka ada di debit, maka untuk 

menghilangkannya harus di kredit sebesar angka tersebut. 

Sebaliknya jika selisih angka ada di kredit, maka untuk 

menghilangkannya harus di debit sebesar angka tersebut. Berikut 

contohnya: 

 

Tabel 3. 8 Entri Penyesuaian Selisih BOP 
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2. Menyiapkan laporan keuangan utama 

Yang dimaksud laporan keuangan utama di sini adalah laporan laba-rugi, 

neraca dan laporan arus kas. MYOB memiliki fitur-fitur untuk 

menampilkan/mencetak laporan keuangan utama tersebut secara 

otomatis. 

MYOB memiliki menu Report > Accounts > Profit and Loss (Accrual) 

untuk menampilkanlaporan laba-rugi seperti nampak dalam gambar 

berikut ini.  

 

Gambar 3. 1 Fitur untuk membuat laporan laba rugi 

 

Hasil laporan Laba-Rugi akan nampak sebagai berikut: 

 

Gambar 3. 2 Laporan laba-Rugi 
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MYOB memiliki menu Report > Accounts >Standard Balance Sheet 

untuk  menampilkanlaporan neraca, seperti nampak dalam gambar di 

bawah ini.  

 

Gambar 3. 3 Fitur untuk membuat laporan neraca 

 

Contoh hasil laporan neraca (standard balance sheet) nampak sebagai 

berikut: 

 

Gambar 3. 4 Laporan Neraca 
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Laporan arus kas yang merupakan laporan utama lainnya juga dapat 

disiapkan secara otomatis dengan menggunakan menu report 

>banking>Statement of Cash Flow. 

 

Gambar 3. 5 Fitur untuk membuat laporan arus kas. 

Contoh hasil laporan arus kas dapat dilihat sebagai berikut: 

 

Gambar 3. 6 Laporan Arus Kas 
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3. Menyiapkan laporan-laporan pendukung 

Laporan-laporan pendukung yang diproses MYOB cukup banyak, tetapi 

dalam pembelajaran kali ini difokuskan pada daftar persediaan dan 

transaksi pada departemen. 

MYOB mempunyai menu Report >Inventory > Items >Items List 

Sumary untuk menampilkan daftar item persediaan (ringkas). 

 

Gambar 3. 7 Fitur untuk membuat Daftar Persediaan 

Hasil laporannya akan ditampilkan seperti gambar berikut: 

 

Gambar 3. 8 Daftar Persediaan 

 

MYOB juga mempunyai menu Report >Account >Jobs >Job 

Transactions untuk menampilkan daftar transaksi yang terjadi di 

departemen.  
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Gambar 3. 9 Fitur Membuat Transaksi Departemen 

Hasilnya akan nampak sebagai berikut: 

 

Gambar 3. 10 Laporan Transaksi Departemen-1 
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Gambar 3. 11 Laporan Transaksi Departemen-2 

 

Dalam MYOB, laporan keuangan utama dan pendukung dapat ditampilkan 

di layar (soft copy) atau langsung dicetak (hard copy). Jika diinginkan 

laporan keuangan juga dapat dieksport ke Excell laporan agar dapat 

diformat secara lebih rapi. 

 

4. Membuat file backup 

Untuk menjaga integritas atau keutuhan data dari bahaya virus atau 

bahaya kerusakan file lainnya maka data akuntansi yang telah selesai 

diproses perlu dibuatkan file cadangan atau file backup. Ini perlu 

dilakukan pada setiap waktu tertentu (misalnya setiap akhir 

minggu/bulan/akhir tahun). File bakcup merupakan file yang isinya telah 

di-compressed atau dimampatkan sehingga sizenya jauh lebih kecil dari 

file aslinya.MYOB bisanya memberikan secara otomatis ekstensi file ZIP 

untuk file backup ini. 
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Gambar 3. 12 Fitur untuk membuat File Backup 

 

5. Me-restore file backup. 

Untuk membuka kembali file backup menjadi file aslinya,diperlukan 

proses me-restorekembali file backup tersebut. File yang telah di-restore 

ini dapat disimpan dengan nama dan folder yang baru agar supaya tidak 

me-replace folder dan file yang lama. 

 

Gambar 3. 13 Fitur untuk Me-restore 
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D. Aktivitas Pembelajaran 

Dalam aktivitas pembelajaran ini Saudara diminta memahami lebih dahulu 

kasus CV. Jayadwipa  di Lampiran 1, kemudian dengan membaca bahan 

rujukan atau literatur yang relevan, Saudara di minta menyelesaikan 

aktivitas-aktivitas berikut: 

Aktivitas 3.1.Mengentri transaksi-transaksi penyesuaian pada akhir Des. 

2015: 

3.1.1. Penyusutan bangunan dan mesin pabrik;  

3.1.2. Beban asuransi bangunan dan mesin pabrik;  

3.1.3. Persediaan awal periode BDP untuk diselesaikan di departemen;  

3.1.4. Transfer BDP dari departmen ke departemen lain;  

3.1.5. Persediaan akhir periode BDP di departemen dengan tingkat 

penyelesaian tertentu;  

3.1.6. Transfer barang Jadi ke Gudang;  

3.1.7. Pembebanan selisih BDP ke HPP. 

Aktivitas 3.2. Menyiapkan laporan keuanganutama 

3.2.1. Menyiapkan laporan laba-rugi,  

3.2.2. Menyiapkan laporan neraca dan  

3.2.3. Menyiapkan laporan arus kas 

Aktivitas 3.3. Menyiapkan laporan keuangan pendukung 

3.3.1. Menyiapkan laporan laba-rugi,  

3.3.2. Menyiapkan laporan neraca dan  

3.3.3. Menyiapkan laporan arus kas 

Aktivitas 3.4. Membuat File Backup data akuntansi Perusahaan manufaktur. 

Aktivitas 3.5. Me-restore file backup dengan nama folder dan nama file yang 

lain. 
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E. Latihan/Kasus/Tugas 

Soal Pilihan Ganda. 

1. Transaksi Penyusutan aset tetap pabrik akan dientri …. 

A. Debit: Biaya Depresiasi Aset Tetap, Kredit: BOP Sesungguhnya 

B. Debit: BOP Sesungguhnya, Kredit: Akumulasi Depresiasi Aset Tetap 

C. Debit: Biaya Depresiasi Aset Tetap, Kredit: Akumulasi Depresiasi 

Aset Tetap 

D. Debit: BOP Sesungguhnya, Kredit: Biaya Depresiasi Aset Tetap 

2. Asuransi Mesin Produksi yang sudah kedaluwarsa bulan Des. 2015 Rp. 

2.000.000,- akan dientri … 

A. Debit: Biaya Asuransi Rp. 2.000.000,-, Kredit: BOP Sesungguhnya 

Rp. 2.000.000,- 

B. Debit: BOP Sesungguhnya Rp. 2.000.000,-, Kredit: Biaya Asuransi 

Rp. 2.000.000,- 

C. Debit: Biaya Asuransi Dibayar Dimuka Rp. 2.000.000,-, Kredit: Kas di 

Bank Rp. 2.000.000,- 

D. Debit: BOP Sesungguhnya Rp. 2.000.000,-, Kredit: Asuransi Dibayar 

Dimuka Rp. 2.000.000,- 

3. Penyesuaian untuk unit awal periode BDP 100 unit di Dep-1 adalah … 

A. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1; 

dan Kredit: Persediaan Barang Dalam Proses. 

B. Debit: Persediaan Barang Dalam Proses; Kredit: BDP Biaya Bahan 

Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1 

C. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-

1;dan Kredit: Persediaan Barang. 

D. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1. 

dan Kredit: BOP Sesungguhnya. 

4. Penyesuaian untuk transfer 900 unit dari Dep-1 ke Dep-2 adalah … 

A. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1; 

dan Kredit: BDP Biaya bahan Dep-2. 

B. Debit: BDP Biaya Bahan Dep-2; Kredit: BDP Biaya Bahan Dep-1, 

BDP BTKL Dep-1, BDP BOP Dep-1 
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C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: BDP Biaya Bahan Dep-1. 

D. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1. 

dan Kredit: Persediaan Barang Dalam Proses. 

5. Penyesuaian untuk unit akhir periode BDP 100 unit di Dep-2 adalah … 

A. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2; 

dan Kredit: Persediaan Barang Dalam Proses. 

B. Debit: Persediaan Barang Dalam Proses; Kredit: BDP Biaya Bahan 

Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2 

C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: Persediaan Barang. 

D. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2. 

dan Kredit: BOP Sesungguhnya. 

6. Penyesuaian untuk pengurangan nilai Barang Dalam Proses akibat 

transfer 300 dari Dep-2 ke Gudang Barang Jadi adalah … 

A. Debit: Persediaan Barang Jadi; dan Kredit: Persediaan Barang 

Dalam Proses. 

B. Debit: Persediaan Barang Jadi; Kredit: BDP Biaya Bahan Dep-2, BDP 

BTKL Dep-2, BDP BOP Dep-2 

C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: Persediaan Barang Jadi. 

D. Debit: Persediaan Barang Jadi dan Kredit:BOP Sesungguhnya. 

7. Langkah untuk menampilkan Arus Kas dalam MYOB: 

A. Report > Banking > Statement of Cash Flow 

B. Report > Banking > Cash Flow Analysis 

C. Banking > Index to Reports >Statement of Cash Flow 

D. Banking > Reports >Statement of Cash Flow 

8. Laporan yang menginformasikan posisi aset, kewajiban dan equitas 

perusahaan pada periode tertentu adalah: 

A. Laporan Laba-Rugi 

B. Neraca 

C. Laporan perubahan modal 

D. Arus Kas 

E. Catatan atas Laporan Keuangan 
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9. Alasan perlunya pembuatan backup file: 

A. Kelengkapan data 

B. Kekurangan data 

C. Kelebihan data 

D. Keamanan data  

10. Langkah untuk me-restore backup fle: 

A. File > Pilih Bakcup file > Restore > Open > Ketik nama file > Save 

B. File > Restore > Open > Ketik nama file > Save 

C. File > Restore > Pilih Backup file > Save > Ketik nama file > Open 

D. File > Restore > Pilih Backup file > Open > Ketik nama file > Save 

 

F. Rangkuman 

Proses awal yang diperlukan dalam menyiapkan laporan keuangan adalah 

mengentri pos-pos penyesuaian. Pos-pos penyesuaian perusahaan 

manufaktur akan difokuskan pada 7 kelompok transaksi, yaitu meliputi 

penyusutan bangunan dan mesin pabrik; beban asuransi bangunan dan 

mesin pabrik; persediaan awal periode BDP untuk diselesaikan di 

departemen; transfer BDP dari departmen ke departemen lain; persediaan 

akhir periode BDP di departemen dengan tingkat penyelesaian tertentu; 

transfer barang Jadi ke Gudang; dan pembebanan selisih BDP ke HPP. 

Setelah entri penyesuaian diselesaikan, MYOB akan memproses laporan 

keuangan secara otomatis didasarkan pada kebutuhan perusahaan. 

Berbagai laporan keuangan utama dan laporan pendukung dapat 

ditampilkan, dieksport ke program excell atau dicetak melalui pemilihan 

menu-menu yang tersedia. 

Terdapat 3 laporan pokok yang diperlukan perusahaan, yaitu laporan Laba-

Rugi, Neraca, Laporan Arus Kas. Disamping itu juga diperlukan laporan-

laporan  pendukung, diantaranya perlu daftar saldo piutang dan utang, serta 

daftar saldo persediaan. Disamping itu perusahaan juga perlu laporan 

transaksi yang telah terajdi di tiap-tiap departemen. 

Untuk menjaga integritas dan keamanan data akuntansi sangat diperlukan 

adanya file backup yang sewaktu-waktu bisa di-restore kembali. 
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G. Umpan Balik dan Tindak Lanjut 

 

No Pertanyaan Jawaban 

1 Pemahaman apa yang Saudara peroleh 

setelah mempelajari pada kegiatan 

pembelajaran3,  tentang   Menyiapkan 

Laporan Keuangan? 

 

2 Hal penting  apa yang bisa Saudara catat 

setelah mempelajari materi pembelajaran 3,  

tentang   Menyiapkan Laporan Keuangan? 

 

3 Rencana tindak lanjut apakah yang akan 

Anda lakukan di sekolah? 

 

 

 

4 Pesan penting apa yang Anda 

rekomendasikan untuk pengembangan 

kegiatan pembelajaran 3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
55 

Komputer Akuntansi Perusahaan Manufaktur 
 

Kunci Jawaban Latihan/Kasus/Tugas 

 

Jawaban Latihan KB-1 

1. B 6. C 

2 B 7. D 

3 C 8. C 

4 C 9. B 

5 C 10 C 

 

Jawaban Latihan KB-2 

1. A 6. C 

2 C 7. B 

3 A 8. B 

4 C 9. D 

5 D 10 C 

 

Jawaban Latihan KB-3 

1. A 6. B 

2 D 7. A 

3 A 8. B 

4 B 9. D 

5 B 10 D 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 Modul Paket Keahlian Akuntasi Sekolah Menengah Kejuruan 
(SMK) 

 

56 

Evaluasi 

 

Soal Pilihan Ganda. 

Pilih jawaban yang paling tepat diantara A, B, C, D, atau E dengan 

memberi  tanda silang (X) pada  lembar jawaban yang telah disediakan. 

1. Untuk mengamankan data dari tangan orang yang tidak bertanggung 

jawab kita dapat memberi password pada MYOB yang kita buat. Adapun 

langkah untuk membuat password tersebut adalah …… 

A. Setup – preference – secutiry – password 

B. Setup – general – security 

C. Tool – preference – security  - password 

D. Setup – option – general – security 

2. Salah satu syarat utama kita dapat melakukan pengembalian data adalah 

A. Harus mempunyai file backup data yang lengkap tidak corrupt 

B. Data harus balance 

C. Harus mempunyai file backup data 

D. File backup data dalam extention .dat 

3. Fitur Card File MYOB Accounting digunakan untuk …… 

A. Menghitung pajak penghasilan karyawan termasuk di dalamnya 

kemampuan untuk mendeposit langsung 

B. Memberikan instruksi atau perintah pembukuan/pencatatan atas 

seluruh transaksi pembelian secara teroganisir 

C. Mengelola atau manage masalah persediaan barang dagangan yang 

dimiliki perusahaan secara efektif dan effesien 

D. Memberikan perintah membuat kartu-kartu yang diperlukan dalam 

pembukuan menggunakan MYOB Accounting 

4. Yang dimaksud dengan Current Financial Year adalah …… 

A. Banyaknya periode akuntansi dalam satu tahun keuangan 

perusahaan 

B. Tahun fiskal keuangan perusahaan 

C. Bulan konversi akuntansi  

D. Tahun berakhir dari tahun keuangan (tahun akuntansi) 



 

 
57 

Komputer Akuntansi Perusahaan Manufaktur 
 

5. Di bawah ini manakah langkah yang digunakan untuk memasukkan saldo 

awal pada masing-masing perkiraan/akun ……. 

A. Setup, Account Opening Balance 

B. Command Center, Account Opening Balance 

C. Edit, Account Opening Balance 

D. Setup, Balances, Account  Opening Balance 

6. Jika kita ingin membuat dan mendesain sendiri daftar account maka pada 

setup MYOB kita dapat menggunakan pilihan …….. 

A. I would like a start with one of the last provided by MYOB Accounting 

B. Last Month of financial Year 

C. I would like to build my own account list one Indonesia begin using 

MYOB 

D. I would like to import a list of account provide by my accountant after 

I’m done creating my company file 

7. Akuntansi disebut juga dengan Akun (Account) yang artinya rekening 

atau perkiraan. Interpretasi akuntansi terdiri dari tiga bagian yaitu… 

A. Pengidentifikasian, Pengukuran, dan Pengkomunikasian 

B. Mengidentifikasikan, Pengukuran, dan Peringkasan 

C. Mengidentifikasikan, Penganalisaan, dan Pengikhtisaran 

D. Pencatatan, Peringkasan, dan Pelaporan 

8. Enter Information about your company adalah merupakan pernyataan 

pada tahap  awal dalam pembuatan data perusahaan yang pada intinya 

berisi tentang pengisian data sebagai berikut… 

A. Company Name, Address, Phone Number, Fax Number, Email 

Address 

B. Company Name, Lay Out, Current Finacial Years, Adress, Conversion 

Month 

C. Company Name, Number of accounting Periods, Address, Phone 

number, Fax Number 

D. Company Name, Address, Phone Number, Lay Out, Accounts 

Number 
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9. Kolom informasi perusahaan yang harus diisi (tidak boleh kosong) adalah 

…. 

A. Serial Number 

B. Company Name 

C. Address 

D. Phone and fax number 

10. Yang dimaksud dengan Conversion Month adalah …. 

A. Bulan saat terjadinya penutupan buku 

B. Bulan saat perpindahan ke komputer akuntansi 

C. Bulan awal periode akuntansi yang berjalan 

D. Bulan pergantian periode akuntansi 

11. Tipe file daftar akun berikut ini yang bisa bisa dimport adalah …. 

A. Daftar_Akun_CVJdwipa.xls 

B. Daftar_Akun_CVJdwipa.doc 

C. Daftar_Akun_CVJdwipa.txt 

D. Daftar_Akun_CVJdwipa.jpg 

12. Pada seting Linked account untuk Sales, dipertanyakan dua hal, (1) Asset 

account for tracking receivable: ….. dan Bank Account for Customer 

Receipts: ….. Jawaban yang akan Saudara isikan sesuai dengan 

urutannya adalah …. 

A. Kas di Bank dan Piutang Dagang. 

B. Kas di Bank dan Penjualan. 

C. Piutang Dagang dan Kas di Bank 

D. Penjualan dan Kas di Bank 

13. Yang termasuk dalam kelompok akun kontra di bawah ini adalah …. 

A. Kerugian Piutang Tidak Tertagih. 

B. Depresiasi Mesin Pabrik 

C. Cadangan kerugian Piutang  

D. Selisih Kas 

14. Dalam tab Selling Details pada Kartu Piutang terdapat kolom Income 

Account, pilih akun mana yang paling cocok untuk diisikan di kolom 

tersebut: 

A. Piutang Dagang 

B. Persediaan Barang 
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C. Penjualan  

D. Kas di Bank 

15. Saudara akan mengentri term of payment 2/10, n/30 dalam tab Buying 

Details pada Kartu Hutang. Maka pilihan format term of payment yang 

paling cocok untuk kasus di atas adalah … 

A. # of Days after EOM. 

B. On a Day of the month. 

C. Day of the month ofter EOM.  

D. In a Given # of Days. 

16. Dalam profile Kartu Persediaan (Inventory Card) terdapat tiga kriteria 

penting untuk setiap item persediaan yaitu (1). I Buy This Item; (2). Isell 

This Item dan (3). I Inventory This Item. Kriteria manakah yang akan 

Saudara ini untuk item persediaan Bahan Baku … 

A. Kriteria (1). 

B. Kriteria (1), (2). 

C. Kriteria (1), (3). 

D. Kriteria (1), (2), (3). 

17. Fitur MYOB yang manakah yang dapat digunakan untuk mengentri Kode 

dan Nama Departemen … 

A. File > Activities 

B. File > Jobs. 

C. Lists > Activities. 

D. Lists > Jobs. 

18. Pengecekan kebenaran entri data awal pada MYOB dapat dilakukan 

dengan memilih menu Command Centre Accounts > Company Data 

Auditor  dan satu pilihan menu lagi yaitu …. 

A. Company File Overview 

B. Account Reconciliation 

C. Transaction Review 

D. Tax Exception Review 
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19. Untuk mengentri data permintaan pembelian bahan dari bagian Gudang, 

Saudara dapat memilih Fitur MYOB yaitu menu Command Centre … 

A. Purchases > Enter Purchases > Quotes 

B. Purchases > Enter Purchases > Orders 

C. Purchases > Enter Purchases > Bills 

D. Purchases > Enter Purchases > Pay Bills 

20. Untuk mengentri data order pembelian didasarkan pada Quotes, Saudara 

dapat memilih Fitur MYOB yaitu menggunakan menu Command Centre 

… 

A. Purchases > Enter Purchases > Orders 

B. Purchases > Purchases Register > Orders 

C. Purchases > Purchases Register > Quotes > Change to Orders 

D. Purchases > Purchases Register > Change to Orders 

21. Fitur Menu Command Centre Purchases > Purchases Register > Orders 

> Receive Items digunakan untuk pencatatan … 

A. Penerimaan bahan-bahan yang diorder 

B. Penerimaan bahan-bahan yang diquote 

C. Penerimaan bahan-bahan yang dibeli 

D. Penerimaan bahan-bahan yang dibayar 

22. Untuk mengubah Orders menjadi Bills yang harus anda lakukan adalah 

pada windows … 

A. Purchases Regiters, pilih Change to Bill. 

B. Purchases Regiters, pilih Bill. 

C. Purchases Regiters, pilih Order dan Change to Bill. 

D. Purchases Regiters, pilih Pay Bill. 

23. Untuk mengentri pembayaran hutang yang didasarkan pada Bill yang 

diterima, Saudara dapat menggunakan menu Command Centre ….. dan 

kemudian pilih … 

A. Banking dan Spend Money 

B. Banking dan  Pay Bills. 

C. Purchases dan Bills. 

D. Purchases dan Pay Bills 
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24. Transaksi permintaan pemakaian bahan baku dari Depertemen-1 ke 

Bagian Gudang akan Saudara catat sebagai berikut … 

A. BDP Biaya Bahan Dep-1 di Debit dan Persedian di Kredit.  

B. BDP Biaya Bahan Dep-1 di Kredit dan Persedian Bahan Baku di 

Debit. 

C. BDP Biaya Bahan Dep-1 di Debit dan Persedian Bahan Baku di 

Kredit. 

D. BDP Dep-1 di Debit dan Persedian Bahan Baku di Kredit. 

25. Pembelian tunai bahan penolong untuk keperluan Depertemen A akan 

dientri …. 

A. Debit: Persedian bahan penolong, Kredit: Kas di Tangan 

B. Debit: BOP Sesungguhnya, Kredit: Kas di Tangan 

C. Debit: BDP BOP Departemen A, Kredit: Kas di Tangan 

D. Debit: BOP Departemen A, Kredit: Kas di Tangan 

26. Selama bulan Desember 2015 terdapat biaya overhead pabrik yang 

dibebankan kepada Departemen-1 sebesar Rp. 15.200.000,-. Transaksi 

ini akan dientri kedalam jurnal umum sebagai berikut … 

A. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: Harga Pokok 

Penjualan Rp. 15.200.000,- 

B. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: BOP 

Sesungguhnya Rp. 15.200.000,- 

C. Debit: BOP Sesungguhnya Rp. 15.200.000,- dan Kredit: BDP BOP 

Dep-1 Rp. 15.200.000,- 

D. Debit: BDP BOP Dep-1 Rp. 15.200.000,- dan Kredit: Harga Pokok 

Produksi Rp. 15.200.000,- 

27. Transaksi penjualan barang jadi secara kredit sebesar Rp. 100.000.000,-   

disertai dengan PPN 10%, Hagra pokok penjualan  sebesar Rp. 

60.000.000,- Transaksi ini akan di entri oleh bagian akuntansi sebagai 

berikut …. 

A. Debit: Piutang dagang Rp. 110.000.000,- dan Kredit: Penjualan Rp. 

100.000.000,- dan PPN Keluaran Rp. 10.000,000,- 

B. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 100.000.000,- Kredit: Penjualan Rp. 100.000.000,- PPN Keluaran 

Rp. 10.000,000,- dan Persediaan Barang Jadi Rp. 100.000.000,- 
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C. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 60.000.000,- Kredit: Penjualan Rp. 110.000.000,- dan Persediaan 

Barang Jadi Rp. 60.000.000,- 

D. Debit: Piutang dagang Rp. 110.000.000,- dan Harga Pokok Penjualan 

Rp. 60.000.000,- Kredit: Penjualan Rp. 100.000.000,- PPN Keluaran 

Rp. 10.000,000,- dan Persediaan Barang Jadi Rp. 60.000.000,- 

28. Dibeli secara tunai perlengkapan penjualan sebesar Rp. 200.000,- 

Transaksi ini akan dientri sebagai berikut … 

A. Debet: BOP Sesungguhnya Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 

B. Debet: Harga Pokok Penjualan Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 

C. Debet: Beban Perlengkapan Penjualan Rp. 200.000,- dan Kredit: Kas 

Rp. 200.000,- 

D. Debet: BDP BOP Departemen Rp. 200.000,- dan Kredit: Kas Rp. 

200.000,- 

29. Transaksi Penyusutan aset tetap pabrik akan dientri …. 

A. Debit: Biaya Depresiasi Aset Tetap, Kredit: BOP Sesungguhnya 

B. Debit: BOP Sesungguhnya, Kredit: Akumulasi Depresiasi Aset Tetap 

C. Debit: Biaya Depresiasi Aset Tetap, Kredit: Akumulasi Depresiasi 

Aset Tetap 

D. Debit: BOP Sesungguhnya, Kredit: Biaya Depresiasi Aset Tetap 

30. Asuransi Mesin Produksi yang sudah kedaluwarsa bulan Des. 2015 Rp. 

2.000.000,- akan dientri … 

A. Debit: Biaya Asuransi Rp. 2.000.000,-, Kredit: BOP Sesungguhnya 

Rp. 2.000.000,- 

B. Debit: BOP Sesungguhnya Rp. 2.000.000,-, Kredit: Biaya Asuransi 

Rp. 2.000.000,- 

C. Debit: Biaya Asuransi Dibayar Dimuka Rp. 2.000.000,-, Kredit: Kas di 

Bank Rp. 2.000.000,- 

D. Debit: BOP Sesungguhnya Rp. 2.000.000,-, Kredit: Asuransi Dibayar 

Dimuka Rp. 2.000.000,- 

 

 



 

 
63 

Komputer Akuntansi Perusahaan Manufaktur 
 

31. Penyesuaian untuk unit awal periode BDP 100 unit di Dep-1 adalah … 

A. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1; 

dan Kredit: Persediaan Barang Dalam Proses. 

B. Debit: Persediaan Barang Dalam Proses; Kredit: BDP Biaya Bahan 

Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1 

C. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-

1;dan Kredit: Persediaan Barang. 

D. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1. 

dan Kredit: BOP Sesungguhnya. 

32. Penyesuaian untuk transfer 900 unit dari Dep-1 ke Dep-2 adalah … 

A. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1; 

dan Kredit: BDP Biaya bahan Dep-2. 

B. Debit: BDP Biaya Bahan Dep-2; Kredit: BDP Biaya Bahan Dep-1, BDP 

BTKL Dep-1, BDP BOP Dep-1 

C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: BDP Biaya Bahan Dep-1. 

D. Debit: BDP Biaya Bahan Dep-1, BDP BTKL Dep-1, BDP BOP Dep-1. 

dan Kredit: Persediaan Barang Dalam Proses. 

33. Penyesuaian untuk unit akhir periode BDP 100 unit di Dep-2 adalah … 

A. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2; 

dan Kredit: Persediaan Barang Dalam Proses. 

B. Debit: Persediaan Barang Dalam Proses; Kredit: BDP Biaya Bahan 

Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2 

C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: Persediaan Barang. 

D. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-2. 

dan Kredit: BOP Sesungguhnya. 

34. Penyesuaian untuk pengurangan nilai Barang Dalam Proses akibat 

transfer 300 dari Dep-2 ke Gudang Barang Jadi adalah … 

A. Debit: Persediaan Barang Jadi; dan Kredit: Persediaan Barang Dalam 

Proses. 

B. Debit: Persediaan Barang Jadi; Kredit: BDP Biaya Bahan Dep-2, BDP 

BTKL Dep-2, BDP BOP Dep-2 
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C. Debit: BDP Biaya Bahan Dep-2, BDP BTKL Dep-2, BDP BOP Dep-

2;dan Kredit: Persediaan Barang Jadi. 

D. Debit: Persediaan Barang Jadi dan Kredit: BOP Sesungguhnya. 

35. Langkah untuk menampilkan Arus Kas dalam MYOB: 

A. Report > Banking > Statement of Cash Flow 

B. Report > Banking > Cash Flow Analysis 

C. Banking > Index to Reports > Statement of Cash Flow 

D. Banking > Reports > Statement of Cash Flow 

36. Laporan yang menginformasikan kemampuan perusahaan dalam 

membayar seluruh kebutuhannya pada periode tertentu adalah: 

A. Laporan Laba-Rugi 

B. Neraca 

C. Laporan perubahan modal 

D. Arus Kas 

37. Laporan yang menginformasikan kemampuan perusahaan prestasi 

keuangan dalam periode tertentu adalah: 

A. Laporan Laba-Rugi 

B. Neraca 

C. Laporan perubahan modal 

D. Arus Kas 

38. Laporan yang menginformasikan posisi aset, kewajiban dan equitas 

perusahaan pada periode tertentu adalah: 

A. Laporan Laba-Rugi 

B. Neraca 

C. Laporan perubahan modal 

D. Arus Kas 

39. Langkah untuk me-restore backup fle: 

A. File > Pilih Bakcup file > Restore > Open > Ketik nama file > Save 

B. File > Restore > Open > Ketik nama file > Save 

C. File > Restore > Pilih Backup file > Save > Ketik nama file > Open 

D. File > Restore > Pilih Backup file > Open > Ketik nama file > Save 
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1. Soal Praktek. 

 

Tugas didasarkan pada kasus CV Jayadwipda, yang secara lengkap 

dapat Saudara lihat di Lampiran 1, saudara diminta: 

1. Menyelesaikan pekerjaan komputer akuntansi untuk kasus CV 

Jayadwipdadan menyerahkan file data akuntansi CV Jayadwipda. 

(LK-Ev1). 

2. Menyerahkan file backup data akuntansi CV Jayadwipda (LK-Ev2). 
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Penutup 

 

Penyusunan Modul Guru Pembelajar Komputer Akuntansi Perusahaan dan Jasa 

Kelompok Kompetensi J ini disusun sebagai bahan ajar bagi Guru Pembelajar 

dalam pelaksanaan kegiatan Pengembangan Keprofesian Berkelanjutan. Melalui 

bahan ajar ini Guru Pembelajar khususnya guru bidang keahlian akuntansi 

diharapkan dapat  menemukan kemudahan dalam mempelajari isi dan kegiatan 

pembelajarannya. 

Keberadaan Modul ini merupakan salah satu bentuk bahan pendukung bagi Guru 

Pembelajar guna merealisasikan proses ketercapaian kompetensi profesional 

yang diharapkan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
67 

Komputer Akuntansi Perusahaan Manufaktur 
 

Daftar Pustaka 

 

Anonim. 2015.Perlakuan Akuntansi Dan Jurnal Pembagian Dividen. 

www.jurnalakuntansikeuangan.com : [diakses pada tanggal 17 

Nopember 2015] 

Direktorat Jenderal Guru dan Tenaga Kependidikan, Kementerian Pendidikan 

dan Kebudayaan. 2015. Pedoman Penyusunan Modul Diklat 

Pengembangan Keprofesian Berkelanjutan Bagi Guru dan Tenaga 

Kependidikan. Jakarta. 

Ikram, Syafrizal. 2013. Akuntansi Praktik Menggunakan Aplikasi MYOB. 

Bandung:Yrama Widya. 

Kementrian Pendidikan dan Kebudayaan. 2014/2015. Ujian Nasional Praktik 

Kejuruan Kompetensi Keahlian Akuntansi. Jakarta:Kemdikbud. 

Mandhamarin.2013.Mengelola-Kartu-Persediaan-Barang-

Dagang.Http://mandhamartin.blogspot.co.id:[diaskses tanggal 7 

Nopember 2015] 

MYOB AccountRight Enterprise v19. 2013. MYOB  AccountRight Enterprise v19 

Tutorial PDF. Copyright Information, Technologi Ltd. 

MYOB AccountRight Enterprise v19. 2013. Help Centre. Copyright Information, 

Technologi Ltd. 

Shinta, Diana. 2012. Seri Pedalaman Materi Akuntansi untuk SMK dan MAK. 

Jakarta:Erlangga. 

Suciono, Bimo dan Noviar, Deky.2011.Modul Mengoperasikan Komputer 

Akuntansi. Jakarta:Erlangga. 

Suciono, Bimo dan Noviar, Deky.2013. Modul Mengoperasikan Paket Pengolah 

Angka/Spreadsheet. Jakarta:Erlangga. 

Suyono. 2013. Komputer Akuntansi Jilid 1. Jakarta:Kementrian Pendidikan dan  

Kebudayaan 

Suyono. 2013. Komputer Akuntansi Jilid 2. Jakarta:Kementrian Pendidikan dan  

Kebudayaan  

 

 

http://www.jurnalakuntansikeuangan.com/
http://mandhamartin.blogspot.co.id/


 

 Modul Paket Keahlian Akuntasi Sekolah Menengah Kejuruan 
(SMK) 

 

68 

Glosarium 

 

Akun (Account) : Disebut   juga   rekening   atau   perkiraan   adalah 
formulir untuk mencatat secara indivual tentang 
penambahan atau pengurangan tiap jenis harta, 
kewajiban, dan ekuitas. 

Account Opening 
Balance 

: Saldo Awal Neraca, Saldo perkiraan ketika awal 
periode. Saldo awal neraca bisa dimasukan dalam 
satu Form secara langsung. 

Account Receivable 
(Trade Debtor) 

: Piutang Dagang, yaitu tagihan kepada para 
pelanggan karena adanya trasaksi penjualan 

Account Payable 
(Trade Creditor) 

: Utang Dagang, yaitu kewajiban perusahaan yang 
harus dibayar perusahaan karena danya transaksi 
pembelian. 

Adjust Inventory : Suatu aktivitas menyesuaikn barang yang ada di 
gudang 

Akuntansi : Suatu   proses   yang   meliputi   kegiatan 
pengidentifikasian, pencatatan, pengikhtisaran dan 
pelaporan data keuangan. 

Aplikasi Komputer 
Akuntansi 

: Program terintegrasi yang disusun untuk penerapan 
sistem komputerisasi di bidang akuntansi. 

Asset : Aset  atau  Aktiva,  yaitu  seluruh  kekayaan  yang 
dimiliki oleh perusahaan 

Bagan akun (Chart 
of Account) 

: Daftar     akun     dan     nomor     kodenya     yang 
mengidentifikasi tempatnya dalam buku besar. 

Building : Gedung  (Bangunan),  yaitu  salah  satu  aset  tetap 
yang dimiliki oleh perusahaan. 

Buku besar (ledger) 
Cash Flow 
Statement 

: Buku yang berisi akun-akun harta, kewajiban, dan 
ekuitas atau kumpulan dari kartu-kartu akun. 
Laporan   Arus   Kas,   yaitu   salah   satu   laporan 
keuangan   yang   memberikan   informasi   tentang 
aliran  kas  masuk  dan  kas  keluar  dari  kegiatan 
operasi, investasi dan pendanaan. 

Cash on Hand : Jumlah kas yang dimiliki oleh perusahaan. 

Card File : File  Kartu,  yaitu  kartu  untuk  mencatat  informasi 
setiap pelanggan dan pemasok (Customers and 
Suppliers) 

Cheque Book : Buku Cek, kumpulan cek yang siap untuk diisi dan 
digunakan untuk pembayaran. 

Current Asset : Aktiva    Lancar,    yaitu    kelompok    aset    yang 
perputarannya dalam jangka pendek  (kurang dari 
satu tahun). 

Current Liabilities : Kewajiban Lancar (Utang Lancar), yaitu salah satu 

Command Centre 
Account 

: Bentuk kewajiban yang harus dituaikan dalam waktu 
satu tahun atau kurang. 
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Command Centre 
Sales 

: Pusat kendali pada MYOB yang berfungsi untuk 
pembuatan  daftar  akun,    pencatatan  saldo  awal 
buku besar, pembuatan jurnal umum, posting dan 
laporan keuangan. 

Command Centre 
Banking 

: Pusat kendali pada MYOB yang berfungsi untuk 
mencatat penerimaan uang yang bukan bersumber 
dari penerimaan piutang dan pengeluaran cek  yang 
bukan untuk pembayaran utang. 

Command Centre 
Purchases 

: Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
penjualan, retur penjualan dan penerimaan piutang 
serta  menyajikan laporan  yang  berhubungan 
dengan penjualan, misalnya rekap penjualan per 
item atau per costumer, analisis piutang dan 
sebagainya. 

Command Centre 
Inventory 

: Pusat kendali pada MYOB yang berfungsi untuk 
mencatat, menampilkan/mencetak transaksi 
pembelian, retur pembelian dan pembayaran utang 
serta  menyajikan laporan  yang  berhubungan 
dengan pembelian, misalnya rekap pembelian per 
item atau per supplier. 

Command Centre 
Card 

: Pusat kendali pada MYOB yang berfungsi untuk 
mencatat item barang yang dibeli untuk dijual, 
penggabungan komponen menjadi satu unit barang 
baru atau sebaliknya, menyajikan laporan yang 
berkaitan dengan persediaan. 

DDB : Salah satu fungsi software spreadsheet yang 
digunakan untuk menghitung penyusutan dengan 
metode saldo menurun ganda. 

Debit : Sisi sebelah kiri suatu akun. 

Deposit paid : Uang  Muka  atau  uang  panjar  yang  dibayarkan 
kepada supplier 

Double Entry System : Sistem pencatatan dari efek ganda (dual effect) dari 
tiap transaksi secara tepat. 

Electric Expense : Beban Listrik 

Equipment : Peralatan, salah satu jenis aset tetap. 

Equity  : Ekuitas atau modal 

Expenses : Beban-beban operasi atau non operasi perusahaan. 

Fixed Asset : Aktiva Tetap, yaitu aset yang umurn pemakaiannya 
lebih dari satu tahun. 

Furniture : Meubel, yaitu termasuk salah satu jenis aset tetap 
perusahaan. 

General Ledger : Buku Besar, yaitu kumpulan akun-akun. 

General Journal 
Entry 

: Formulir  untuk mencatat Jurnal Umum 

Income : Penghasilan (Pendapatan) 

Interest Expense : Beban Bunga, yaitu beban non operasi perusahaan 

Interest Revenue : Pendapatan  Bunga,  salah  satu  pendapatan  yang 
termasuk dalam non operasi 
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Jurnal : Buku  catatan  akuntansi  yang  digunakan  untuk 
mencatat transaksi-transaksi keuangan yang terjadi 
setiap hari. 

Jurnal umum : Bentuk  jurnal  yang  paling  umum  dipakai  untuk 
mencatat semua jenis transaksi. 

Kredit (credit) : Sisi kanan suatu akun. 

LAN : Local Area Network Jaringan untuk daerah kecil, 
biasanya menggunakan kabel dan satu buah hub 
switch contoh Labolatorium Akuntansi, atau Jaringan 
di sebuah kantor. 

Laporan Keuangan : Merupakan    ringkasan    dari    transaksi-transaksi 
keuangan yang terjadi selama satu periode 
akuntansi tertentu 

Liability : Kewajiban, yaitu sesuatu yang harus ditunaikan 
perusahaan. 

Linked Account : Jalur sistem penghubung antara pengisian data dan 
pencatatan ke jurnal. Jika Linked Account tidak 
sesuai, jurnal transasksi jadi tidak sesuai. MYOB 
telah menyediakan beberapa dari default ccount list 
yang tidak dapa dihapus, tetapi dapat digantikan 
dengan nomor dan nama akun yang lain.  

MYOB : Salah satu aplikasi komputer akuntansi yang dibuat 
oleh salah satu perusahaan di Australia yang 
merupakan singkatan dari Mind on Your Own 
Business. 

Neraca saldo (Trial 
Balance) 

: Daftar  akun-akun  buku-buku  dan  saldo-saldonya 
pada saat tertentu. 

Motor Vehicle  : Kendaraan  Bermotor,  yaitu  salah  satu  jenis  aset 
tetap 

Office Supplies : Suplies Kantor atau Bahan Habis Pakai (BHP) 
Other Expense          Beban lain-lain di luar opersai 
perusahaan. 

Payroll Check : Cek Gaji, yaitu cek yang khusus untuk pembayaran 
gaji. 

Periode Akuntansi : Rentangan waktu akuntansi yang dimulai pada saat 
pembuatan neraca awal sampai dengan saat 
pembuatan  laporan  keuangan,  biasanya  selama 
satu tahun. 

Perusahaan Jasa : Entitas  bisnis  yang  usaha  pokoknya  memperoleh 
pendapatan dengan memberikan layanan jasa 
kepada pelanggan 

Posting : Prosedur memasukkan/memindahkan data dari 
jurnal ke buku besar. 

Profit and Loss 
Report 

: Laporan Laba Rugi, salah satu jenis laporan yang 
memberikan     informasi      tentang      pendapatan 
dibandingkan dengan beban-beban perusahaan. 
Cadangan kerugian piutang, dana yang disediakan 

Provision for doubtful 
debt 

: Transaksi Keuangan untuk menutup kerugian akibat 
piutang yang tidak tertagih. 
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Telephone Expense  : Beban Telepon, yaitu pembayaran tagihan rekening 
telkom. 

Transaction : Kegiatan ekonomis  yang dilakukan oleh perusahaan 
yang secara financial berdampak pada perubahan 
posisi keuangannya. 

Journal : Jurnal  Transaksi,  yaitu  catatan  hasil  pemrosesan 
jurnal transaksi keuangan tertentu. 

Trial Balance : Neraca Saldo, yaitu selisih antara jumlah debit 
dan jumlah kredit akun-akun yang ada dalanm 
buku besar. 

Other Income : Penghasilan    Lain-lain    di    luar    usaha    pokok 
perusahaan. 

Rent Expense : Beban      Sewa,      yaitu      pembayaran      sewa 
gedung/peralatan. 

Retained Earning : Laba  Ditahan,   yaitu  sebagian  laba  yang  tidak 
dibagikan kepada pemilik perusahaan. 

Salaries and Wages 
Expenses 

: Beban Gaji dan Upah, yaitu pembayaran gaji/upah 
pegawai bulanan. 

SLN : Salah satu fungsi software spreadsheet yang 
digunakan untuk menghitung penyusutan dengan 
metode garis lurus 

Spreadsheet : Salah satu aplikasi komputer yang terdiri atas lajur-
lajur dibuat oleh salah satu perusahaan Microsoft di 
Amerika yang banyak digunakan untuk membantu 
menghitung, menganalisis, membuat grafik, dan 
manajemen data. 

SYD : Salah satu fungsi software spreadsheet yang 
digunakan untuk menghitung penyusutan dengan 
metode jumlah angka tahun. 

Water Expense : Beban Air, yaitu pembaran tagihan rekening PDAM. 

Value Added Tax 
(VAT) 

: Pajak yang dikenakan atas penambahan nilai 
produksi pada setiap tingkat kegiatan produksi dan 
proses distribusi barang. Tipe pajak ini berlaku 
hampir di semua negara, yaitu transaksi pajak 
pertambahan nilai dan pajak pembelian yang telah 
dibayarkan ke Supplier, dan bisa dikreditkan dengan 
nilai pajak keluaran yang kita kenakan ke Custumer 
saat terjadi penjualan 
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Lampiran 

Lampiran 1 Kasus CV Jayadwipa 

Kasus Akuntansi Perusahaan Manufaktur 

(Kasus ini diambil dari Modul Akuntansi Perusahaan Manufaktur, 

Metode Harga Pokok Proses, Irsan Lubis S.E.Ak. Pusat Pengembangan 

Penataran Guru Kejuruan, Depok, 2006 dengan beberapa perubahan) 

 

A. Identitas Perusahaan Dan Usaha Pokok 

 Nama perusahaan  : CV. Jayadwipa 

 Nama pemilik  : Rio Suyoko 

 Alamat perusahaan : Jl. Maluku I, Blok Q3/5 Pamulang Permai, 

Tangsel. 

 Telepon  : 021 7431270 

 Nomor NPWP  :  17.613.120.9-035.000 

 Usaha pokok  :  Produksi kursi goyang, merk “GoYanK” 

 Proses produksi : 

 Pembuatan kursi goyang melalui 2 departemen, yaitu Departemen 

Assembling yang merakit menjadi rangka kursi goyang dari bahan 

potongan kayu ramin dan kayu rasalama, untuk selanjutnya dikirim ke 

Departemen Finishing. 

 Departemen Finishing menyelesaikan rangka kursi menjadi barang 

jadi yang siap dijual.  

 

B. Kebijakan akuntansi CV. Jayadwipa: 

 Sistem   : Komputerisasi per 1 Desember 2015. 

 Program aplikasi : Software MYOB AccountRight v19. 

 Metode  : Harga pokok proses (Process Costing). 

 Periode akuntansi : Januari s.d Desember 2015. 

 Bulan transaksi : Desember 2015. 
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C. Posisi Saldo per 30 Nopember 2015  

Neraca Saldo per 30 Nopember 2015 sebagai berikut: 

Nama Akun Debit Kredit 

Kas di Bank 400.000.000,00  

Piutang dagang 55.000.000,00  

Asuransi dibayar dimuka 13.500.000,00  

Persediaan bahan baku 37.500.000,00  

Persediaan bahan penolong 1.200.000,00  

Persediaan bahan dalam proses 48.610.000,00  

Persediaan barang jadi 0,00  

PPN Masukan 180.000,00  

Tanah 15.000.000,00  

Bangunan 28.800.000,00  

Akumulasi penyusutan bangunan  10.150.000,00 

Mesin 12.000.000,00  

Akumulasi penyusutan mesin  4.800.000,00 

Hutang dagang  37.500.000,00 

Hutang biaya  1.800.000,00 

Hutang PPh pasal 21  0,00 

PPN Keluaran  240.000,00 

Modal Rio Suyoko  500.000.000,00 

Prive Rio Suyoko 500.000,00  

Saldo Laba  57.800.000,00 

Jumlah 612.290.000,00 612.290.000,00 

 

Daftar nama Pelanggan dan saldo Piutang per 30 Nopember 2015 

Kode Nama Pelanggan No & Tgl. Faktur Saldo 

P-001 Toko Ria Mebel, Jakarta FP.1121 29/11/15 55.000.000,00 

P-002 Toko Borneo Mebel, Ciputat - - 

Jumlah 55.000.000,00 

 

Daftar nama Pemasok dan saldo Utang per 30 Nopember 2015 

Kode Nama Pemasok No & Tgl. Faktur Saldo 

S-001 UD Pelangi, Jakarta FP.131 30/11/15 37.500.000,00 

S-002 UD Sinar Jaya, Jakarta - - 

Jumlah 37.500.000,00 
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Daftar nama barang dan saldo persediaan per 30 Nopember 2015 

Kode 

Barang 

Nama Barang Saldo Persediaan Awal 

Qty Satuan Hg. pokok Jumlah 

Persediaan bahan baku     

K-01 Kayu Ramin 15 M3 1.000.000 15.000.000 

K-02 Kayu Rasamala 27,5 M3 600.000 16.500.000 

J-01 Jok Busa 100 M2 60.000 6.000.000 

 Jumlah    37.500.000 

Persediaan  bahan penolong     

Am-1 Amplas 5 Lb. 8.000 40.000 

Ca-1 Cat-Melamix 10 Kl. 80.000 800.000 

Ca-2 Cat-Semprot 2 Kl. 120.000 240.000 

De-1 Dempul 10 Kl. 12.000 120.000 

 Jumlah    1.200.000 

Persediaan barang jadi     

KG-01 Kursi GoYank - Buah - - 

      

 

D. Nama Departemen Produksi (Job List): 

Kode Job Nama Departemen Produksi 

Dep1 Departemen Assembling 

Dep2 Departemen Finishing 

 

E. Daftar Akun. 

No. Akun Nama Akun Header Tipe Akun 

10000 Aktiva H Asset 

11000 Aktiva Lancar H Asset 

11110 Kas Bank  Bank 

11112 Dana Belum Disetor  Bank 

11114 Akun Kliring Elektronik  Bank 

11120 Piutang Dagang  Accounts Receivable 

11122 Cadangan Piutang Tak Tertagih  Accounts Receivable 

11130 Asuransi Dibayar Dimuka  Other Current Asset 

11300 Persediaan H Asset 

11310 Persed Bahan Baku  Other Current Asset 

11320 Persed Bahan Penolong  Other Current Asset 

11330 Persed Bahan Dlm Proses  Other Current Asset 

11340 Persed Barang Jadi  Other Current Asset 

11400 Perlengkapan H Asset 

11410 Perlengkapan Kantor  Other Current Asset 

11420 Perlengkapan Pebrik  Other Current Asset 
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11430 Perlengkapan Penjualan  Other Current Asset 

11500 PPN Masukan  Other Current Asset 

12000 Aktiva Tetap H Asset 

12100 Tanah  Fixed Asset 

12210 Bangunan  Fixed Asset 

12220 Akum Dep Bangunan  Other Asset 

12310 Mesin Potong  Fixed Asset 

12320 Akum Dep Mesin Potong  Fixed Asset 

20000 Kewajiban H Liability 

21000 Kewajiban Lancar H Liability 

21100 Hutang Dagang  Accounts Payable 

21200 Hutang PPh  Other Current Liability 

21300 PPN Keluaran  Other Current Liability 

21500 Hutang Penerimaan Bahan  Other Liability 

21600 Hutang Gaji  Other Liability 

21700 Hutang Biaya  Other Liability 

22000 Kewjiban Jk Panjang H Liability 

22100 Hutang Bank Mandiri  Long Term Liability 

30000 Ekuitas H Equity 

30100 Modal Rio Suyoko  Equity 

30200 Prive Rio Suyoko  Equity 

30300 Saldo Laba Periode Lalu  Equity 

30800 Retained Earnings  Equity 

30900 Saldo Laba  Equity 

30999 Akun Penyeimbang  Equity 

40000 Pendapatan H Income 

40100 Penjualan  Income 

40200 Pot Penjualan  Income 

50000 Harga Pokok H Cost of Sales 

51000 Harga pokok penjualan  Cost of Sales 

52000 Biaya Produksi H Cost of Sales 

52100 BDP Biaya Bahan H Cost of Sales 

52110 BDP Biaya Bahan Dep1  Cost of Sales 

52120 BDP Biaya Bahan Dep2  Cost of Sales 

52130 Pot Pembelian Bahan  Cost of Sales 

52140 Retur Pembelian Bahan  Cost of Sales 

52150 Beban Angkut Pembelian  Cost of Sales 

52200 BDP Biaya Tenaga Kerja H Cost of Sales 

52210 BDP BTK Dep-1  Cost of Sales 

52220 BDP BTK Dep-2  Cost of Sales 

52300 BDP BOP H Cost of Sales 

52310 BDP BOP Dep-1  Cost of Sales 
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52320 BDP BOP Dep-2  Cost of Sales 

52400 BOP Sesungguhnya  Cost of Sales 

52500 Selisih BOP  Cost of Sales 

60000 Beban-Operasi H Expense 

60100 Wages & Salaries  Expense 

60200 Other Employer Expenses  Expense 

61000 Beban Penjualan H Expense 

61100 Beban gaji penjualan  Expense 

61200 Beban iklan  Expense 

61300 Beban Perlengk. Penjualan  Expense 

61400 Beban Penjualan lain-lain  Expense 

62000 Beban Adm H Expense 

62100 Baban Gaji Kantor  Expense 

62200 Beban Listrik dan Telpon  Expense 

62300 Beban Perlengk. Kantor  Expense 

62400 Beban Adm. Lain-lain  Expense 

80000 Pendapatan Lain-lain H Other Income 

80100 Pendapatan Jasa Giro  Other Income 

90000 Beban Lain-lain H Other Expense 

90100 Beban Bunga  Other Expense 

90200 Beban Adm. Bank  Other Expense 

 

F. Transaksi Keuangan Bulan Desember 2015 

Bukti no. 01 

CV. Jayadwipa – Tangerang Selatan 

Tanggal Permintaan Pembelian Bahan No. PP-01 

5-12-2015 Dari bagian Gudang:  Harap segera dibeli bahan-bahan sbb.: 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

200 K-01 Kayu Ramin - - - 

130 K-02 Kayu Rasamala - - - 

250 J-01 Jok Busa - - - 

20 Ca-1 Cat Melamix - - - 

30 Ca-2 Cat Semprot - - - 

100 Am-1 Amplas - - - 

5 De-1 Dempul - - - 
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Bukti no. 02 

CV. Jayadwipa – Tangerang Selatan 

Tanggal Surat Pesanan Pembelian Bahan  No. PP-02 

8-12-2015 Dari bagian Pembelian. Dikirim ke: UD Pelangi, Jakarta. Isi: harap segera dikirim pesanan ini. 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

200 K-01 Kayu Ramin 1.000.000/M3 200.000.000 PPN 

130 K-02 Kayu Rasamala 600.000/M3 78.000.000 PPN 

250 J-01 Jok Busa 60.000/M2 15.000.000 PPN 

 
 20 Ca-1 Cat Melamix 80.000/Kl 1.600.000 PPN 

30 Ca-2 Cat Semprot 120.000/Kl 3.600.000 PPN 

100 Am-1 Amplas 8.000/Lb 800.000 PPN 

5 De-1 Dempul 12.000/Kl 60.000 PPN 

 

Sub Total 299.060.000  

PPN 29.906.000  

Total Amount 328.966.000  

Bukti no. 03 

CV. Jayadwipa – Tangsel 

Tanggal Laporan Penerimaan Bahan  No. PP-03 

12-12-2015 Dari bagian Gudang (atas dasar PP-02  Tgl. 8/12/2015) 

 Qty Dipesan Qty Diterima Qty Selisih Item No. Description Ket 

200 200 - K-01 Kayu Ramin - 

130 130 - K-02 Kayu Rasamala - 

250 250 - J-01 Jok Busa - 

20 20 - Ca-1 Cat Melamix - 

30 30 - Ca-2 Cat Semprot - 

100 100 - Am-1 Amplas - 

5 5 - De-1 Dempul - 

Bukti no. 04 

UD. Pelangi, Jakarta 

Tanggal Faktur  No. FP-140 

12-12-2015 Tagihan kepada : CV. Jayadwipa, Tangsel.  Jatuh tempo tgl. 12/1/2016 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

200 K-01 Kayu Ramin 1.000.000/M3 200.000.000 PPN 
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130 K-02 Kayu Rasamala 600.000/M3 78.000.000 PPN 

250 J-01 Jok Busa 60.000/M2 15.000.000 PPN 

20 Ca-1 Cat Melamix 80.000/Kl 1.600.000 PPN 

30 Ca-2 Cat Semprot 120.000/Kl 3.600.000 PPN 

100 Am-1 Amplas 8.000/Lb 800.000 PPN 

5 De-1 Dempul 12.000/Kl 60.000 PPN 

 

Sub Total 299.060.000 - 

PPN 29.906.000 - 

Total Amount 328.966.000  

Bukti no. 05 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1201 

26-12-2015 Melunasi utang kepada UD Pelangi, Jakarta 

 Bukti Tgl. Uraian Jumlah (Rp) Ket 

FP-131 30/11 Saldo hutang Nop. 2015 37.500.000  

FP-140 12/12 Angsuran hutang Des. 2015 262.500.000  

     

  Jumlah dibayar 300.000.000  

 

Bukti no. 06 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Permintaan Bahan  No. PB-301 

16-12-2015 Permintaan dari bagian Departemen Assembling (Dep1) ke bagian gudang dan bag. Akuntansi atas surat 

perintah produksi no. 017. 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

100 K-01 Kayu Ramin 1.000.000/M3 100.000.000  

60 K-02 Kayu Rasamala 600.000/M3 36.000.000  

 Jumlah 136.000.000  

Bukti no. 07 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Permintaan Bahan  No. PB-302 

18-12-2015 Permintaan dari bagian Departemen Finishing (Dep2) ke bagian gudang dan bag. Akuntansi atas surat 

perintah produksi no. 017 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

40 K-02 Kayu Rasamala 600.000/M3 24.000.000  
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200 J-01 Jok Busa 60.000/M2 12.000.000  

60 Am-1 Amplas 8.000/Lb 480.000  

3 De-1 Dempul 12.000/Kl 36.000  

15 Ca-1 Cat Melamic 80.000/Kl 1.200.000  

20 Ca-2 Cat Seprot 120.000/Kl 2.400.000  

 Jumlah 40.116.000  

Bukti no. 08 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1202 

19-12-2015 Dibayarkan kepada Toko Ariwi 

 Uraian Jumlah (Rp) Ket 

Pembelian kain lap dam masker (perlengkapan pabrik) untuk 

Depatemen Finishing 
500.000  

Total 500.000  

Bukti no. 09 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar (BKK-1210) BKK-1203 

20-12-2015 Dibayarkan kepada Gunung Maras, Jakarta. 

 Uraian Jumlah (Rp) Ket 

Pembelian bahan penolong bulan Desember 2015 untuk 

Depatemen Finishing 
16.384.000  

Total 16.384.000  

Bukti no. 10 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1204 

20-12-2015 Dibayarkan kepada PLN & Telkom 

 Uraian Jumlah (Rp) Ket 

Tagihan Listrik dan Telepon untuk pemakaian pabrik  

Desember 2015 
5.500.000  

Total 5.500.000  

Bukti no. 11 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1205 

22-12-2015 Dibayarkan kepada UD Baretta Service, Jakarta 

 Uraian Jumlah (Rp) Ket 

Jasa tenaga helper dan cleaning service di pabrik 3.200.000  

Total 3.200.000  
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Bukti no. 12 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar BKK-1206 

25-12-2015 Dibayarkan kepada Karyawan 

 Uraian Gaji kotor PPh ps.21 Gaji dibayar 

Gaji dan Upah Produksi Des. 2015: 

Tenaga kerja langsung Dep assembling 4 orang 

Tenaga kerja langsung Dep assembling 4 orang 

 

4.584.714 

4.584.665 

 

 
15.122 
10.122 

 

4.569.592 

4.574.543 

Jumlah  9.169.379 25.244 9.144.135 

Gaji Bagian Kantor Des. 2015: 

Gaji bagian Administrasi dan Penjualan 6 orang 

 

13.272.530 

 

 

431.550 

 

 

12.840.980 

Jumlah 22.441.909 456.794 21.985.115 

Bukti no. 13 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar  BKK-1207 

28-12-2015 Dibayarkan kepada PLN & Telkom (Non Produksi) 

 Uraian Jumlah (Rp) Ket 

Rekening Listrik – Nopember 2015  300.000  

Rekening Telepon – Nopember 2015 150.000  

Perlengkapan kantor 120.000  

Total 570.000  

Bukti no. 14 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Keluar BKK-1208 

29-12-2015 Pembelian perlengkapan penjualan (Non Produksi) 

 Uraian Jumlah (Rp) Ket 

Pembelian perlengkapan penjualan: 

- Kertas bungkus cokelat 

- Tali rafia 

 

100.000 

15.000 

 

Total 115.000  

Bukti no. 15 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1201 

31-12-2015 BOP yang dibebankan dalam bulan Desember 2015 

 Uraian Jumlah (Rp) Ket 

BOP dibebankan kepada Departemen Assembling (Dep1) 

200 jam x Rp. 76.000,- 
15.200.000  

BOP dibebankan kepada Departemen Finishing (Dep2) 

168 jam TKL x Rp. 120.000,- 
20.160.000  
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Total 35.360.000  

Bukti no. 16 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1202 

31-12-2015 Pos penyesuaian untuk penyusutan bulan Desember 2015 

 Uraian Jumlah (Rp) Ket 

Mesin Pabrik 800.000  

Bangunan Pabrik 1.300.000  

Total 2.100.000  

Bukti no. 17 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1203 

31-12-2015 Penyesuaian untuk asuransi bangunan pabrik beban Desember 2015 

 Uraian Jumlah (Rp) Ket 

Asuransi Bangunan Pabrik telah kadaluarsa bulan Desember 

2015 (pencatatan sebelumnya sebagai aktiva) 
1.500.000  

Total 1.500.000  

 
 

Bukti no. 18 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1204 

31-12-2015 Unit awal periode barang dalam proses (100 unit) di Departemen Assembling (Dep1) 

 Uraian Jumlah (Rp) Ket 

Jumlah unit awal proses Dep. Assembling (Dep1) untuk 

diselesaikan lebih lanjut sebanyak 100 unit: 

 Biaya bahan  

 Biaya Tenaga Kerja Langsung  

 BOP  

 

 

18.920.000 

4.000.000 

7.960.000 

 

Total 30.880.000  

Bukti no. 19 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1205 

31-12-2015 Unit produksi ditransfer dari Dep Assembling (Dep1) ke Dep Finishing (Dep2) 

 Uraian Jumlah (Rp) Ket 

Jumlah Unit produksi ditransfer dari Dep Assembling (Dep1) 

ke Dep Finishing (Dep2) sebanyak 900 unit: 

 BDP - Biaya bahan  

 BDP - Biaya Tenaga Kerja Langsung  

 BDP - BOP 

 

 

 

136.693.800 

8.219.700 

21.269.700 

 

Total 166.183.200  
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Bukti no. 20 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1206 

31-12-2015 Unit akhir periode persediaan barang dalam proses di Departemen Assembling (Dep1) 

 Uraian Jumlah (Rp) Ket 

Persediaan BDP Dep1 pada akhir Des. 2015 sebanyak 100 

unit, dengan tingkat penyelesaian sbb: 

 Biaya bahan 60% 

 Biaya Tenaga Kerja 20% 

 BOP 40% 

 

 

18.225.840 

365.320 

1.890.640 

 

Total 20.481.800  

Bukti no. 21 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1207 

31-12-2015 Unit awal periode barang dalam proses 120 unit di Departemen Finishing (Dep2) 

 Uraian Jumlah (Rp) Ket 

Jumlah unit awal proses  Departemen Finishing (Dep2) untuk 

diselesaikan lebih lanjut sebanyak 120 unit: 

 Biaya bahan  

 Biaya Tenaga Kerja  

 BOP  

 

 

8.300.000 

4.250.000 

5.180.000 

 

Total 17.730.000  

 

Bukti no. 22 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1208 

31-12-2015 Unit barang jadi yang ditransafer dari Dep. Finishing ke Gudang 

 Uraian Jumlah (Rp) Ket 

Jumlah unit yang ditransfer dari  Departemen Finishing (Dep2) 

ke Gudang barang jadi sebanyak 920 unit x Rp.240.876 

dengan perincian: 

 Biaya bahan akumulatif (Dep1 dan Dep2) 

 Biaya tenaga kerja 

 Biaya BOP 

 

 

 

189.847.520 

8.210.080 

23.548.320 

 

Total 221.605.920  

Bukti no. 23 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1209 

31-12-2015 Unit akhir periode persediaan barang dalam proses di Departemen Finishing (Dep2) 

 Uraian Jumlah (Rp) Ket 
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Persediaan BDP Departemen Finishing (Dep2) pada akhir 

Des. 2015 sebanyak 100 unit, dengan tingkat penyelesaian 

sbb: 

 Biaya bahan akumulatif (Dep1 & Dep2) 100% 

 Biaya Tenaga Kerja 70% 

 BOP 70% 

 

 

 

20.635.600 

624.680 

1.791.720 

 

Total 23.052.000  

Bukti no. 24 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Memorial BM-1210 

31-12-2015 Pembebanan selisih BDP ke HPP 

 Uraian Jumlah (Rp) Ket 

Selisih BDP dibebankan ke HPP pada akhir bulan  sbb: 

 BDP Bahan Assembling 

 BDP Bahan Finishing   

 BDP TKL Assembling  

 BDP TKL Finishing   

 BDP BOP Assembling  

 BDP BOP Finishing   

 

360 

80 

(306) 

(95) 

(340) 

(40) 

 

Selish BOP dibebankan dengan BOP Sesungguhnya: 

      Selisih BOP 

 

2.060.000 
 

   

Bukti no. 25 

CV. Jayadwipa – Tangsel 

Tanggal Faktur Penjualan  No. FP-1201 

31-12-2015 Kepada : Toko Ria Mebel, Jakarta Jatuh tempo 30 Pebr 2015 

 Qty Item No. Description Price/Unit (Rp) Total (Rp) Tax 

600 GY-01 Kursi goyang 500.000 300.000.000 PPN 

      

   PPN 10% 30.000.000  

 Jumlah 330.000.000  

Bukti no. 26 

CV. Jayadwipa – Tangsel 

Tanggal Bukti Kas Masuk BKM-1201 

31-12-2015 Menerima pelunasan piutang dari Toko Ria Mebel, Jakarta 

 Bukti Tgl. Uraian Jumlah (Rp) Ket 

FP-1101 30/11 Saldo piutang Nop. 2015 55.000.000  

FP-1201 31/12 piutang Des. 2015 45.000.000  

     

  Jumlah dibayar 100.000.000  
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Refleksi Pembelajaran 

Pendahuluan 

 

A. Latar Belakang 

 

iundangkannya Undang-undang RI Nomor 14 Tahun 2005 tentang 

Guru dan Dosen, dan  Peraturan Menteri Pendidikan Nasional 

(Permendiknas) No. 16 Tahun 2007 tentang Standar Kualifikasi 

dan Kompetensi Guru Mata Pelajaran merupakan bukti pengakuan terhadap 

profesionalitas pekerjaan guru dan dosen.Bagi para guru pengakuan dan 

penghargaan di atas harus dijawab dengan meningkatkan profesionalisme 

dalam bekerja.  

 
Permendiknas No. 16 Tahun 2007 menyebutkan, ada empat kompetensi 

yang wajib dimiliki oleh seorang guru mata pelajaran, yaitu  kompetensi 

Pedagogik, kepribadian, sosial, dan profesional. Masing-masing kompetensi 

ini memiliki beberapa kompetensi  inti. Salah satu kompetensi  inti pedagogik 

yang sangat penting dan harus dikuasai oleh pendidik  yakni  “Melakukan 

tindakan reflektif untuk peningkatan kualitas pembelajaran”.  Tindakan ini 

sangat penting dilakukan Karena melalui diary (instrumen refleksi) dapat 

diperoleh informasi positif tentang bagaimana cara gurumeningkatkan 

kualitas pembelajarannya, sekaligus sebagai bahan observasi untuk 

mengetahui sejauh mana tujuan pembelajaran itu tercapai.  

 
Guru tidak selayaknya bekerja as usual seperti era sebelumnya, melainkan 

harus menunjukkan komitmen dan tanggung jawab yang tinggi. Setiap 

kinerjanya harus dapat dipertanggung jawabkan baik secara publik maupun 

akademik. Untuk itu ia harus memiliki landasan teoretik atau keilmuan yang 

mapan dalam melaksanakan tugasnya mengajar maupun membimbing 

peserta didik. 

 
Dalamkegiatanpembelajaran, seorang guru sudahpasti akan 

berhadapandenganberbagaipersoalanbaikmenyangkutpesertadidik, 

subjectmatter, maupunmetodepembelajaran. Sebagaiseorangprofesional, 

D 
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guru harusmampumembuatprefessionaljudgement yang didasarkanpada 

data sekaligusteori yang akurat. Selainitu guru 

jugaharusmelakukanpeningkatanmutupembelajaransecaraterusmenerus 

agar prestasibelajarpesertadidik optimal disertaidengankepuasan yang 

tinggi. Untukmewujudkanhaltersebut guru harusmembekali 

diridengankemampuanmeneliti, khususnyamelalui PenelitianTindakanKelas. 

Denganlatarbelakang di atas, semogamodulPengembangan Keprofesian 

Berkelanjutan (PKB)   Kompetensi Pedagogik  Guru Kejuruan  (Grade 10) 

inidapat membantu guru dalam melakukan refleksi terhadap pembelajaran 

yang telah dilaksanakannya.    

 

B. Tujuan 

Setelah menyelesaikan materi pelatihan ini peserta diharapkan dapat : 

1. Melakukan refleksi terhadap pembelajaran yang telah dilaksanakan 

2. Memanfaatkan hasil refleksi untuk perbaikan dan pengembangan 

pembelajaran dalam mata pelajaran yang diampu 

3. Melakukan penelitian tindakan kelas untuk meningkatkan kualitas 

pembelajaran dalam mata pelajaran yang diampu 
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C. Peta Kompetensi 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tindakan 
Reflektif Untuk 
Peningkatan 

Kualitas 
Pembelajaran 

 

Melakukan 
penelitian 
tindakan 

kelas untuk 
meningkatk

an 
kualitaspem

belajaran 
dalam mata 

pelajaran 
yang 

diampu 

 

 
Memanfaatka

n hasil 
refleksi 
untuk 

perbaikan 
dan 

pengembang
an 

pembelajara
n dalam 

mata 
pelajaran 

yang  
diampu 

 

a.  
Melakuka
n refleksi 
terhadap 

pembelaja
ran yang 

telah 
dilaksana

kan 

 

Diagnosis pelaksanaan 
pembelajaran 

c.  

d.  

Penilaian kesesuaian 
pelaksanaan pembelajaran 

dengan tujuan 
pembelajaran 

e.  

Komponen penyebab 
keberhasilan dan atau 

kegagalan dalam pelaksanaan 
pembelajaran 

g.  

Analisis hasil refleksi 
pembelajaran untuk perbaikan 

dan pengembangan 
pembelajaran 

i.  

Seleksi  hasil refleksi 
pembelajaran untuk bahan 

perbaikan dan pengembangan 
pembelajaran 

k.  

Fokus hasil refleksi 
pembelajaran untuk 

perbaikan  pembelajaran 
l.  

Memperjelas fokus masalah dalam 
pembelajaran pada mata pelajaran 

yang diampu 

m. Merinci  rencana perbaikan 
pembelajaran untuk meningkatkan 

kualitas pembelajaran pada 

mapelyang diampu 

Menyusun rencana penelitian 
tindakn kelas untuk meningkatkan 
kualitas pembelajaran dalam mapel 

yang diampu 

Melakukan penelitian tindakan kelas 
untuk meningkatkan 
kualitaspembelajaran dalam 

matapelajaran yang diampu 
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D. Ruang Lingkup 

1. Refleksi Pembelajaran  

a. Diagnosis pelaksanaan pembelajaran  

b. Penilaian kesesuaian pelaksanaan pembelajaran dengan tujuan 

pembelajaran 

c. Komponen penyebab keberhasilan dan atau kegagalan dalam 

pelaksanaan pembelajaran 

 

2. Pemanfaatan Hasil Refleksi Pembelajaran 

a. Analisis hasil refleksi pembelajaran untuk perbaikan dan 

pengembangan pembelajaran 

b. Seleksi  hasil refleksi pembelajaran untuk bahan perbaikan dan 

pengembangan pembelajaran  

c. Fokus hasil refleksi pembelajaran untuk perbaikan  pembelajaran  

 

3. Penelitian Tindakan Kelas (PTK) 

b. Memperjelas fokus masalah dalam pembelajaran pada mata 

pelajaran yang diampu 

c. Merinci  rencana perbaikan pembelajaran untuk meningkatkan 

kualitas pembelajaran pada mapel yang diampu 

d. Menyusun rencana penelitian tindakan kelas untuk meningkatkan 

kualitas pembelajaran dalam mapel yang diampu 

e. Melakukan penelitian tindakan kelas untuk meningkatkan kualitas 

pembelajaran dalam mata pelajaran yang diampu 

E. Petunjuk Penggunaan Modul 

 

Untuk membantu anda dalam menguasai kemampuan di atas, materi dalam 

modul ini dibagi menjadi tiga kegiatan belajar sebagai berikut : 

 Kegiatan belajar 1: Melakukan refleksi terhadap pembelajaran yang telah 

dilaksanakan 

 Kegiatan belajar 2: Memanfaatkan hasil refleksi untuk perbaikan dan 

pengembangan pembelajaran dalam mata pelajaran yang  diampu 
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 Kegiatan belajar 3: Melakukan penelitian tindakan kelas untuk 

meningkatkan kualitas pembelajaran dalam mata pelajaran yang diampu 

 
Anda dapat mempelajari keseluruhan modul ini dengan cara yang berurutan. 

Jangan memaksakan diri sebelum benar-benar menguasai bagian demi 

bagian dalam modul ini, karena masing-masing saling berkaitan. Setiap 

kegiatan belajar dilengkapi dengan uji kepahaman dan uji kompetensi. Uji 

kepahaman dan uji kompetensi menjadi alat ukur tingkat penguasaan anda 

setelah mempelajari materi dalam modul ini. Jika anda belum menguasai 

75% dari setiap kegiatan, maka anda dapat mengulangi untuk mempelajari 

materi yang tersedia dalam modul ini. Apabila anda masih mengalami 

kesulitan memahami materi yang ada dalam modul ini, silahkan diskusikan 

dengan fasilitator atau teman anda. 

Selamat mempelajari modul ini, semoga anda berhasil dan sukses selalu. 
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Kegiatan Pembelajaran 1 

Melakukan Refleksi Terhadap Pembelajaran yang 

Telah Dilaksanakan 
 

 

A. Tujuan 

 

Setelah mempelajari Kegiatan Belajar 1 peserta diklat diharapkan dapat 

melakukan refleksi terhadap pembelajaran yang telah dilaksanakan 

sesuai mata pelajaran yang diampu. 

 

 

B. Indikator Pencapaian Kompetensi 

 

Setelah menyelesaikan materi pelatihan ini, peserta diharapkan dapat: 

1. Mendiagnosis pelaksanaan pembelajaran yang telah dilakukan pada 

mata pelajaran yang diampu 

2. Menilai kesesuaian pelaksanaan pembelajaran yang telah dilakukan 

pada mata pelajaran yang diampu dengan tujuan pembelajaran yang 

ingin dicapai 

3. Menemukan komponen penyebab keberhasilan dan atau kegagalan 

dalam pelaksanaan pembelajaran pada mata pelajaran yang diampu. 
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C. Uraian Materi 

Untuk mencapai hasil pembelajaran yang optimal dibutuhkan guru yang 

kreatif dan inovatif yang selalu mempunyai keinginan terus menerus untuk 

memperbaiki dan meningkatkan mutu proses belajar mengajar (PBM) di 

kelas. Salah satu upaya tersebut adalah dengan melaksanakan Penelitian 

Tindakan Kelas (PTK). Dengan PTK kekurangan atau kelemahan yang 

terjadi dalam PBM dapat teridentifikasi dan terdeteksi.  

Kegiatan PTK dimulai dengan melakukan refleksi diri terhadap 

keterlaksanaan pembelajaran yang telah dilakukan pada mata pelajaran 

yang diampu dalam kurun waktu tertentu. 

1. Diagnosis Pelaksanaan Pembelajaran 

a. Pengertian Refleksi Pelaksanaan Pembelajaran 

Refleksi berarti bergerak mundur untuk merenungkan kembali apa 

yang sudah terjadi dan dilakukan. Guru sebagai pendidik dituntut 

untuk bertanggung jawab atas apa yang telah dilakukannya di 

kelas. Oleh karena itu perlu melakukan refleksi. Refleksi yang 

dimaksud disini adalah refleksi dalam pengertian introspeksi diri, 

seperti guru mengingat kembali apa saja tindakan yang telah 

dilakukan di dalam kelas, apa dampak dari tindakan tersebut, 

mengapa dampaknya menjadidemikian, dan lain sebagainya. 

Sebagaimana disebutkan oleh Schmuck  (1977), kita seperti 

melihat diri kita di dalam cermin tentang berbagai tindakan yang 

telah kita lakukan  dan harapan kita atas tindakan tersebut.  

 

Gambar 1 22 Kegiatan Merefleksi 
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Cara Melakukan Refleksi  Pelaksanaan Pembelajaran 

Refleksi dapat dilakukan dengan cara : pertama; meminta peserta 

didik memberikan penilaian terhadap guru. kedua; berupa hasil 

pengamatan langsung yang dilakukan oleh guru mata pelajaran 

sejenis selaku pengamat saat pelaksanaan pembelajaran 

berlangsung.Ada empat bidang masalah yang dapat dikembangkan 

yang menjadi tanggungjawab guru dalam mengelola pembelajaran, 

yaitu yang berkaitan dengan pengelolaan kelas, proses belajar-

mengajar,pengembangan/penggunaan sumber belajar, maupun 

sebagai wahana peningkatan personal dan profesional.  

 

b. Pengertian Diagnosis.  

Berdasarkan Kamus Besar Bahasa Indonesia (KBBI), diagnosis 

diartikan 1 penentuan jenis penyakit dengan cara meneliti 

(memeriksa) gejala-gejalanya; 2, Sos pemeriksaan terhadap suatu 

hal; sedangkan para ahli mengemukakan pendapatnya mengenai 

pengertian diagnosis antara lain, menurut Hariman dalam bukunya 

Handbook of Psychological Term, diagnosis adalah suatu analisis 

terhadap kelainan atau salah penyesuaian dari gejala-gejalanya.  

Dari pendapat diatas dapat diambil kesimpulan bahwa diagnosis 

adalah penentuan jenis masalah atau kelainan atau 

ketidakmampuan dengan meneliti latar belakang penyebabnya atau 

dengan cara menganalisis gejala-gejala yang tampak. 

 

c. Pentingnya Diagnosis Pelaksanaan Pembelajaran 

Diagnosis hasil pelaksanaan pembelajaran merupakan langkah 

yang sangat penting dalam peningkatan kualitas guru. Dengan 

teridentifikasinya masalah pembelajaran yang dialami oleh guru, 

maka usaha untuk mencari pemecahan masalah dalam 

pelaksanaan PTK akan menjadi lebih mudah. Identifikasi ini berisi 

deskripsi mengenai hal-hal yang dipandang guru tidak sesuai, 

kurang cocok, tidak memuaskan, dan lain sebagainya.  
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Dalam identifikasi masalah terdapat dua hal, yaitu masalah dan 

penyebab masalah. Biasanya, permasalahan dituangkan dalam 

rumusan masalah penelitian, sedangkan penyebab masalah 

dituangkan dalam latar belakang.  

 
Contoh kasus:  

Masalah: “Siswa tidak pernah mengerjakan tugas atau pekerjaan rumah 

(PR). Gejala permasalahan ini harus dijelaskan bukti-buktinya, apa tugas 

yang tidak dikerjakan, kapan saja ia tidak mengerjakan tugas, berapa 

banyak tugas yang tidak dikerjakan, dan lain sebagainya”. Latar belakang 

atau penyebabnya, terdapat beberapa kemungkinan: 

1) Tugas sekolah terlalu monoton dan tidak pernah dibahas bersama 

secara tuntas 

2) Tugas terlalu sulit bagi saya 

3) Banyak menonton acara TV sehingga mengabaikan tugas belajar 

4) Terlalu banyak bermain sehingga kehabisan waktu untuk mengerjakan 

tugas sekolah.    

 
Sekadar contoh, masalah pertama di atas dapat diatasi oleh guru dengan 

membuat tugas lebih kreatif kemudian membahasnya secara tuntas 

bersama-sama sehingga tidak membosankan. Masalah kedua dapat 

diatasi dengan cara mengukur kemampuan siswa sehingga tugas-tugas 

yang diberikan tidak terlalu memberatkan. Sedangkan dua penyebab 

yang terakhir tidak dapat dilakukan oleh guru. Disebabkan Penyebab ke-3 

dan ke 4.  Banyak menonton TV dan  terlalu banyak bermain, tidak 

mungkin dapat dikontrol oleh guru. Yang dapat dilakukan guru adalah 

dengan mengubah jenis-jenis tugas belajar yang lebih menantang, atau 

guru harus membahas setiap tugas secara bersama-sama dengan 

metode pengerjaan tugas yang cemerlang, sehingga siswa lebih senang 

dan termotivasi menyelesaikannya. 
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2. Menilai kesesuaian pelaksanaan pembelajaran dengan tujuan 

yang ingin dicapai 

Dalam setting pembelajaran, tujuan merupakan pengikat segala 

aktivitas guru dan siswa. Oleh sebab itu, merumuskan tujuan 

merupakan langkah pertama yang harus dilakukan dalam merancang 

sebuah program pembelajaran.  

a. Evaluasi diri.  

Evaluasi diri adalah aktivitas menilai sendiri keberhasilan proses 

pengajaran yang kita lakukan. Melakukan evaluasi diri merupakan 

aktivitas yang penting karena pertama, kita ingin memperbaiki 

kualitas pengajaran kita ; kedua kita tidak terlalu berharap banyak 

pada orang lain untuk mengamati proses pengajaran yang kita 

lakukan. Hasil evaluasi diri digunakan untuk menetapkan langkah 

selanjutnya dalam upaya untuk menghasilkan perbaikan-perbaikan. 

Prinsip-prinsip yang dapat digunakan adalah : kejujuran, 

kecermatan, dan kesungguhan. Dengan mengetahui kelemahan 

yang kita lakukan, kita dapat memperbaiki diri.  

b. Cara Melakukan Evaluasi Diri  

 Dalam menilai sendiri keberhasilan pengajaran, kita membutuhkan 

informasi yang dapat dijadikan bahan pertimbangan dalam 

menentukan berhasil atau tidaknya pengajaran yang telah kita 

lakukan. Informasi-informasi berupa hasil pengukuran tersebut di 

atas selanjutnya perlu dianalisis. Proses analisis dimulai dari: 

1) Menilai hasil-hasil pengukuran (tes atau non tes),  

2) Menetapkan tingkat keberhasilan dari masing-masing aspek 

penilaian 

3) Menentukan kriteria keberhasilan 

4) Menetapkan berhasil atau tidaknya aspek-aspek yang dinilai 

tersebut.  

5) Proses selanjutnya adalah memberi makna (pemaknaan) atas 

hasil analisis yang kita lakukan.  

6) Langkah selanjutnya adalah memberikan penjelasan, seperti: 

mengapa kegagalan itu bisa terjadi.  

7) Memberikan kesimpulan-kesimpulan yang masuk akal.  
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3. Menemukan Komponen Penyebab Keberhasilan dan Atau 

Kegagalan Dalam Pelaksanaan Pembelajaran 

a. Identifikasi faktor-faktor penyebab kegagalan pelaksanaan 

pembelejaran. 

Salah satu jenis penilaian yang dapat dilakukan guru dalam 

pembelajaran adalah penilaian diagnostik, yaitu penilaian yang 

berfungsi mengidentifikasi faktor-faktor Penyebab Kegagalan dan 

Pendukung Keberhasilan dalam Pembelajaran.  

  
Berdasarkan faktor-faktor penyebab kegagalan yang berhasil kita 

identifikasi diatas, kita merencanakan upaya-upaya perbaikan 

(remidi).  

 
b. Faktor-faktor  Penyebab Kegagalan Pembelajaran 

Kegiatan evaluasi pembelajaran dapat mengambil dua macam 

bentuk : 1). Menilai cara mengajar seorang guru dan 2).  Menilai 

hasil belajar (yakni pencapaian tujuan belajar).  

Beberapa hal yang dapat menyebabkan kegagalan dalam 

pelaksanaan pembelajaran, adalah :  a). Bahasa yang digunakan 

oleh guru sukar untuk dimengerti; b). Guru kurang bisa menguasai 

kelas;  c). Cara mengajar Guru yang membosankan, d). Guru 

kurang mampu memotivasi anak dalam belajar, e). Guru kurang 

memahami kemampuan anak didiknya di dalam menyerap 

pelajaran; f) Guru kurang disiplin dalam mengatur waktu.; g)Guru 

enggan membuat persiapan mengajar; h)Guru kurang menguasai 

materi, tidak mempunyai kemajuan untuk menambah atau menimba 

ilmu; i) Guru kurang terampil mengajukan pertanyaan kepada 

murid,. j) Guru hanya mengutamakan pencapaian target kurikulum. 

 

D. Aktivitas Pembelajaran 

Aktivitas Pembelajaran 1, 2 dan 3  (Tugas Mandiri) 

Anda  diminta mencari teman sejawat yang mengampu mata pelajaran 

sejenis. Telaahlah dokumen RPP teman sejawat Anda, kemudian tanyakan 
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kapan Anda bisa melihat yang bersangkutan mengajar. Lakukan hal-hal 

berikut ini : 

1. Amati  dan cermati proses pembelajaran yang dilakukan oleh teman 

sejawat Anda. Gunakan lembar pengamatan proses belajar mengajar 

(Lamp. 1 - LK 1.1) 

2. Buatlah catatan kejadian selama proses pembelajaran berlangsung, 

gunakan  (Lamp. 2 -LK 2.1) 

3. Menilai penyebab ketidaksesuaian RPP dengan  pelaksanaan 

pembelajaran   ( Lamp. 2 -LK 2.2) 

 

E. Latihan/ Kasus /Tugas 

 

Latihan Pembelajaran 1 

Materi : Melakukan Refleksi Terhadap Pembelajaran Yang Telah 

Dilaksanakan 

Kegiatan : Curah pendapat dan diskusi prosedur pelaksanaan PTK 

 

Setelah mencermati materi modul/berbagai sumber/referensi lainnya/tayangan 

yang disampaikan fasilitator, tuliskan pemahaman Saudara berkenaan dengan 

“Pembelajaran  1” 

1. Apa yang Anda fahami tentang refleksi pembelajaran ? 

2. Bagaimana cara Anda merefleksi pembelajaran yang telah dilaksanakan ? 

3. Menurut Anda,  mengapa kegiatan evaluasi diri penting dilakukan? 

Jelaskan berikut alasannya. 

4. Sebutkan dan jelaskan hal-hal yang dapat menyebabkan kegagalan dalam 

pelaksanaan pembelajaran. 
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F. Rangkuman 

i. Kegiatan mendiagnosis pelaksanaan pembelajaran yang telah 

dilaksanakan terhadap mata pelajaran yang diampu, selalu diawali 

dengan kegiatan refleksi. Refleksi berarti bergerak mundur untuk 

merenungkan kembali apa yang sudah terjadi dan dilakukan. 

 

ii. Refleksi pelaksanaan pembelajaran dapat dilakukan dengan 

cara:pertama; meminta peserta didik memberikan penilaian terhadap 

guru. kedua; berupa hasil pengamatan langsung yang dilakukan oleh guru 

mata pelajaran sejenis selaku pengamat saat pelaksanaan pembelajaran 

berlangsung. 

iii. Untuk mengetahui kesesuaian pelaksanaan pembelajaran dengan tujuan 

yang ingin dicapai, dapat menggunakan penilaian diagnostik, yaitu 

penilaian yang berfungsi mengidentifikasi faktor-faktor Penyebab 

Kegagalan dan Pendukung Keberhasilan dalam Pembelajaran.  

 

G. Umpan Balik dan Tindak Lanjut 

 

Tabel 1- 1Umpan balik kegiatan belajar 1. 

 

No. Indikator Pencapaian 

Kompetensi 

Deskripsi Hasil 

Belajar 

Rencana Tindak 

Lanjut 

1 Mendiagnosis pelaksanaan 
pembelajaran yang telah 
dilakukan pada mata pelajaran 
yang diampu. 
 

  

2 Menilai kesesuaian pelaksanaan 
pembelajaran yang telah 
dilakukan pada mata pelajaran 
yang diampu 
 

  

3 Menemukan komponen 
penyebab keberhasilan dan 
atau kegagalan dalam 
pelaksanaan pembelajaran 
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Kegiatan Pembelajaran 2 

Memanfaatkan Hasil Refleksi Untuk Perbaikan dan 

Pengembangan Pembelajaran 
 

 

A. Tujuan 

 

 

Setelah mempelajari Kegiatan Belajar 2 peserta diklat diharapkan dapat 

memanfaatkan hasil refleksi untuk perbaikan dan pengembangan 

pembelajaran 

 

 

B. Indikator Pencapaian Kompetensi 

 

 

Setelah menyelesaikan materi pelatihan ini, peserta diharapkan dapat: 

1. Menganalisis hasil refleksi pembelajaran untuk perbaikan dan 

pengembangan pembelajaran 

2. Menyeleksi hasil refleksi pembelajaran untuk bahan perbaikan dan 

pengembangan pembelajaran pada mata pelajaran yang diampu 

3. Memfokuskan hasil refleksi pembelajaran yang penting untuk 

perbaikan pembelajaran selanjutnya pada mata pelajaran yang diampu 

 

 

 

 

 

 



 

 
99 

Refleksi Pembelajaran 

C. Uraian Materi 

1. Analisis Hasil Refleksi Pembelajaran Untuk Perbaikan Dan 

Pengembangan Pembelajaran 

Kegiatan menganalisis hasil refleksi pembelajaran ini merupakan 

kegiatan identifikasi masalah.  Kegiatan ini merupakan langkah pertama 

dalam menyusun rencana PTK. Identifikasi masalah ini mirip seperti 

diagnosis yang dilakukan oleh dokter kepada pasiennya. Jika 

diagnosisnya tepat, maka obat yang diberikan pasti mujarab. Begitupula 

sebaliknya sebaliknya.  

Identifikasi masalah menjadi titik tolak bagi perencanaan PTK yang lebih 

matang. Sebab, tidak semua masalah dapat diselesaikan dengan PTK. 

Berikut ini empat langkah yang dapat dilakukan agar identifikasi 

masalah mengenai sasaran.  

a. Masalah harus rill. Masalah yang diangkat adalah masalah yang 

dapat dilihat, dirasakan, didengar, secara langsung oleh guru. 

Misalnya: sebagian besar nilai Matematika siswa kelas X SMA “X” 

dibawah standar kelulusan.  

b. Masalahnya harus problematik. Permasalahan yang bersifat 

problematik adalah masalah yang dapat dipecahkan oleh guru, 

mendapat dukungan literatur yang memadai, dan kewenangan 

mengatasinya secara penuh. Misalnya sebagian besar siswa kelas 

X SMK “X”  tidak  lancar membaca teks bahasa Inggris.  

c. Manfaatnya jelas. Hasil PTK harus dapat dirasakan, bagaikan obat 

yang menyembuhkan.  

d. Masalah harus fleksibel, yakni bisa diatasi dengan 

mempertimbangkan kemampuan peneliti, waktu, biaya, tenaga, 

sarana-prasarana, dan lain sebagainya. .   

Setelah menemukan masalah yang rill, problematik, bermanfaat , dan 

fleksibel, masalah tersebut harus ditemukan akarnya. Selanjutnya akar 

masalah tersebut harus digali sedalam-dalamnya, sehingga ditemukan 

akar masalah yang benar-benar menjadi sumber penyebab utama 

terjadinya masalah. Akar masalah inilah yang nantinya akan menjadi 

tolok ukur tindakan.  
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2. Menyeleksi hasil refleksi pembelajaran untuk bahan perbaikan dan 

pengembangan pembelajaran pada mata pelajaran yang diampu 

Dari sekian banyak masalah yang kita temukan berdasarkan analisis 

refleksi diatas, dapat kita pilih salah satu masalah pembelajaran yang 

kita anggap paling penting dan harus segera diatasi.    

Dalam kegiatan pembelajaran di kelas, guru dapat mencermati  

masalah-masalah apa yang dapat dijadikan PTK. Ada empat yang dapat 

dijadikan masalah dalam PTK, yaitu (1) masalah yang barkaitan dengan 

pengelolaan kelas, (2) masalah proses belajar mengajar, (3) masalah 

pengembangan atau penggunaan sumber-sumber belajar; (4) masalah 

yang berkaitan dengan wahana peningkatan personal dan profesional.  

Beberapa contoh permasalahan dalam aspek pembelajaran yang 

dapat dijadikan kajian PTK, antara lain : 

a. rendahnya keterlibatan siswa dalam proses pembelajaran mata 

pelajaran  “x”; 

b. metode pembelajaran yang kurang tepat; 

c. perhatian siswa terhadap PBM mata pelajaran “x’ rendah 

d. media pembelajaran yang tidak ada atau kurang sesuai; 

e. sistem penilaian yang tidak atau kurang sesuai; 

f. motivasi belajar siswa rendah; 

g. rendahnya kemandirian belajar siswa; 

h. siswa datang terlambat ke sekolah 

i. desain dan strategi pembelajaran di kelas.  

j. penanaman dan pengembangan sikap serta nilai-nilai; 

k. alat bantu, media dan sumber belajar 

l. bagaimana meningkatkan minat dan motivasi siswa dalam belajar; 

m. bagaimana mengajak siswa aktif belajar di kelas 

n. bagaimana menghubungkan materi pembelajaran dengan 

lingkungan kehidupan sehari-hari 

o. bagaimana memilih strategi pembelajaran yang tepat; 

p. bagaimana melaksanakan pembelajaran kooperatif; 

q. dan permasalahan ptk lainnya. 
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Permasalahan dalam PTK juga dapat didekati dari faktor input, proses, 

output.   

Teknik Mencari Permasalahan. 

Untuk memudahkan menemukan permasalahan dalam mencari  

permasalahan PTK  dapat menggunakan pertanyaan sebagai berikut : 

a. apa yang sekarang sedang terjadi ? 

b. apakah yang sedang berlangsung itu mengandung permasalahan? 

c. apa yang dapat saya lakukan untuk mengatasinya ? 

d. saya ingin memperbaiki apanya ? 

e. saya mempunyai gagasan yang ingin saya cobakan di kelas saya. 

f. apa yang bisa saya lakukan dengan hasil semacam itu ?  

 

3. Memfokuskan hasil refleksi pembelajaran yang penting untuk perbaikan 

pembelajaran selanjutnya pada mata pelajaran yang diampu 

Setelah kita melakukan refleksi dan menemukan banyak 

permasalahan, tentunya guru harus memilih satu dari sekian banyak 

masalah yang menjadi fokusnya. Oleh karena itu guru harus yakin 

bahwa masalah yang dipilih memang masalah yang dapat 

ditanggulangi dan memang perlu prioritas untuk segera ditangani.  

Setelah kita mengidentifikasi permasalahan di kelas dan kita telah 

menentukan permasalahan yang akan diteliti, langkah selanjutnya 

adalah mengidentifikasi penyebab permasalahan tersebut terjadi. 

Tentunya penyebab permasalahan pembelajaran di kelas disebabkan 

oleh beberapa faktor yaitu faktor siswa, faktor guru, dan juga faktor 

sarana pendukungnya. Dalam langkah ini catatlah semua yang 

memungkinkan munculnya permasalahan dari tiga faktor tersebut. 

Setelah kita menentukan penyebab permasalahan tersebut, cobalah 

mencari data pendukung untuk memastikan bahwa permasalahan 

tersebut memang disebabkan oleh satu atau dua faktor yang telah kita 

tentukan. Di sini kita bisa melakukan studi awal dengan melakukan 

wawancara pada siswa dan atau teman sejawat, penyebaran angket, 

mengkaji daya serap siswa, atau melakukan pretes. Studi awal ini 

dilakukan untuk memastikan bahwa permasalahan yang terjadi itu 
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memang benar-benar terjadi, bukan hanya menurut perasaan guru 

semata.  

Dari hasil studi awal tersebut, kita akan memastikan permasalahan dan 

penyebabnya sehingga kita dapat melangkah ke tingkat selanjutnya 

yaitu penentuan solusi. Penentuan solusi atau jalan keluar pemecahan 

masalah harus mempertimbangkan faktor-faktor penyebabnya. seperti 

buku, diktat, atau lainnya yang inovatif. Dalam penentuan solusi, 

hendaknya didasarkan pada : a) Efektivitas dan efisiensi sumber daya 

yang ada.; b) Kemampuan Daya dukung (guru, sarana, kurikulum dll); 

c) Kemudahan pelaksanaan. Sebagai contoh apabila penyebabnya 

tidak dimanfaatkannya media sehingga PBM monoton, mungkin solusi 

yang akan diberikan adalah pemanfaatan media pembelajaran.  

Setelah permasalahan dan solusinya ditentukan, hal yang harus 

dilakukan adalah pembuatan judul. Syarat judul yang baik adalah : a) 

Judul harus sudah menggambarkan isi PTK. , b) Ada tindakan untuk 

mengatasi masalah, c) Menarik untuk dibaca isinya, d) Panjang 

diusahakan tidak lebih dari 15 kata (kalau terpaksa max 20 kata), e) 

Subjek penelitian sudah tergambar pada judul. 

Alternatif judul PTK :  

 Upaya meningkatkan x melalui y pada kelas ….SMK…  

 Peningkatan x dengan menggunakan y pada kelas… SMK …  

 Penggunaan y untuk meningkatkan … pada kelas … SMK… 

 

D. Aktivitas Pembelajaran 

Aktivitas Pembelajaran  1. ( Analisis Kasus ) 

Cermati contoh kasus dibawah ini : 

Di sebuah kelas terlihat Ibu Dewisedang merenung, ia tampak sedih dan 

kesal, karena selama pembelajaran dikelas sebagian besar siswa tidak 

memperhatikan apa yang ia sampaikan dan membosankan. Mereka 

nampak sibuk mengobrol sendiri, bahkan sebagian lagi lebih suka melihat 

keluar kelas. Padahal guru tersebut merasa sudah maksimal dalam 

penyampaian materi, ia telah mengajar dengan suara yang keras, tulisan di 
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papan pun terlihat dengan jelas dipapan. Namun mereka tetap saja 

melakukan hal-hal lain diluar kegiatan proses belajar, oleh karena itu guru 

tersebut sangat lelah dan merasa telah terkuras habis tenaganya karena 

telah mengeluarkan semua kekuatanya untuk menerangkan materi 

pelajaran kepada siswanya. 

Berdasarkan kasus tersebut, coba pikirkan beberapa hal dibawah ini : 

1. Identifikasikan apa yang menjadi penyebab permasalahan dalam 

kasus di atas. 

2. Dari hasil identifikasi permasalah tersebut, carikan solusi yang dapt 

dilakukan untuk mengatasi masalah tersebut sesuai komponen 

pembelajaran (Media pembelajaran, kurikulum/materi, metode 

pembelajaran/strategi, kompetensi guru, penilaian, dan peserta didik),  

3. Tetapkan salah satu dari alternatif tersebut sesuai kemampuan Anda, 

mengacu pada empat langkah prinsip dalam identifikasi masalah 

(masalah harus riil, problematik, manfaat jelas, dan fleksibel ).  

4. Untuk mengerjakan kasus ini Anda dapat menggunakan  “Lembar 

Kerja 2.1 “ (lamp.3) 

 

E. Latihan/ Kasus /Tugas 

 

Latihan Pembelajaran 2 

Materi : Memanfaatkan hasil refleksi untuk perbaikan dan 

pengembanganpembelajaran 

Kegiatan : Curah pendapat dan diskusi prosedur pelaksanaan PTK 

  

Setelah mencermati materi pada modul PTK, berbagai sumber/referensi 

lainnya dan tayangan yang disampaikan fasilitator, tuliskan pemahaman 

Saudara berkenaan dengan “Pembelajaran 2” 

1. Sebutkan dan jelaskan empat hal yang dapat dijadikan masalah dalam 

PTK 

2. Sebutkan empat langkah yang dapat dilakukan agar identifikasi masalah 

mengenai sasaran 
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F. Rangkuman 

1. Menganalisis hasil refleksi pembelajaran merupakan kegiatan identifikasi 

masalah.  Kegiatan ini merupakan langkah pertama dalam menyusun 

rencana PTK. Identifikasi yang tepat akan menemukan hasil penelitian 

yang sangat berguna bagi peningkatan hasil belajar siswa, sebaliknya, 

identifikasi masalah yang keliru akan menyebabkan penelitian sia-sia dan 

memboroskan biaya. Identifikasi masalah menjadi titik tolak bagi 

perencanaan PTK yang lebih matang. Sebab, tidak semua masalah dapat 

diselesaikan dengan PTK 

 
2. Langkah yang dapat dilakukan agar identifikasi masalah mengenai 

sasaran., yaitu  pertama: masalah harus rill. Masalah yang diangkat 

adalah masalah yang dapat dilihat, dirasakan, didengar, secara langsung 

oleh guru, kedua: masalah harus problematik. Permasalahan yang 

bersifat problematik adalah masalah yang dapat dipecahkan oleh guru, 

mendapat dukungan literatur yang memadai, dan kewenangan 

mengatasinya secara penuh, ketiga: manfaatnya jelas. Hasil penelitian 

harus bermanfaat secara jelas.;  keempat: masalah harus fleksibel, yakni 

bisa diatasi dengan mempertimbangkan kemampuan peneliti, waktu, 

biaya, tenaga, sarana-prasarana, dan lain sebagainya.  
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G. Umpan Balik dan Tindak Lanjut 

Tabel 2- 1 Umpan Balik Kegiatan Pembelajaran 2 

 

No. Indikator Pencapaian Kompetensi 
Deskripsi Hasil 

Belajar 

Rencana Tindak 

Lanjut 

1 Menganalisis hasil refleksi 
pembelajaran untuk perbaikan 
dan pengembangan 
pembelajaran 

  

2 Menilai kesesuaian pelaksanaan 
pembelajaran yang telah 
dilakukan pada mata pelajaran 
yang diampu  
 

  

3 Memfokuskan hasil refleksi 
pembelajaran yang penting 
untuk perbaikan pembelajaran 
selanjutnya pada mata pelajaran 
yang diampu 
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Kegiatan Pembelajaran 3 

Pelaksanaan Penelitian Tindakan Kelas Untuk 

Meningkatkan Kualitas Pembelajaran Dalam Mata 

Pelajaran Yang Diampu 
 

 

 

A. Tujuan 

 

Setelah mempelajari Kegiatan Belajar 1 peserta diklat diharapkan dapat 

melakukan penelitian tindakan  kelas (PTK) untuk meningkatkan kualitas 

pembelajaran dalam mata pelajaran yang diampu. 

 

 

B. Indikator PencapaianKompetensi 

 

Setelah menyelesaikan materi pelatihan ini, peserta diharapkan dapat: 

1. Memperjelas fokus masalah dalam pembelajaran pada mata 

pelajaran yang diampu 

2. Merinci  rencana perbaikan pembelajaran untuk meningkatkan 

kualitas pembelajaran pada mapel yang diampu 

3. Menyusun rencana penelitian tindakn kelas untuk meningkatkan 

kualitas pembelajaran dalam mapel yang diampu Menguraikan 

prosedur pelaksanaan PTK untuk meningkatkan kualitas 

pembelajaran dalam mata pelajaran yang diampu.   

4. Melakukan penelitian tindakan kelas untuk meningkatkan kualitas 

pembelajaran dalam mata pelajaran yang diampu 
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C. Uraian Materi 

1. Penetapan Fokus Permasalahan  

Tahapan ini disebut dengan tahapan merasakan adanya masalah. Jika 

dirasakan ada hal-hal yang perlu diperbaiki dapat diajukan pertanyaan 

seperti : a) Apakah kompetensi awal siswa yang mengikuti pelajaran 

cukup memadai?, b) Apakah proses pembelajaran yang dilakukan cukup 

efektif?, c) Apakah sarana pembelajaran cukup memadai?, d) Apakah 

hasil pembelajaran cukup berkualitas?, e) Bagaimana melaksanakan 

pembelajaran dengan strategi inovatif tertentu?  

Secara umum karaktersitik suatu masalah yang layak diangkat untuk PTK 

adalah sebagai berikut : 

a) Masalah itu menunjukkan suatu kesenjangan antara teori dan fakta 

empirik yang dirasakan dalam proses pembelajaran.. 

b) Masalah tersebut memungkinkan untuk dicari dan diidentifikasi faktor-

faktor penyebabnya.  

c) Adanya kemungkinan untuk dicarikan alternatif solusi bagi masalah 

tersebut melalui tindakan nyata yang dapat dilakukan guru/peneliti. 

 
Pada tahap selanjutnya dilakukan identifikasi masalah yang sangat 

menarik perhatian. Cara melakukan identifikasi masalah antara lain 

sebagai berikut. 

a) Menuliskan semua hal (permasalahan) yang perlu diperhatikan 

karena akan mempunyai dampak yang tidak diharapkan terutama 

yang berkaitan dengan pembelajaran. 

b) Memilah dan mengklasifikasikan permasalahan menurut jenis/ 

bidangnya, jumlah siswa yang mengalaminya, serta tingkat frekuensi 

timbulnya masalah tersebut. 

c) Mengurutkan dari yang ringan, jarang terjadi, banyaknya siswa yang 

mengalami untuk setiap permasalahan yang teridentifikasi. 

d) Dari setiap urutan diambil beberapa masalah yang dianggap paling 

penting untuk dipecahkan sehingga layak diangkat menjadi masalah 
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PTK. Kemudian dikaji kelayakannya dan manfaatnya untuk 

kepentingan praktis, metodologis maupun teoretis. 

 

Setelah memperoleh sederet permasalahan melalui identifikasi, 

dilanjutkan dengan analisis. Analisis masalah dipergunakan untuk 

merancang tindakan baik dalam bentuk spesifikasi tindakan, keterlibatan 

peneliti, waktu dalam satu siklus, indikator keberhasilan, peningkatan 

sebagai dampak tindakan, dan hal-hal yang terkait lainya dengan 

pemecahan yang diajukan. 

Pada tahap selanjutnya, masalah-masalah yang telah diidentifikasi dan 

ditetapkan dirumuskan secara jelas, spesifik, dan operasional. 

Perumusan masalah yang jelas memungkinkan peluang untuk pemilihan 

tindakan yang tepat. Contoh rumusan masalah yang mengandung 

tindakan alternatif yang ditempuh antara lain sebagai berikut. 

a) Apakah strategi pembelajaran menulis yang berorientasi pada proses 

dapat meningkatkan kemampuan siswa dalam menulis?  

b) Apakah pembelajaran berorientasi proses dapat meningkatkan 

partisipasi siswa dalam kegiatan pembelajaran?  

c) Apakah penyampaian materi dengan menggunakan LKS dapat 

meningkatkan partisipasi siswa dalam kegiatan pembelajaran? 

d) Apakah penggunaan strategi pembelajaran inkuiri dapat 

meningkatkan pemahaman siswa terhadap materi pelajaran IPS?   

Dalam memformulasikan masalah, peneliti perlu memperhatikan 

beberapa ketentuan yang biasa berlaku meliputi : a) Aspek substansi 

menyangkut isi yang terkandung, b) Aspek orisinalitas (tindakan), c) 

Aspek formulasi, dalam hal ini masalah dirumuskan dalam bentuk kalimat 

pertanyaan dengan mengajukan alternatif tindakan yang akan dilakukan, 

d) Aspek teknis, menyangkut kemampuan dan kelayakan peneliti untuk 

melakukan penelitian terhadap masalah yang dipilih.  
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2. Perencanaan Tindakan 

Rencana tindakan perlu  fleksibel agar dapat diadaptasikan dengan 

pengaruh yang tak dapat terduga dan kendala yang yang sebelumnya 

tidak terlihat. Tindakan yang telah direncanakan harus disampaikan 

dengan dua pengertian. Pertama, tindakan kelas mempertimbangkan 

resiko yang ada dalam perubahan dinamika kehidupan kelas dan 

mengakui adanya kendala nyata, baik yang bersifat material maupun 

yang bersifat non material dalam kelas. Kedua,  tindakan-tindakan dipilih 

karena memungkinkan penelti bertindak secara lebih efektif dalam 

tahapan-tahapan pembelajaran, lebih bijaksana dalam memperlakukan 

siswa, dan cermat dalam memenuhi kebutuhan dan perkembangan 

belajar siswa.  

Setelah masalah dirumuskan secara operasional, perlu dirumuskan 

alternatif tindakan yang akan diambil. .Alternatif tindakan yang dapat 

diambil dapat dirumuskan ke dalam bentuk hipotesis tindakan dalam arti 

dugaan mengenai perubahan yang akan terjadi jika suatu tindakan 

dilakukan. 

Beberapa hal yang perlu diperhatikan dalam merumuskan hipotesis 

tindakan adalah sebagai berikut :  

a) Diskusikan rumusan hipotesis tindakan dengan mitra peneliti 

b) Pelajari hasil-hasil penelitian yang telah dilakukan di bidang ini; 

c) Masukkan tindakan yang diusulkan untuk menghasilkan perbaikan 

yang diinginkan 

d) Tetapkan berbagai alternatif tindakan pemecahan masalah; 

e) Pilih tindakan yang paling menjanjikan hasil terbaik dan dapat 

dilakukan oleh guru; 

f) Tentukan cara untuk dapat menguji  hipotesis tindakan; 

g) Dalam menentukan tindakan, peneliti bisa berdiskusi dengan teman 

sejawat, ahli,  buku, atau hasil penelitian yang telah ada. 
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Contoh hipotesis tindakan yang sesuai dengan permasalahan yang akan 

dipecahkan dapat dicontohkan seperti di bawah ini. 

a) Strategi pembelajaran menulis yang berorientasi pada proses dapat 

meningkatkan kemampuan siswa dalam menulis.  

b) Pembelajaran berorientasi proses dapat meningkatkan partisipasi 

siswa dalam kegiatan pembelajaran.  

c) Penyampaian materi dengan menggunakan LKS dapat meningkatkan 

partisipasi siswa dalam kegiatan pembelajaran. 

d) Penggunaan strategi pembelajaran inkuiri dapat meningkatkan 

pemahaman siswa terhadap materi pelajaran IPS.     

Secara rinci, tahapan perencanaan tindakan terdiri atas kegiatan-kegiatan 

sebagai berikut. 

a) Menetapkan cara yang akan dilakukan untuk menemukan jawaban. 

b) Menentukan cara yang tepat untuk menguji hipotesis tindakan 

dengan menjabarkan indikator-indikator keberhasilan serta instrumen 

pengumpul data yang dapat dipakai untuk menganalisis indikator 

keberhasilan itu. 

c) Membuat secara rinci rancangan tindakan yang akan dilaksanakan 

mencakup;. 

Pokok-pokok kegiatan rencana PTK adalah:  

a) Identifikasi masalah dan penerapan alternative pemecahan masalah; 

b) Merencanakan pembelajaran yang akan diterapkan dalam PBM; 

c) Menentukan pokok bahasan; 

d) Mengembangkan skenario pembelajaran; 

e) Menyusun LKS; 

f) Menyiapkan sumber belajar; 

g) Mengembangkan format evaluasi; 

h) Mengembangkan format observasi pembelajaran; 

i) Melakukan simulasi pelaksanaan tindakan. 
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Tabel 3 1 Rencana dan Prosedur Penelitian Tindakan Kelas (PTK) 

Sumber: Suharsimi Arikunto, 2006 

SIKLUS I Perencanaan 

Identifikasi 
masalah dan 
penetapan 
alternative 
pemecahan 
masalah 

a. Merencanakan pembelajaran yang akan diterapkan 
dalam PBM 

b. Menentukan pokok bahasan 
c. Mengembangkan scenario pembelajaran 
d. Menyiapkan sumber belajar 
e. Mengembangkan format evaluasi 
f. Mengembangkan format evaluasi pembelajaran 

Tindakan Menerapkan tindakan mengacu kepada skenario 
pembelajaran 

Pengamatan a. Melakukan observasi dengan memakai format observasi 
b. Menilai hasil tindakan dengan menggunakan format 

Refleksi a. melakukan evaluasi tindakan yang telah dilakukan yang 
meliputi evaluasi mutu, jumlah dan waktu dari setiap 
macam tindakan 

b. melakukan pertemuan untuk membahas hasil evaluasi 
tentang scenario pembelajaran, dan lain-lain 

c. memperbaiki pelaksanaan tindakan sesuai hasil evaluasi 
untuk digunakan pada siklus berikutnya 

d. evaluasi tindakan 1 

Siklus II Perencanaan a. Identifikasi masalah dan penetapan alternative 
pemecahan masalah  

b. Pengembangan program tindakan II 

Tindakan Pelaksanaan program tindakan II 

Pengamatan Pengumpulan dan analisis data tindakan II 

Refleksi Evaluasi tindakan II 

Siklus-siklus berikutnya 

Kesimpulan dan saran 

 
 

3. Pelaksanaan Tindakan 

Pelaksanaan tindakan hendaknya dituntun oleh rencana PTK yang telah 

dibuat, tetapi perlu diingat bahwa tindakan itu tidak secara mutlak 

dikendalikan oleh rencana, mengingat dinamika proses pembelajaran di 

kelas menuntut penyesuaian atau adaptasi. Oleh karena itu, peneliti 

(guru) perlu bersikap fleksibel dan siap mengubah rencana tindakan 

sesuai dengan keadaan yang ada. Menetapkan pembelajaran yang telah 

direncanakan sebelumnya dan lembar kerja siswa (LKS). 

Padatahapan ini, rancangan strategi dan skenario pembelajaran 

diterapkan. Skenario tindakan harus dilaksanakan secara benar tampak 

berlaku wajar. Pada PTK yang dilakukan guru, pelaksanaan tindakan 

umumnya dilakukan dalam waktu antara 2 sampai 3 bulan. Waktu 

tersebut dibutuhkan untuk dapat menyesaikan sajian beberapa pokok 
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bahasan dan mata pelajaran tertentu. Berikut disajikan contoh aspek-

aspek rencana (skenario) tindakan yang akan dilakukan pada satu PTK.: 

a) Dirancang penerapan metode tugas dan diskusi dalam pembelajaran 

X untuk pokok bahasan : A, B, C, dan D. 

b) Format tugas: pembagian kelompok kecil sesuai jumlah pokok 

bahasan, pilih ketua, sekretaris, dan lain-lain oleh dan dari anggota 

kelompok, bagi topik bahasan untuk kelompok dengan cara random, 

dengan cara yang menyenangkan. 

c) Kegiatan kelompok; mengumpulkan bacaan, melalui diskusi anggota 

kelompok bekerja/ belajar memahami materi, menuliskan hasil 

diskusi dalam OHP untuk persiapan presentasi. 

d) Presentasi dan diskusi pleno; masing-masing kelompok menyajikan 

hasil kerjanya dalam pleno kelas, guru sebagai moderator, lakukan 

diskusi, ambil kesimpulan sebagai hasil pembelajaran. 

e) Jenis data yang dikumpulkan; berupa makalah kelompok, lembar 

OHP hasil kerja kelompok, siswa yang aktif dalam diskusi, serta 

hasil belajar yang dilaksanakan sebelum (pretes) dan setelah 

(postes) tindakan dilak- sanakan. 

 

4. Pengamatan/Observasi dan Pengumpulan Data 

Kegiatan pengamatan dilakukan pada waktu tindakan sedang berjalan, 

keduanya berlangsung dalam waktu yang sama. Pada tahapan ini, 

peneliti (atau guru apabila ia bertindak sebagai peneliti) melakukan 

pengamatan dan mencatat semua hal-hal yang diperlukan dan terjadi 

selama pelaksanaan tindakan berlangsung. Pengumpulan data ini 

dilakukan dengan menggunakan format observasi/penilaian yang telah 

disusun. Sebagai contoh pada satu usulan PTK akan dikumpulkan data 

seperti: (a) skor tes essai; (b) skor kualitas (kualitatif) pelaksanaan diskusi 

dan jumlah pertanyaan dan jawaban yang terjadi selama proses 

pembelajaran; serta (c) hasil observasi dan catatan lapangan yang 

berkaitan dengan kegiatan siswa.  
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Berdasarkan data-data yang akan dikumpulkan seperti di atas, maka 

akan dipakai instrumen; (a) soal tes yang berbentuk essai; (b) pedoman 

dan kriteria penilaian/skoring baik dari tes essai maupun untuk 

pertanyaan dari jawaban lisan selama diskusi; (c) lembar observasi guna 

memperoleh data aktivitas diskusi yang diskor dengan rubrik; dan (d) 

catatan lapangan. 

 

5. Refleksi 

Tahapan ini dimaksudkan untuk mengkaji secara menyeluruh tindakan 

yang telah dilakukan, berdasar data yang telah terkumpul, dan kemudian 

melakukan evaluasi guna menyempurnakan tindakan yang berikutnya. 

Alur Pelaksanaan PTK secara umum dapat dilihat pada bagan berikut : 

MenyusunRencana PTK 

a. Proposal PTK 

Dalam PTK kegiatan menyusun perencanaan tersebut disebut 

menyusun proposal. Namun pada umumnya proposal PTK sekurang-

kurangnya berisi tentang pokok-pokok sebagai berikut :  

 

Judul Penelitian ....................................... 

Peneliti ..................................................... 

 
Bab I. PENDAHULUAN 

A. Latar Belakang Masalah 

Dalam latar belakang ini peneliti menjelaskan beberapa hal, yaitu (a) 

mengapa masalah yang diteliti itu penting, (b) kondisi yang 

diharapkan. (c) masalah yang akan diteliti merupakan masalah yang 

terjadi dalam PBM disertai data faktual dan diagnosisnya, (d) 

menyinggung teori yang melandasi diajukannya gagasan untuk 

memecahkan masalah, (e) apa yang membuat peneliti  merasa 

gelisah dan resah sekiranya masalahnya tidak detliti, (f) Gejala-gejala 

kesenjangan apa yang terdapat di lapangan sebagai dasar untuk 

memunculkan masalah (g) keuntungan dan kerugian apa yang  
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mungkin akan terjadi jika masalah tersebut tidak diteliti (h) masalah 

yang akan diteliti merupakan masalah yang penting dan mendesak 

untuk dipecahkan, (i) dijelaskan pula tindakan yang akan dikenakan 

subjek pelaku tindakan. Perlu dijelaskan apa sebab tindakan itu paling 

tepat diberikan kepada subjek pelaku, dengan alasan yang berkaitan 

dengan permasalahan yang dicari solusinya. 

 
B. Identifikasi Masalah 

Identifikasi masalah merupakan kegiatan mendeteksi, melacak, 

menjelaskan aspek permasalahan yang muncul dan berkaitan dari 

judul penelitian atau dengan masalah atau variabel yang akan diteliti. 

Identifikasi masalah bisa dilakukan dengan cara mendaftar sejumlah 

problem yang dihadapi atau dirasakan guru, kemudian menyaringnya 

hingga menemukan masalah yang paling mendesak. Setelah masalah 

ditemukan, selanjutnya menemukan akar masalah. Caranya yang 

paling mudah adalah  dengan mencari penyebab masalah tersebut. 

Setelah ditemukan, peneliti harus mempunyai inisiatif atau ide 

cemerlang (mengajukan hipotesis tindakan) untuk mengatasi masalah 

tersebut. Ide atau inisiatif pemecahan masalah itulah yang kemudian 

diangkat menjadi judul penelitian. 

 
C. Rumusan Masalah. 

Rumusan masalah dalam PTK adalah beberapa pertanyaan yang 

akan terjawab setelah tindakan selesai dilakukan. Perumusan 

masalah dirumuskan dengan kalimat tanya dengan mengajukan 

alternatif  tindakan yang akan dilakukan. Perumusan masalah 

merupakan titik tolak bagi perumusan hipotesis nantinya.  

Contoh perumusan masalah:  

 Apakah penerapan pembelajaran model problem based learning 

dapat meningkatkan kemampuan pemecahan masalah pada 

mata pelajaran Biologi kelas X di SMK Bina Harapan ? 

D. Cara Memecahkan masalah  

Cara memecahkan masalah ditentukan berdasarkan pada akar 

penyebab masalah dalam bentuk tindakan secara jelas dan terarah.  
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Contoh : Cara pemecahan masalah yang akan digunakan dalam PTK 

ini yaitu menggunakan metode pembelajaran kooperatif  tipe Jigsaw. 

 
E. Hipotesis Tindakan 

Rumusan hipotesis tindakan berdasarkan pada cara memecahkan 

masalah yang akan digunakan dalam PTK, Contoh : Dengan 

diterapkan model pembelajaran kooperatif dengan tipe Jigsaw  dapat 

meningkatkan hasil belajar siswa dalam mata pelajaran biologi  

 
F. Tujuan PTK 

Tujuan penelitian harus sejalan dengan rumusan masalah, artinya 

tujuan penelitian hanya untuk menjawab rumusan masalah, tegasnya 

tujuan PTK adalah untuk mengatasi masalah yang dihadapi guru di 

dalam kelas. Contoh rumusan masalah tujuan penelitian Yang 

mengacu pada rumusan masalah:  

 Ingin mengetahui sejauh mana metode pembelajaran kooperatif 

dapat meningkatkan aktivitas pembelajaran Biologi siswa 

 
G. Manfaat  Hasil   Penelitian 

Karena hakekat PTK adalah untuk meningkatkan proses dan hasil 

belajar siswa, hendaknya dalam mencantumkan manfaat penelitian 

lebih menitikberatkan pada apa yang akan diperoleh siswa setelah 

menggunakan hasil penelitian ini.  

 
BAB II.  Kajian  Pustaka 

Anda juga perlu membaca hasil penelitian terakhir oleh orang lain. Anda 

dapat mengambil manfaat dari pengalaman orang itu.  

Anda perlu merujuk pada teori yang dapat menjustifikasi tindakan yang 

akan Anda berikan juga perlu mengetahui penelitian-penelitian terakhir 

yang relevan dengan masalah PTK Anda. Urutan yang harus diuraikan 

hendaknya dmulai dengan konsep atau teori tentang variabel yang akan 

dipecahkan.  
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BAB III. Metodologi Penelitian  

1. Setting Penelitian. 

Menggambarkan lokasi dan kelompok siswa atau subjek yang dikenai 

tindakan. Tidak ada sampel  populasi dalam PTK. Jadi satu kelas 

secara keseluruhan. 

2. Sasaran penelitian, adanya target bahwa akan terjadi perubahan 

melalui tindakan yang dilakukan guru.  

3. Rencana tindakan, yaitu gambaran riil secara detail mengenai rencana 

tindakan yang akan dilakukan peneliti.   

4. Teknik pengumpulan data, yaitu metode yang digunakan peneliti 

dalam merekam data (informasi) yang dibutuhkan. Secara umum, 

bagian ini menjelaskan tentang informasi yang menyangkut indikator 

yang terdapat dalam tindakan. 

5. Analisis data, yaitu analisis yang telah terkumpul guna mengetahui 

seberapa besar keberhasilan tindakan dalam penelitian untuk 

perbaikan belajar siswa.    

 

D. Aktivitas Pembelajaran 

Berdasarkan apa yang sudah Anda fahami dari modul pembelajaran 1 dan 

berdasarkan pengalaman selama Anda mengajar di sekolah, tentunya Anda 

memiliki masalah-masalah mengajar yang selama ini mengusik pikiran Anda, 

sehingga apabila masalah tersebut tidak segera diatasi maka akan 

menghambat proses belajar mengajar dikelas Anda. Dari banyak masalah 

mengajar yang Anda hadapi  dan  berbagai alternatif tindakan yang mungkin 

dapat mengatasi masalah tersebut,  cermati kegiatan berikut ini  : 

 Aktivitas Pembelajaran  1 

Ambil salah satu dari sekian banyak masalah yang menurut Anda paling 

penting dan sering terjadi saat Anda mengampu mata pelajaran di kelas 

dan diluar kelas.  Analisislah masalah tersebut menggunakan “Lembar 

Kerja. 3.1 ” (lamp. 4) 

 Aktivitas Pembelajaran 2. 

 Setelah Anda menentukan salah satu dari sekian banyak masalah yang 

Anda hadapi dan menentukan salah satu tindakan yang akan Anda 
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ambil untuk mengatasi  masalah tersebut, buatlah rencana tindakan 

perbaikan pembelajaran dalam bentuk proposal penelitian tindakan 

kelas. Untuk mengerjakan tugas ini,  Anda dapat menggunakan  

“Lembar Kerja 3.2 “(lamp. 5) 

 Aktivitas Pembelajaran 3. 

Untuk menindaklanjuti Proposal PTK yang telah Anda susun, 

selanjutnya Lakukan penelitian tindakan kelas berdasarkan 

permasalahan yang Anda miliki  dan tindakan apa yang akan Anda 

lakukan untuk mengatasi masalah tersebut dalam upaya meningkatkan 

kualitas pembelajaran pada mata pelajaran yang  Anda  ampu. Gunakan 

pedoman pelaksanaan PTK pada Lampiran 6. 

 

E. Latihan/ Kasus /Tugas 

 

Latihan Pembelajaran 3 

Materi : Pelaksanaan PTK 

Kegiatan : Curah pendapat dan diskusi prosedur pelaksanaan PTK 

 

Setelah mencermati materi pada modul PTK, berbagai sumber/referensi 

lainnya dan tayangan yang disampaikan fasilitator, tuliskan pemahaman 

Saudara berkenaan dengan “Pembelajaran 3” 

1. Salah satu ciri penelitian tindakan kelas (PTK) adalah adanya siklus-

siklus kegiatan. Jelaskan langkah-langkah pokok kegiatan yang 

ditempuh pada siklus pertama dan siklus-siklus berikutnya 

2. Tidak semua masalah dapat di -PTK- kan. Secara umum,jelaskan apa 

saja karaktersitik suatu masalah yang layak diangkat untuk PTK? 

3. Uraikan yang dimaksud dengan analisis masalah, tujuan analisis 

masalah dan kegunaan analisis masalah, dilihat dari segi 

kelayakannya? 

4. Buatlah dua contoh rumusan masalah yang mengandung tindakan 

alternatif yang ditempuh . 
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F. Rangkuman 

1. Tiga hal penting dalam pelaksanaan PTK sebagai berikut. 

a) PTK adalah penelitian yang mengikutsertakan secara aktif peran guru 

dan siswa dalam berbagai tindakan. 

b) Kegiatan refleksi (perenungan, pemikiran, evaluasi) dilakukan 

berdasarkan pertimbangan rasional (menggunakan konsep teori) 

yang mantap dan valid guna melakukan perbaikan tindakan dalam 

upaya memecahkan masalah yang terjadi. 

c) Tindakan perbaikan terhadap situasi dan kondisi pembelajaran 

dilakukan dengan segera dan dilakukan secara praktis (dapat 

dilakukan dalam praktik pembelajaran). 

2. Prosedur pelaksanaan PTK meliputi: a) penetapan fokus permasalahan, 

b) perencanaan tindakan. c) pelaksanaan tindakan diikuti dengan kegiatan 

observasi. d) refleksi : mencakup analisis, sintesis, dan penilaian terhadap 

hasil pengamatan atas tindakan yang dilakukan. 

 

G. Umpan Balik dan Tindak Lanjut 

Tabel 3- 1 Umpan balk kegiatan belajar 3 

 

No 

Indikator Pencapaian Kompetensi Deskripsi Hasil 

Belajar 

Rencana Tindak 

Lanjut 

1 Memperjelas fokus masalah dalam 
pembelajaran pada mata pelajaran yang 
diampu 

  

2 Merinci  rencana perbaikan 
pembelajaran untuk meningkatkan 
kualitas pembelajaran pada mapel yang 
diampu 

  

3 Menyusun rencana penelitian tindakn 
kelas untuk meningkatkan kualitas 
pembelajaran dalam 118ctua yang 
diampu Menguraikan prosedur 
pelaksanaan PTK untuk meningkatkan 
kualitas pembelajaran dalam mata 
pelajaran yang diampu 

  

4 Melakukan penelitian tindakan kelas 
untuk meningkatkan kualitas 
pembelajaran dalam mata pelajaran 
yang diampu 
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Kunci Jawaban Latihan/Kasus/Tugas 

Kegiatan Pembelajaran 1 

1. Refleksi yang dimaksud  adalah refleksi dalam pengertian introspeksi 

diri, seperti guru mengingat kembali apa saja tindakan yang telah 

dilakukan di dalam kelas, apa dampak dari tindakan tersebut, 

mengapa dampaknya menjadi demikian, dan lain sebagainya. 

 
2. Pertama; meminta peserta didik memberikan penilaian terhadap guru. 

Penilaian dilakukan dengan cara penulisan tertulis maupun lisan oleh 

peserta didik kepada guru, berisi ungkapan kesan, pesan, harapan 

serta kritik membangun atas pembelajaran yang diterimanya.   

Kedua; berupa hasil pengamatan langsung yang dilakukan oleh guru 

mata pelajaran sejenis selaku pengamat saat pelaksanaan 

pembelajaran berlangsung 

3. Melakukan evaluasi diri merupakan aktivitas yang penting karena dua 

alasan. Pertama, kita ingin memperbaiki kualitas pengajaran kita. 

Kedua, kita tidak terlalu berharap banyak pada orang lain untuk 

mengamati proses pengajaran yang kita lakukan. Evaluasi diri 

merupakan bagian penting dalam aktivitas pembelajaran untuk 

memahami dan memberi makna terhadap proses dan hasil 

(perubahan) yang terjadi akibat adanya pengajaran yang kita lakukan. 

Hasil evaluasi diri digunakan untuk menetapkan langkah selanjutnya 

dalam upaya untuk menghasilkan perbaikan-perbaikan.  

4. Beberapa hal yang dapat menyebabkan kegagalan dalam 

pelaksanaan pembelajaran : 

a. Bahasa yang digunakan oleh guru sukar untuk dimengerti,  

b. Guru kurang begitu menguasai kelas 

c. Cara mengajar Guru yang membosankan 

d. Guru kurang mampu memotivasi anak dalam belajar 

e. Guru kurang memahami anak didiknya di dalam menyerap 

pelajaran 

f. Guru kurang memahami kemampuan anak didiknya di dalam 

menyerap pelajaran 
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g. Guru kurang disiplin dalam mengatur waktu. 

h. Guru enggan membuat persiapan tahapan proses belajar-mengajar 

i. Guru kurang menguasai materi, 

j. Guru kurang terampil mengajukan pertanyaan kepada murid, 

memberikan latihan soal atau kuis, sehingga murid kurang 

memahami tentang apa yang dimaksud oleh guru.  

k. Guru hanya mengutamakan pencapaian target kurikulum. 

Kegiatan Pembelajaran  2 

1. Empat hal yang dapat dijadikan masalah dalam PTK yaitu (1) masalah 

yang barkaitan dengan pengelolaan kelas, (2) masalah proses belajar 

mengar, (3) masalah pengembangan atau pengunaan sumber-sumber 

belajar; (4) masalah yang berkaitan dengan wahana  

 

2. Langkah-langkah yang dapat dilakukan agar identifikasi masalah 

mengenai sasaran. : (1) Masalah harus rill. Masalah yang diangkat 

adalah masalah yang dapat dilihat, dirasakan, didengar, secara 

langsung oleh guru.; (2) Masalahnya harus problematik. Permasalahan 

yang bersifat problematik adalah maslah yang dapat dipecahkan oleh 

guru, mendapat dukungan literatur yang memadai, dan kewenangan 

mengatasinya secara penuh.; (3) Manfaatnya jelas. Hasil penelitian 

harus bermanfaat secara jelas; (4) Masalah harus fleksibel, yakni bisa 

diatasi dengan mempertimbangkan kemampuan peneliti, waktu, biaya, 

tenaga, sarana-prasarana, dan lain sebagainya.  

 

Kegiatan Pembelajaran  3 

1. Langkah-langkah pokok yang ditempuh pada siklus pertama dan siklus-

siklus berikutnya adalah :   

a. Perencanaan tindakan  

b. Pelaksanaan tindakan  

c. Pengumpulan data (pengamatan/observasi) 

d. Refleksi (analisis, dan interpretasi) 

2. Karaktersitik suatu masalah yang layak diangkat untuk PTK, pertama, 

masalah itu menunjukkan suatu kesenjangan antara teori dan fakta 
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empirik yang dirasakan dalam proses pembelajaran, Kedua, masalah 

tersebut memungkinkan untuk dicari dan diidentifikasi faktor-faktor 

penyebabnya, Ketiga; adanya kemungkinan untuk dicarikan alternatif 

solusi bagi masalah tersebut melalui tindakan nyata yang dapat 

dilakukan guru/peneliti.  

3. Analisis masalah adalah kajian terhadap permasalahan, dilihat dari segi 

kelayakannya. Tujuan Analisis masalah adalah untuk mengetahui 

proses tindak lanjut perbaikan atau pemecahan yang dibutuhkan 

Analisis masalah dipergunakan untuk merancang tindakan baik dalam 

bentuk spesifikasi tindakan, keterlibatan peneliti, waktu dalam satu 

siklus, indikator keberhasilan, peningkatan sebagai dampak tindakan, 

dan hal-hal yang terkait lainnya dengan pemecahan yang diajukan 

4. Contoh rumusan masalah yang mengandung tindakan 121ctual121iona 

yang ditempuh : 

a. Apakah strategi pembelajaran menulis yang berorientasi pada 

proses dapat meningkatkan kemampuan siswa dalam menulis?  

b. Apakah pembelajaran berorientasi proses dapat meningkatkan 

partisipasi siswa dalam kegiatan pembelajaran?  

c. Apakah penyampaian materi dengan menggunakan LKS dapat 

meningkatkan partisipasi siswa dalam kegiatan pembelajaran? 

d. Apakah penggunaan strategi pembelajaran inkuiri dapat 

meningkatkan pemahaman siswa terhadap materi pelajaran IPS? 
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Evaluasi 

Untuk mengukur pemahaman Saudara tentang isi materi yang terdapat pada 

Modul Diklat Pengembangan Keprofesian Berkelanjutan (PKB) Kompetensi  

Pedagogik Guru Kejuruan ini, Saudara diminta menjawab soal-soal pertanyaan 

dibawah ini. Usahakan jangan melihat kunci jawaban terlebih dahulu sebelum 

Saudara benar-benar menjawab  seluruh soal evaluasi yang ada. 

Petunjuk  Pengisian Soal: 

Jawablah pertanyaan-pertanyaan dibawah ini dengan cara memberikan tanda 

silang (X) pada salah satu huruf jawaban ( a,b,c, atau d ) yang Saudara anggap 

paling “benar”.  

 

1. Refleksi dapat berarti bergerak mundur untuk merenungkan kembali apa 

yang sudah terjadi dan dilakukan. Dalam kegiatan pembelajaran yang 

dilaksanakan guru, kegiatan merefleksi pelaksanaan pembelajaran ini sangat 

penting untuk perbaikan proses pembelajaran ke depan. Waktu yang paling 

baik dilakukan guru untuk merefleksi hasil pelaksanaan pembelajaran adalah 

a. Di akhir pelaksanaan tatap muka 

b. Di akhir satu kompetensi   

c. Di akhir  semester    

d. Di akhir  tahun pelajaran   

 
2. Guru risau karena nilai  ulangan siswa pada pelajaran matematika selalu 

rendah, rata-rata kurang dari 50. Ini terjadi setiap kali ulangan. Jika guru 

bertanya, siswa tampak ragu-ragu dan bingung. Kalau menjawab, 

jawabannya selalu salah. Contoh refleksi ini menunjukkan masalah yang 

dapat dikembangkan yang menjadi tanggung jawab guru dalam mengelola 

pembelajaran, yaitu yang berkaitan dengan: 

a. Pengelolaan kelas 

b. Proses belajar mengajar 

c. Pengembangan/penggunaan sumber belajar 

d. Wahana peningkatan personal dan  profesional 
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3. “Siswa tidak pernah mengerjakan tugas atau pekerjaan rumah (PR).” Latar 

belakang atau penyebabnya, terdapat beberapa kemungkinan: 

1) Banyak menonton acara TV sehingga mengabaikan tugas belajar 

2) Tugas terlalu sulit bagi saya 

3) Terlalu banyak bermain sehingga kehabisan waktu untuk mengerjakan 

tugas sekolah.    

4) Tugas sekolah terlalu monoton dan tidak pernah dibahas bersama 

secara tuntas 

Mana dari ke empat  penyebab permasalahan di atas yang tidak mungkin 

dapat diatasi oleh guru dengan pendekatan Penelitian Tindakan Kelas 

(PTK)? 

a. Penyebab 1 dan 4 

b. Penyebab 2 dan 3 

c. Penyebab 2 dan  4 

d. Penyebab 1 dan 3 

 
4. Mana diantara pernyataan dibawah ini yang menurut Saudara paling tepat 

untuk mendefinisikan istilah diagnosis  

a. diagnosis adalah penentuan jenis masalah atau kelainan atau 

ketidakmampuan dengan meneliti latar belakang penyebabnya atau 

dengan cara menganalisis gejala-gejala yang tampak.  

b. Diagnosis adalah penentuan jenis masalah atau kelainan atau 

ketidakmampuan meneliti latar belakang penyebabnya, atau dengan cara 

meminta siswa mengemukakan pendapatnya tentang bagaimana cara 

guru mengajar 

c. Diagnosis adalah penentuan jenis masalah atau kelainan atau 

ketidakmampuan meneliti latar belakang, atau dengan cara pengamatan 

kelas oleh guru mata pelajaran sejenis. 

d. Diagnosis adalah penentuan jenis masalah atau kelainan atau 

ketidakmampuan meneliti latar belakang penyebabnya  atau dengan cara 

mengumpukan informasi dari lingkungan keluarga 
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5. Dalam menilai sendiri keberhasilan pengajaran, kita membutuhkan informasi 

yang dapat dijadikan bahan pertimbangan dalam menentukan berhasil atau 

tidaknya pengajaran yang telah kita lakukan. Informasi-informasi tersebut 

selanjutnya dianalisis. Urutan langkah-langkah analisis yang benar menurut 

Saudara adalah: 

1) menilai hasil-hasil pengukuran (tes atau non tes),  

2) faktor makna (pemaknaan) atas hasil analisis yang kita lakukan. 

3) menetapkan berhasil atau tidaknya aspek-aspek yang dinilai tersebut.  

4) memberikan penjelasan  

5) menetapkan tingkat keberhasilan dari masing-masing aspek penilaian  

6) menentukan faktor keberhasilan  

7) Memberikan kesimpulan-kesimpulan yang masuk akal. 

 
a. 1, 3, 2, 4, 5, 6 ,7 

b. 1, 6, 2, 3, 4, 5, 7 

c. 1, 6, 5, 3, 4, 6, 7 

d. 1, 5, 6, 3, 2, 4, 7 

 
6. Salah satu jenis penilaian yang dapat dilakukan guru dalam pembelajaran 

yang berfungsi mengidentifikasi faktor-faktor Penyebab Kegagalan dan 

Pendukung Keberhasilan dalam Pembelajaran adalah : 

a. Penilaian formatif 

b. Penilaian sumatif 

c. Penilaian diagnostik 

d. Penilaian diri 

 
7. Agar identifikasi masalah mengenai sasaran, ada empat langkah yang dapat 

dilakukan.  Jika masalahnya demikian: “sebagian besar nilai Matematika 

siswa kelas X SMA “ Y ” dibawah standar kelulusan”,  Ini merupakan contoh 

masalah yang  menunjukkan bahwa : masalah tersebut : 

a. Rill 

b. problematik 

c. Manfaat jelas 

d. fleksibel 
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8. Jika guru ingin meningkatkan sifat dan kepribadian siswa;  maka cara ini 

termasuk masalah yang berkaitan dengan : 

a. Pengelolaan kelas,  

b. Pengembangan atau penggunaan sumber-sumber belajar 

c. Proses belajar mengajar 

d. Wahana peningkatan personal dan profesional 

 
9. Dari judul-judul penelitian dibawah ini, manakah yang merupakan judul 

Penelitian Tindakan Kelas (PTK) 

a. Hubungan Antara Kemandirian Belajar Motivasi Berprestasi Dan 

Kemampuan Numerik Dengan Prestasi Belajar Matematika Pokok 

Bahasan Statitiska Siswa Kelas II Semester II SMK Negeri Se-Kec.... 

Kab... Tahun Ajaran  2013-2014 

b. Hubungan Antara Keterlibatan Orang Tua Dengan Prestasi Belajar 

Biologi Siswa Kelas I Cawu 3 Di SMK.....  Kabupaten .... Tahun Ajaran 

2013-2014  

c. Penggunaan Metode Drill Dalam Upaya Meningkatkan Prsetasi  Belajar 

Siswa Kelas X B – Pada Mata Pelajaran Matematika Pokok Bahasan 

Persamaan Kuadrat Di SMK Negeri ....Semester I Tahun Pelajaran 2012-

2013 

d. Pengaruh Metode Ceramah Dan Metode Diskusi Terhadap Hasil Belajar 

Siswa SMK  Kelas X  Se Kecamatan ..... 

 
10. Pemecahan  masalah dengan “model tindakan tertentu yang merupakan 

suatu hal  baru yang  belum pernah dilakukan guru sebelumnya”  merupakan  

ketentuan yang berlaku  dalam memformulasikan suatu masalah.  Hal ini 

termasuk dalam ketentuan : 

a. Aspek substansi 

b. Aspek orosinalitas 

c. Aspek formulasi 

d. Aspek teknis 
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11. Dari beberapa pengertian hpotesis dibawah ini, mana yang paling tepat 

menurut pendapat Saudara. 

a. Hipotesis dalam penelitian tindakan merupakan hipotesis pebedaan atau 

hubungan 

b. Bentuk umum rumusan hipotesis tindakan sama  dengan hipotesis dalam 

penelitian formal 

c. Rumusan hipotesis tindakan memuat tindakan yang diusulkan untuk 

menghasilkan perbaikan yang diinginkan. 

d. Hipotesis tindakan merupakan dugaan sementara yang masih harus diuji 

kebenarannya melalui teori-teori.  

 
12. Rencana tindakan pada PTK merupakan tindakan pembelajaran kelas yang 

tersusun. Tahapan pada perencanaan  ini  terdiri atas kegiatan-kegiatan yang 

berurutan.  Urutan kegiatan yang benar adalah : 

a. 1) Menetapkan cara yang akan dilakukan untuk menemukan jawaban; 2) 

Menentukan cara yang tepat untuk menguji hipotesis tindakan; 3) 

Membuat secara rinci rancangan tindakan yang akan dilaksanakan 

b. 1) Menentukan cara yang tepat untuk menguji hipotesis tindakan; 2) 

Menetapkan cara yang akan dilakukan untuk menemukan jawaban; 3) 

Membuat secara rinci rancangan tindakan yang akan dilaksanakan 

c. 1) Membuat secara rinci rancangan tindakan yang akan dilaksanakan; 2) 

Menetapkan cara yang akan dilakukan untuk menemukan jawaban; 3) 

Menentukan cara yang tepat untuk menguji hipotesis tindakan; 

d. 1)Mencari akar permasalahan; 2) Menetapkan cara yang akan dilakukan 

untuk menemukan jawaban; 3) Menentukan cara yang tepat untuk 

menguji hipotesis tindakan; 

 
13. Hasil analisis kekuatan dan kelemahan pembelajaran yang telah 

dilaksanakan dapat digunakan guru untuk .... 

a. mempertahankan kebiasaan mengajar karena sudah lama dan banyak 

berpengalaman 

b. mengusulkan penyediaan media mengajar yang canggih untuk 

meningkatkan pembelajaran 
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c. merancang ulang rancangan pembelajaran yang berdasarkan analisis 

terbukti memiliki kelemahan  

d. memberikan latihan tambahan berupa tes untuk para siswa 

 

14. Tahap perencanaan pada siklus I  intinya adalah identifikasi masalah dan 

penetapan alternative pemecahan masalah. Berikut ini yang bukan 

merupakan kegiatan pada tahap tersebut adalah… 

a. Melakukan observasi dengan menggunakan format observasi 

b. Menyusun dan mengembangkan scenario pembelajaran 

c. Merencanakan pembelajaran yang akan diterapkan dalam PBM 

d. Mengembangkan format evaluasi dan observasi 

 
15. Manfaat yang didapat dengan dilakukannya PTK adalah 

a. Guru dapat berkembang dan meningkatkan kinerjanya secara 

127ctual127ional, karena guru dapat menilai, merefleksi diri, dan mampu 

memperbaiki pembelajaran yang dikelolanya 

b. Guru dapat bertindak sebagai praktisi dan merasa puas terhadap apa 

yang dikerjakan atau diajarkan di kelas  

c. Guru dapat bertindak sebagai penilai pembelajaran yang dilakukan 

didalam maupun diluar kelas 

d. Guru dapat melakukan evaluasi siswa dan menganalisis cara belajar 

siswa dan mengembangkan cara penilaian pembelajaran 

 

Kunci Jawaban Evaluasi  

 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

C B D A D C A D C B C A C A A 
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Penutup 

 

anyak jalan yang dapat ditempuh para pendidik/guru dan tenaga 

kependidikan dalam mengembangkan profesinya, setidaknya ada lima 

cara dan salah satunya adalah kegiatan penulisan  karya tulis ilmiah 

(KTI). Sedangkan penelitian merupakan salah satu dari kegiatan penulisan KTI. 

Penelitian tindakan kelas merupakan salah satu jenis penelitian dari berbagai 

jenis penelitian yang ada, seperti penelitian eksperimen dan penelitian kualitatif. 

Namun PTK merupakan jenis penelitian yang paling tepat dan strategis untuk 

perbaikan  proses pembelajaran yang permasalahannya banyak dialami oleh 

tenaga pendidik dan kependidikan. Oleh karena itu jenis penelitian ini sangat 

tepat untuk dipahami dan diaplikasikan dalam  upaya mengatasi masalah yang 

relevan, yang ke sehariannya tidak lepas dari masalah di kelas atau proses 

pembelajaran 

Dengan membiasakan diri merespons permasalahan aktual di kelas/lingkungan 

kerja dan adanya upaya untuk mengatasinya, niscaya akan mampu 

meningkatkan kualitas pendidikan, dan profesionalisme pendidik dan tenaga 

kependidikan akan lebih mudah tercapai.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

B 



 

 
129 

Refleksi Pembelajaran 

Daftar Pustaka 

 

Asep Jihad dkk. 2013. Evaluasi Pembelajaran. Yogyakarta. Multi Pressindo 

Ekawarna. 2010. Penelitian Tindakan Kelas. Jakarta. Gaung Persada 

http://wahyuprimasari.blogspot.co.id/2011/02/refleksi-proses-dan-hasil-

asesmen.html  (diunduh 20 November 2015) 

https://ptkguru.wordpress.com/2008/05/11/penelitian-tindakan-kelas (diunduh 20 

November 2015) 

http://bknpsikologi.blogspot.co.id/2010/11/diagnosis-kesulitan-belajar.html  

(diunduh 18 November 2015) 

Kunandar. 2008. Langkah Mudah Penelitian Tindakan Kelas Sebagai 

Pengembangan Profesi. Rajagrafindo Persada 

Suhaimi Arikunto dkk. 2007. Penelitian Tindakan Kelas. Jakarta. Bumi Aksara. 

Suyadi, 2012. Buku Panduan Guru Profesional Penelitian Tindakan Kelas dan 

Penelitian Tindakan Sekolah. Yogyakarta. Andi. 

Udin Syaefudin Saud.2009. Pengembangan Profesi Guru. Bandung. Alfabeta 

Wina Sanjaya. 2008. Strategi Pembelajaran Berorientasi Standar Proses. 

Prenada Media Group 

Zainal Aqib. 2006. Penelitian Tindakan Kelas untuk Guru. Bandung. Yrama 

Widya. 

 
 
 
 
 
 
 
 



 

 Modul Paket Keahlian Akuntasi Sekolah Menengah Kejuruan 
(SMK) 

 

130 

Glosarium 

   

as usual 

 

diagnosis 

 

 

 

das sein 

das sollen 

 

empiris 

 

 

 

professional 

judgement   

 

refleksi 

 

 

setting 

subject matter 

 

valid 

 

 

 yang biasa saja 

 

1.penentuan jenis penyakit dengan cara meneliti 

(memeriksa) gejala-gejalanya; 2. penentuan jenis 

masalah atau kelainan atau ketidakmampuan dengan 

meneliti latar belakang penyebabnya 

kenyataan nyata 

kondisi yang diharapkan 

 

berdasarkan pengalaman (terutama yang diperoleh dari 

penemuan, percobaan, pengamatan yang telah 

dilakukan) 

 

penilaian secara profesional 

 

 

bergerak mundur untuk merenungkan kembali apa yang 

sudah dilakukan 

 

Pengaturan 

Pokok 

 

menurut cara yang semestinya; berlaku; sahih: tes 

dikatakan -- jika sesuai dengan materi yang diajarkan 

oleh guru 
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Lampiran 

Lampiran 2 Lembar Pengamatan Proses Belajar Mengajar 

 

Lembar Pengamatan Proses Belajar Mengajar 

 
Nama Guru : ......................................................................... 
Tahun Pelajaran : ......................................................................... 
Kelas/semester : ......................................................................... 
Pokok Bahasan : ......................................................................... 
 

 
NO 

 
KEGIATAN 

 
PENILAIAN 

 
CATATAN 

  
 

 
4 

 
3 

 
2 

 
1 

 

1 Apersepsi      

2 Penjelasan materi      

3 Penjelasan metode 
pembelajaran 

     

4 Teknik pembagian kelompok      

5 Penguasaan kelas      

6 Penggunaan media      

7 Suara      

8 Pengelolaan kegiatan diskusi      

9 Bimbingan kepada kelompok      

10 Pengelolaan kegiatan diskusi      

11 Pemberian pertanyaan/kuis      

12 Kemampuan melakukan 
evaluasi 

     

13 Memberikan penghargaan 
individu dan kelompok 

     

14 Menentukan nilai individu dan 
kelompok 

     

15 Menyimpulkan materi 
pembelajaran 

     

16 Menutup pembelajaran      

17 Menyimpulkan materi 
pembelajaran 

     

18 Menutup pembelajaran      

 

Pengamat  

      (                                             ) 

 

 

LK – 1.1 
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Lampiran 3 Lembar Pengamatan Kesesuaian Mengajar 

 

Lamp. 2 

 

Lembar Pengamatan Kesesuaian  Mengajar 

Nama Guru : ......................................................................... 
Tahun Pelajaran : ......................................................................... 
Kelas/semester : ......................................................................... 
Pokok Bahasan : ......................................................................... 
  

Kompo 
nen 

 
Tertulis Di 

RPP 

 
Proses 

Pembelajaran 

 
Hasil 

Diagnosis 

 
Hasil 

Penilaian 

 
Penyebab 
Kegagalan 

 
Kegiatan 
Awal 
 
 
 

     

 
 
 
 
 
Kegiatan 
Inti 

     

Kegiatan 
Penutup 
 
 
 
 
 

     

         

Pengamat 

       (                 ) 

 

 

 

 

LK – 1.2 
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Lampiran 4 LK 2.1 

 

 
No 

 
Masalah 

Yang 
Diambil 

 
Identifikasi 

Masalah 

Alternatif 
Pemecahan 

Masalah/solusi 

Fokus 
Pemecahan 

Masalah 

Keterangan/ 
Catatan. 
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Lampiran 5 LK 3.1 

 

 

No Fokus Masalah yang 
dihadapi 

Identifikasi Penyebab 
Timbulnya Masalah 

Alternatif Tindakan 
Pemecahan 

Masalah 
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Lampiran 6 Sistematika Proposal Penelitian Tindakan Kelas 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
SISTEMATIKA PROPOSAL 

 PENELITIAN TINDAKAN KELAS 
 

Judul Penelitian ....................................... 
Peneliti ..................................................... 
 
Bab I. PENDAHULUAN 

1. Latar Belakang Masalah 
2. Identifikasi Masalah 
3. Rumusan Masalah 
4. Cara Memecahkan Masalah 
5. Hipotesis Tindakan  
6. Tujuan PTK 
7. Manfaat Hasil Penelitian 

 
Bab II. Kajian Pustaka 
 
Bab III. Metodologi Penelitian 

1. Setting Penelitian 
2. Sasaran Penelitian 
3. Rencana Tindakan 
4. Teknik Pengumpulan Data 
5. Analisis Data 

 
 

LK 3.2 
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Lampiran 7 Pedoman Penyusunan PTK 

PEDOMAN PENYUSUNAN PTK 

No KEGIATAN Cek 

 RENCANA PTK   

1 Identifikasi masalah dan alternatif pemecahan masalah  

2 Merencanakan pembelajaran yang akan diterapkan dalam PBM  

3 Menentukan Pokok Bahasan  

4 Mengembangkan skenario pembelajaran  

5 Menyusun LKS  

6 Menyiapkan sumber belajar  

7 Mengembangkan format evaluasi  

8 Mengembangkan format observasi pembelajaran  

9 Melakukan simulasi pelaksanaan tindakan  

 Kegiatan Siklus 1  

 A.Perencanaan  

1 Merencanakan pembelajaran yang akan diterapkan dalam PBM  

2 Menentukan pokok bahasan  

3 Mengembangkan skenario pembelajaran  

4 Menyiapkan sumber belajar  

5 Mengembangkan format evaluasi  

6 Mengembangkan format evaluasi pembelajaran  

 B. Tindakan  

1 Menerapkan tindakan mengacu kepada skenario pembelajaran  

 C.Pengamatan  

1 Melakukan observasi dengan memakai format observasi 
 

 

2 Menilai hasil tindakan dengan menggunakan format  

 D.Refleksi  

1 melakukan evaluasi tindakan yang telah dilakukan yang meliputi evaluasi 
mutu, jumlah dan waktu dari setiap macam tindakan 

 

2 melakukan pertemuan untuk membahas hasil evaluasitentang scenario 
pembelajaran, dan lain-lain 
 

 

3 memperbaiki pelaksanaan tindakan sesuai hasil evaluasi untuk 
digunakan pada siklus berikutnya 

 

4 evaluasi tindakan 1  

 Kegiatan Siklus 2  

 A. Perencanaan  

1 Identifikasi masalah dan penetapan alternative pemecahan masalah  

2 Pengembangan program tindakan II  

 B. Tindakan  

 Pelaksanaan program tindakan II  

 C.Pengamatan  

 Pengumpulan dan analisis data tindakan II  

 D.Refleksi  

 Evaluasi Tindakan II  

 Siklus-siklus berikutnya  

 Kesimpulan dan saran  
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